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1.1  Getting Started with Smarky 
Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar above to return here.

Launch Smarky.  Smarky will automatically import your current bookmarks from Safari the first time you launch it.  If
those have changed and you want to re-import the bookmarks you have now, click in the menu: File  > Import from
Safari.

If you have other bookmarks in other files, browsers or devices which you want to import and merge with what you
have just imported, import those now and consolidate all of your bookmarks.

Organize your bookmarks.

Check and be sure that the Content you now see in Smarky is what you want in Safari.

Smarky can keep your bookmarks in Safari sorted automatically.   It will watch for when you change bookmarks in
Safari, or from iCloud, import the content, sort it, and export it.

To enable syncing

Click the Syncing  button in the toolbar to being syncing.   It will get a green dot like this…

When prompted, click Export.

Quit Smarky.  Smarky’s syncing will perform when needed in the background.  (If you leave Smarky running,
syncing will still work, but it will draw a sheet over the window while it is working, to prevent conflicts.)

If desired, you may test syncing.

To finish without enabling syncing

Click in the menu: File  > Export to Safari.   You should consider, but ultimately approve of any warnings which
appear.

Click in the menu: Smarky  > Quit Smarky.
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1.2  Getting Started with Synkmark 
This section gives the steps to set up Synkmark, possibly in conjunction with other services, to sync the internal
bookmarks of your web browsers.

Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar above to return here.

Launch Synkmark for the first time.  You will be prompted to choose the browsers you wish to sync.  (Later, these
will be in Preferences  > Syncing. )

If there are other bookmarks in other files, browsers or devices which you want to import and merge with what you
have just imported, import those now and consolidate all of your bookmarks.  In particular, if there are bookmarks
on other Macs that you want to have in your synced collection, make sure you get those now and import them into
this document.

Organize your bookmarks.

If you have other proprietary sync services such as iCloud, Firefox Sync, Sign in to Chrome, or Opera Link already
syncing your bookmarks, or if your ultimate goal is to sync your bookmarks among multiple devices, read about the
different routes available for syncing multiple devices and sketch out how you will use Synkmark, in conjunction,
with other services if necessary, to reach all the browsers on all devices.

If, as a result of the previous step, you need to disable branches of these other services because they are not in
your sketch, do that now.  If you don’t remember how you set them up, we have links for you.

Check and be sure that the Content you now see in Synkmark is what you want in your web browsers.

Click the Syncing  button in the toolbar to being syncing.   It will get a green dot like this…

When prompted, click Export.

Quit Synkmark.  Synkmark’s syncing will perform when needed in the background.  (If you leave Synkmark
running, syncing will still work, but it will draw a sheet over its document window while it is working, to prevent
conflicts.)

If you are only using Synkmark on one Mac, you are done.  If desired, you may test your Agents.

If you made a sketch earlier and it shows Synkmark on multiple Macs, repeat the following group of steps on each
additional Mac.  They’re mostly the same as what you did on the first Mac.

Install Synkmark.

Find the synced .bkmslf Bookmarkshelf Document file, which you placed in your Online Synced Folder on your first
Mac.  (For most services, you can get there by clicking on their menulet on the right side of your menu bar.)

Verify that the file is done downloading.  Most services indicate this with a green checkmark “badge” on its icon.  If
you don’t see the file or the badge yet, check your network connection and the configuration of your Online Synced
Folder, and wait a few minutes.  (Path Finder users must Reveal in Finder  to see the badge.)

Double-click the .bkmslf file, to open it in Synkmark.

Click the tab: Settings > Clients and add the clients that you want synced on this Mac, switching on Import,  Export
or both,  as desired.

Set up simple Agents to watch your Clients for changes on this Mac.

If you Paused  agents during the previous step, click the Syncing  button in the toolbar to Resume  syncing.

http://cocoatech.com/


This time, click Export.   Your initial export is very important, to make sure that all clients begin with the same
bookmarks, that is, they begin in sync.

Quit Synkmark.

Your setup is now complete.

If desired, you may test your Agents.
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1.3  Getting Started with Markster 
Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar above to return here.

Import any existing bookmarks. to your Bookmarkshelf document.

Review the following facilities which you may use to land  (add) new bookmarks into Markster, or visit bookmarks
currently in Markster.  Decide which facilities you would like to use.  Some of them require some setting up.

        Facility  Landing  Visiting  Works in browsers
        Keyboard Shortcuts  ✔  ✔  All readable browser apps
        Status Menulet  ✔  ✔  All readable browser apps
        Dock Menu  ✔  ✔  All readable browser apps
        Browser Menu Items  ✔  Firefox only
        Browser Toolbar Button ✔  Chrome, Chromium, Canary only
        Bookmarklet  ✔  All browsers
        Scripting Markster  ✔  

For each facility you’d like to use, perform any setting up as indicated in the links in the table above.

Designate a default folder for New Bookmark Landing.

If you don’t want sound effects when landing new bookmarks, switch off that preference.

If you don’t want to use the default web browser you have already set in Mac OS X, set the default web browser for
visiting from Markster.

Consider whether or not you’d like to hide Markster.

RELATED TOPICS

Landing new bookmarks with the Floating Menu
How new bookmarks get their initial Name  and Comments
Automatic Saving
Which browser is used for visiting
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1.4  BookMacster for One Browser 
To set up BookMacster to manage the bookmarks of a single web browser, you will create a Bookmarkshelf document
with that single web browser as a Client.

Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar to return here.

Activate BookMacster.

Create a Bookmarkshelf Document, switching ON the checkboxes for the browser whose bookmarks you wish to
manage.

If you have other bookmarks in other files, browsers or devices which you want to import and merge with what you
have just imported, import those now and consolidate all of your bookmarks.

Organize your bookmarks.

Click in the menu: File  > Export to all.

You have just manually  organized your bookmarks and you can stop here.

But there’s more, if you want.  BookMacster can keep your bookmarks in a web browser sorted automatically.  It will
watch for when you change bookmarks in the web browser, imports the content, sorts it, and export it.  To enable this
feature, continue…

Set up a simple Agent.

If you Paused  agents during the previous step, click the Syncing  button in the toolbar to Resume  syncing.

This time, click Export.   Your initial export is very important, to make sure that the web browser and your
Bookmarkshelf Document begin with the same bookmarks, that is, they begin in sync.

Quit BookMacster.  If you have set up an Agent, it will work silently.  (If you leave the Bookmarkshelf window open,
your Agent will still work, but it will draw a sheet over the window while it is working, to prevent a conflict between
you and the Agent changing your bookmarks at the same time, which is annoying.)

If desired, you may test your Agent.
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1.5  BookMacster : Sync Browsers 
This section gives the steps to set up BookMacster, possibly in conjunction with other services, to sync the internal
bookmarks of your web browsers.

Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar above to return here.

Activate BookMacster.

Create a Bookmarkshelf Document, importing existing bookmarks from the web browsers you wish to sync.

If there are other bookmarks in other files, browsers or devices which you want to import and merge with what you
have just imported, import those now.  In particular, if there are bookmarks on other Macs that you want to have in
your synced collection, make sure you get those now and import them into this document.  Later, when we Export
on that other Mac, those bookmarks will be deleted.

Organize your bookmarks.

If you have other proprietary sync services such as iCloud, Firefox Sync, Sign in to Chrome, or Opera Link already
syncing your bookmarks, or if your ultimate goal is to sync your bookmarks among multiple devices, read about the
different routes available for syncing multiple devices and sketch out how you will use BookMacster, in conjunction,
with other services if necessary, to reach all the browsers on all devices.

If, as a result of the previous step, you need to disable branches of these other services because they are not in
your sketch, do that now.  If you don’t remember how you set them up, we have links for you.

Set up simple Agents.  This is how you “turn on syncing”.

If you Paused  agents during the previous step, click the Syncing  button in the toolbar to Resume  syncing.

This time, click Export.   Your initial export is important, to make sure that all clients begin with the same
bookmarks, that is, they begin in sync.

Finally, quit BookMacster.  Your Agents will work silently.  (If you leave the Bookmarkshelf window open, Agents will
still work, but they will draw a sheet over the window while it is working, to prevent a conflict between you and the
Agent changing your bookmarks at the same time, which is annoying.)

If you are only using BookMacster on one Mac, you are done.  If desired, you may test your Agents.

If you made a sketch earlier and it shows BookMacster on multiple Macs, repeat the following group of steps on each
additional Mac.  They’re mostly the same as what you did on the first Mac.

Install BookMacster.

Find the synced .bkmslf Bookmarkshelf Document file, which you placed in your Online Synced Folder on your first
Mac.  (For most services, you can get there by clicking on their menulet on the right side of your menu bar.)

Verify that the file is done downloading.  Most services indicate this with a green checkmark “badge” on its icon.  If
you don’t see the file or the badge yet, check your network connection and Online Synced Folder configuration,
and wait a few minutes.  (Path Finder users must Reveal in Finder  to see the badge.)

Double-click the .bkmslf file, to open it in BookMacster.

Click the tab: Settings > Clients and add the clients that you want synced on this Mac, switching on Import,  Export
or both,  as desired.

Set up simple Agents to watch your Clients for changes on this Mac.

If you Paused  agents during the previous step, click the Syncing  button in the toolbar to Resume  syncing.

This time, click Export.   Your initial export is very important, to make sure that all clients begin with the same
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bookmarks, that is, they begin in sync.

Quit BookMacster.

Your setup is now complete.

If desired, you may test your Agents.
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1.6  BookMacster as a Central Store  
To configure BookMacster as a Central Store,  you will create a document that has no Clients.

Follow the steps below.  If you click a link for more detail, use the Back (◀) button in the toolbar above to return here.

Create a Bookmarkshelf Document..  If asked to add web browser Clients, don’t add any.  Just click Done.

Import any existing bookmarks.

Review the following facilities which you may use to land  (add) new bookmarks into BookMacster, or visit
bookmarks currently in BookMacster.  Decide which facilities you would like to use.  Some of them require some
setting up.

        Facility  Landing  Visiting  Works in browsers
        Global Keyboard Shortcuts  ✔  ✔  All readable browser apps
        Status Menulet  ✔  ✔  All readable browser apps
        Dock Menu  ✔  ✔  All readable browser apps
        Browser Menu Items  ✔  Firefox only
        Browser Toolbar Button  ✔  Chrome, Chromium, Canary only
        Bookmarklet ✔  All browsers
        Scripting BookMacster  ✔  

For each facility you’d like to use, perform any setting up as indicated in the links in the table above.

Designate a default folder for New Bookmark Landing.

If you don’t want sound effects when landing new bookmarks, switch off that preference.

If you don’t want to use the default web browser you have already set in Mac OS X, set the default web browser for
visiting from BookMacster.

Consider whether or not you’d like to hide BookMacster.

RELATED TOPICS

Landing new bookmarks with the Floating Menu
How new bookmarks get their initial Name  and Comments
Automatic Saving
Which browser is used for visiting
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1.7  BookMacster : Custom Usages 
The prior sections give instructions explain how to configure BookMaster for the three common use cases:

Configure BookMacster to manage bookmarks of one Browser
Configure BookMacster to sync web browsers
Configure BookMacster as a Central Store  and use it directly

But in fact, all BookMacster features are in fact available to all users at all times, no matter how you start.

BookMacster is a document-based application.  Your bookmarks are stored in a Bookmarkshelf Document.  You may
optionally add local settings which to sync your document with web browser clients.  Syncing is performed by
BookMacster Agents.

Advanced users may choose to have more than one Bookmarkshelf Document, for example Work Stuff  and Home
Stuff.   You create these documents by clicking in the menu: File  > New Bookmarkshelf.

You may want to briefly visit some of the topics linked to above.  By performing configuration steps from more than
one, you can create documents that function for both Cross-Browser Syncing and Central Bookmarks Store.
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2.0  Setup Tasks    
This chapter describes some of the common tasks that you may need to perform in order to set up Smarky, Synkmark,
Markster or BookMacster as a new user.

       Topic Pages in Chapter 2

2.1  Creating a Bookmarkshelf
2.2  Simple Agents
2.3  Test Syncing
2.4  Settings for Direct  Usage
2.5  Changing Your Setup
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2.1  Creating a Bookmarkshelf 
(Smarky, Synkmark, Markster and BookMacster are all based on the Bookmarkshelf document.  However, only
BookMacster supports more than one.  Smarky, Synkmark and Markster create and maintain your single
Bookmarkshelf document automatically.  Therefore, the New Bookmarkshelf  menu item is only available in
BookMacster.)

Click in the menu: File  > New Bookmarkshelf.

If asked, give your new document a name that you will recognize, or accept the default name.

If presented with the list of candidate Client(s), switch on those whose internal bookmarks you want synced…

If you are setting up a document to manage bookmarks of a single web browser, switch on the Import
checkbox for that web browsers, making it a client.  This will also switch on the Export  checkbox.  Leave both
on.

If you are setting up a document to sync web browsers, switch on the Import  checkbox for those web
browsers, making them clients.  This will also switch on the Export  checkbox for each.  Leave both on.

If you are setting up to purely use BookMacster as a Central Bookmarks Store , you will not be doing regular
imports or exports and may therefore leave all checkboxes switched off.

The separate Import  and Export  checkboxes are in case you want one-way  syncing.  To import  means to pull
changes (such as new bookmarks) from a document’s clients (usually, web browsers) into BookMacster for
processing.  To export  means to push changes from BookMacster out to the clients.  Usually, you want both, but if you
don’t, switch off the appropriate checkboxes.

Click button Done.

When asked if you want to Import from Clients Now,  you should click Do It  if all clients have some bookmarks you
want that are not in other clients, or if you only have one Client.
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2.2  Simple Agents 

2.2.1  Simple Setup

To keep browsers in sync, or to just keep the content of one browser sorted alphabetically, you activate Agents.  For
most users, Simple Agents suffice.

Click the tab Settings  > Agents,  then the subtab Simple.

Click the button Full Syncing.

Four of the checkboxes will switch on.

Leaving all four checkboxes on is recommended for most users.  If you want your bookmarks to be sorted
(alphabetized), you should also switch ON Checkbox 2.

If you have no special requirements and want syncing to “just work”, you are now done and may go back to
the previous page.

If you want to make sure that BookMacster will sync as you want it to, please read on.



2.2.2  A Little More Detail

Conceptually, when you switch on these checkboxes, you are enabling sync operations  to occur whenever your
bookmarks are changed.  A sync operation  commences 0-5 minutes after the change, and is slow and lazy by design. 
Upon commencement, it typically takes 5-20 seconds total, and consists of three steps…

Bookmarks changes are read in to your Bookmarkshelf document, from wherever they happened.

[Optional] Bookmarks in your Bookmarkshelf document are sorted (alphabetized).

The changed bookmarks Content is exported from your Bookmarkshelf document to Clients (web browsers and
such).

Voila!  All Clients now have the same, changed bookmarks.  These three steps are enabled in various ways by the five
checkboxes…

Checkbox 1 tells Mac OS X to watch each of your Clients for which you have switched on the Import  checkbox in
the  Clients tab.  Whenever any of their internal bookmarks changes (for example, when you add a bookmark to
Safari), after a few minutes, a BookMacster Worker is activated to import the changes (and, possibly, continue on
to sort and export).

Checkbox 2 tells BookMacster to, after an import triggered by Checkbox 1, sort (alphabetize) your bookmarks. 
Bookmarks are ordered in the same way as if you had clicked in the menu Bookmarkshelf  > Sort All.

Checkbox 3 tells BookMacster to, furthermore after an import triggered by Checkbox 1, export the changed
bookmarks to the web browser Clients for which you have switched on the Export  checkbox in the Clients tab.

For basic syncing among one or more web browsers on one Mac, you need to leave on at least Checkbox 1
and Checkbox 3.

Checkbox 4 tells Mac OS X to activate a BookMacster Worker whenever the Bookmarkshelf document file is
updated from another Mac, which can occur if you keep the document in a Online Synced Folder.  If such an
update never happens, this checkbox has no effect.  If you are planning to sync bookmarks across multiple Macs,
and if you made a sketch which has BookMacster on this Mac syncing with BookMacster on other Macs too, you
may need Checkbox 4 on.

Checkbox 5 is useful if you plan to add bookmarks to BookMacster directly.  It causes an export to occur following
each landing  of a new bookmark.  This immediately syncs the new bookmark to all Clients  and, from there,
possibly, to your other devices.

2.2.3  If you want a Lot More Detail

If you would like even finer-grained control over how and when BookMacster syncs, and additional triggers, such as
syncing on a schedule or syncing when you log in, consider using Advanced Agents instead of these Simple Agents.

RELATED TOPICS

How Agents Work   

Advanced Agents 
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2.3  Test Syncing   
If you want to see how Agents work, click in the menu: BookMacster > Logs and watch the entries as you perform the
test.  Click the little round refresh  button in the Logs  window to display new events.

2.3.1  Testing Syncing in Smarky 

Activate Safari.

Add an internal bookmark.  That is, visit a web page and click in the menu Bookmarks  > Add Bookmark.

Click in the menu: Bookmarks  > Edit Bookmarks  or Show All Bookmarks.

Find the bookmark you just added.

Wait a few minutes.

Verify that the bookmark has moved to its proper position based on your settings of what gets sorted and sorting
order.

2.3.2  Testing Syncing in Synkmark 

Click in the menu: Preferences  > Syncing.

Note the list of Synced Browsers.

Choose one of the browsers which has the Import  checkbox switched on, and another browser which has has the
Export  checkbox on.  (Normally, all checkboxes will be switched on, so just pick two of them.)

Activate the first browser.

Add an internal bookmark.  That is, visit a web page and click in the menu Bookmarks  > Add Bookmark  (or
equivalent).

Wait a few minutes.

Activate the second browser.

Look at its internal bookmarks.

Verify that the bookmark you added in the first browser is now in the second browser, and also that it is positioned
properly based on your settings of what gets sorted and sorting order.

2.3.3  Testing Agents in BookMacster 

Activate a Bookmarkshelf Document window.

Click in the toolbar: Settings  > Clients.

Choose one of the Clients which has the Import  checkbox switched on, and another browser which has has the
Export  checkbox on.  (Normally, all checkboxes will be switched on, so just pick two of them.)

Activate the first client browser.

Add an internal bookmark.  That is, visit a web page and click in the menu Bookmarks  > Add Bookmark  (or
equivalent).

Wait a few minutes.



Activate the second client browser.

Look at its internal bookmarks.

Verify that the bookmark you added in the first browser is now in the second browser, and also that it is positioned
properly based on your settings of what gets sorted and sorting order.
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2.4  Settings for Direct  Usage  
This section highlights the preferences and other settings which are particularly relevant when setting up to use
BookMacster as a Central Store .

       Topics on this Page

Your New Bookmark Landing
Dock Menu
Status Menulet
Global Keyboard Shortcuts
Sound Effects
Popping up the Inspector for a Newly-Landed Bookmark

2.4.1  Your New Bookmark Landing

When Markster or BookMacster create a new bookmark via one of its Firefox menu item, toolbar buton in Chrome, or
BookMacsterize Bookmarklet, it is initially placed in the folder designated as your New Bookmark Landing.   To change
a New Bookmark Landing,

If you have Markster, in the menu click Markster  > Preferences,  then click the Adding  tab.
If you have BookMacsterster, in the toolbar click Settings  > General.

You will see a popup menu.

Which Bookmarkshelf?  BookMacster lands a new bookmark into whatever Bookmarkshelf you have open, asking
you to choose one if you have more than one, or none, open.

2.4.2  Dock Menu

The Dock Menu is one of three facilities in Markster and BookMacster which you may use to display its Floating Menu,
which in turn provides capabilities to land  new bookmarks and visit  existing bookmarks.  To show the Dock Menu,
perform a secondary click on the app’s icon in the Dock.



No setup is necessary.  All running Macintosh applications show a Dock Menu, unless they are in the background.

2.4.3  Status Menulet

The Status Menulet is another of the three facilities you may use to display theFloating Menu, which in turn provides
capabilities to land  new bookmarks and visit  existing bookmarks.  The Status Menulet is not displayed by default.

To display the Status Menulet whenever Markster or BookMacster is running,

Click in the menu: BookMacster  > Preferences.
Click the tab Appearance.
Under Status Item (menulet),  deselect (No Status Item)  by instead selecting the image you would like to see in
your menu bar.

Note that if you have enabled the app’s Launch in Background preference, you must have either a Status Menulet or
Global Keyboard Shortcut to the Floating Menu enabled.  (Otherwise, you would have no way to ever interact with the
app!)  The (No Status Item)  button may be disabled for this reason.

2.4.4  Global Keyboard Shortcuts

Markster and BookMacster offer three keyboard shortcuts which can create or visit a bookmark while you are working
in any readable web browser application.  That is, these keyboard shortcuts become enabled whenever a readable
web browser application becomes the active application.   They become disabled whenever any other application
(including BookMacster itself) becomes the active application.

These keyboard shortcuts are not active by default.  To activate or de-activate them,

Click in the menu Markster  or BookMacster  > Preferences  and
Click the Shortcuts  tab.



To add a keyboard shortcut, click in its text field, hold down the desired modifier keys and then type the desired
character key.

If you enter a keyboard shortcut which conflicts with a keyboard shortcut in a readable web browser application, your
Markster or BookMacster keyboard shortcut will over-ride the web browser’s keyboard shortcut.  If Markster or
BookMacster will not accept your keyboard shortcut, that is probably because the shortcut is in use by Mac OS X.  To
review those settings, click in your menubar:  > System Preferences,  then the Keyboard  tool, then the Keyboard
Shortcuts  tab.

Since many web browsers use ⌘D to create a new bookmark, we recommend using ⌘D as your keyboard shortcut
for Add Quickly,  so that you can add a bookmark to your Bookmarkshelf in the same way as you added a bookmark to
your web browser before you began using Markster or BookMacster.  ⌘⌥D is our preference for Add & Inspect,  but
in order to use it you must switch off the shortcut to Turn Dock Hiding On/Off  in  > System Preferences  > Keyboard
> Keyboard Shortcuts  > Launchpad & Dock.   (As an alternative to that, we’re fans of Automatically hide and show the
Dock  in  > System Preferences  > Dock. )

These shortcut keys work even if Markster or BookMacster have been launched in the background or its window(s) are
minimized to the Dock.

To remove a keyboard shortcut, click the little ⓧ at the right edge of its text field.

2.4.5  Sound Effects

Markster and BookMacster plays a the sound of a page ripping out of a book when landing a new bookmark, and two
quick beeps when landing a duplicate bookmark.  The sound effects may be silenced with a checkbox in Preferences
> Adding.

2.4.6  Popping up the Inspector for a Newly-Landed Bookmark

When adding a bookmark, in some cases you’re in a hurry or don’t want to break your concentration.  In other cases,
you want to stop, compose a good name, add tags and notes, and/or place the bookmark in its proper folder. 
BookMacster allows you to do it either way, at any time.  In the first case, you’re done in one click.  In the second case,
the Inspector opens on the new bookmark wherein you can edit and move it.

If you are using the menu item in Firefox, you have two menu items to choose from, Add Quickly  and Add & Inspect,
which command these two cases, respectively.

If you are using the [Add Here menu item], or the browser action button in Chrome or the BookMacsterize Bookmarklet
in any browser, whether or not you get the Inspector depends on whether or not you’re holding down the option/ alt
key on your keyboard.  To set which is which, click in the menu BookMacster  > Preferences  > Adding



(If you use the BookMacsterize Bookmarklet in Firefox, you must hit the option key quickly after  clicking the
bookmarklet, because holding down the option  key prior to clicking any bookmark or bookmarklet seems to activate
the Save As  feature in Firefox.)
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2.5  Changing Your Setup
Many users, especially switchers from older versions of Microsoft Windows, are in the habit of uninstalling and
reinstalling an app if the app is not behaving as expected.  This doesn’t usually solve the problem in Mac OS X,
because Mac OS X smartly keeps your data and applications separate.  So if you reinstall the app, it will still be using
your same data.  What you want to do is move or remove the relevant data.  With BookMacster, the relevant data is
your Bookmarkshelf Document files.

Removing Preferences  files is also popular.  BookMacster has Preferences, but they are straightforward in
BookMacster and not likely to cause confusion.  Also, starting with 10.9, Mac OS X caches preferences, and removing
the file will have unpredictable results.

This section explains better methods for changing your setup.
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2.5.1  The Reset Button  

If you would like to change how BookMacster is configured, click in the menu: File  > Reset and Start Over.   If you
then follow through and click the button, this will remove all remove all BookMacster documents and data, reset most
preferences, and then present the New User Setup window so you can start over.  Because your doucments will be
trashed, you should only do this if any bookmarks that you want to keep are currently stored in another app or file. 
Typically, your bookmarks are in a web browser app such as Safari.  After you Reset and Start Over, you can re-import
them to a new document.

The documents and data removed are…

All known Bookmarkshelf documents.  Any documents currently open will be closed.
Any Agents which they may have (for syncing, etc.)
Documents’ Sync Logs and Identifier Indexes.
Any pending changes from web browsers.

Reset and Start Over  will not change any of the internal bookmarks currently in your web browsers.  Also, it will not
delete the logs you see in menu > BookMacster > Logs, and will not uninstall Browser Add-Ons.  The idea is to keep
the working infrastructure in place.  Browser Add-Ons can be uninstalled with menu > BookMacster > Manage Browser
Add-Ons.

The few preferences not  reset include cosmetic settings in Preferences  > Appearance.   Any License (registration)
Information is also preserved.

You’ve now down to “scratch” and are ready to start over.

2.5.2  Locating Your Bookmarkshelf Document    

Sometimes it helps to just know where the document whose window you are looking at is located on your hard drive. 
This little trick works in any document-based Mac app.  Hold down the ⌘ key while clicking its title at the top of the
window…



You will see a menu showing the file path  of the document, like this…

In this example, I am using the Dropbox Online File Syncing Service.  My-Bookmarks.bkmslf is in a folder named
Dropbox,  which is my “Dropbox” folder.  It is located in my home (jk) folder.

2.5.3  Moving Your Bookmarkshelf Document 

If you need to move your Bookmarkshelf Document file, click in the menu File  > Save To…  ( or Save As Move…  if
you have Mac OS X 10.7 or earlier).
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3.0  Organizing Tasks    
In addition to automatic sorting and syncing of browsers’ bookmarks, and collecting new bookmarks and visiting
bookmarks directly, the app provides commands which you can invoke manually to organize your bookmarks.  These
commands operate upon a Bookmarkshelf document, and are particularly useful when you have initially created and
populated such a document by importing from old, disparate bookmarks collections and need to organize them.

       Topic Pages in Chapter 3

3.1  Pause and Resume Agents
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3.7  Navigating Your Content
3.8  Create New Items
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3.1  Pause and Resume Agents   
To avoid syncing conflicts, before beginning any major bookmarks reorganization, if you have enabled syncing (in
BookMacster an, Agent) , you should pause  it.  This can be done in one click, using the using the multi-function
Syncing  button near the middle of the toolbar in a Bookmarkshelf  window.

If you have paused  agents, the app will remind you to resume  them if desired when you close the Bookmarkshelf
document or quit the app.

This indicates that no Syncing Agents are available in the Bookmarkshelf.  Clicking the button will expose
the Settings  > Agents  > Simple  tab and prompt you to create an Agent.  Because Smarky and Synkmark
always have Syncing agents available, this state will only appear in BookMacster.

This indicates that a Syncing Agent is currently active.  Clicking the button will cause all of this
Bookmarkshelf’s Agents to be paused  until you resume  them.  To avoid interruptions in your work, you
may want to pause syncing when you are editing Settings or Content in the app.  To avoid conflicts, do not
manipulate bookmarks in any of the Clients while syncing is paused.  If one of the Clients is Safari and you
are using iCloud Bookmarks syncing, it is best to wait until your Mac has been running for 20 minutes after
you have made any bookmarks changes in other devices, for changes to clear.  The app will remind you to
resume  syncing before closing the window.

This indicates that a Syncing Agent is available but syncing has been paused .  Clicking the button will
resume  syncing.

These functions are also accessible from menu items in the Bookmarkshelf  menu.

Home | Parent ← Go → Prior | Next



Home | Parent ← Go → Prior | Next

3.2  Consolidating Your Bookmarks    
You may have bookmarks in disparate old collections, in different web browsers, online services, Macs, computers
running Microsoft Windows, smart phones, etc. which you wish to consolidate into one Bookmarkshelf document.  This
section describes several tools available in the app to help with that.

       Topics on this Page

Singular Import/Exports
Extracting Bookmarks from Other Bookmarks Management Applications
Drag, Drop, Copy Paste

3.2.1  Singular Import/Exports    

The Import from  and Export to  features provides several facilities for manual imports of bookmarks from a selected
source.  To use this, activate a Bookmarkshelf Document), click the File  menu, then the desired action.  They’re near
the bottom.

Submenu Selections
The items at the top of the menu are the available browser apps which have ben found in your Macintosh user
account, and those web-based apps which are generally available.

If your target is an XBEL file or other file which is loose  somewhere on a mounted drive, such as your hard drive, click
the submenu item Choose File (Advanced)  which is at the bottom.

The Import from  and Export to  items in the File  menu allow you to execute one_time imports or exports without
adding or configuring a Client.

To import from or export to a loose, standalone file such as an XBEL file that you have exported from another
bookmarks managedment application, click the Choose File (Advanced)  menu item.  Then, take care to properly
choose New File  or Existing File  at the top of the sheet.

Normal  Import/Export versus Overlay

Normal  Import or Export
For clients which are not listed in Settings > Clients for the current document, a normal  import or export will use the
default settings for new clients.  In particular, this means that any items not existing in the source will be deleted in the
destination.  Also, since this is a first import or export with this client, you will not be warned if the operation exceeds
the applicable Safe Sync Limit.

For clients which are  listed in Settings > Clients for the current document, a normal  import or export will use deviate
from the defaults, using whatever advanced settings for that client and, for Imports, any Import Postprocessing settings
you have set.  In other words, it’s just like you had clicked in the menu Bookmarkshelf  > Import from all  or
Bookmarkshelf  > Export to all,  except that if the Bookmarkshelf has multiple Clients, only one Client will be involved.

Overlay
An overlay  import or export differs from the normal in that no items in the destination will be deleted.  More precisely,
Delete Unmatched Items is OFF.

Combining Import/Export with Other Operations 

If you want to use an Overlay during an Import, but still have unmatched items deleted, you can do this by clicking in



the menu: Bookmarkshelf  > Delete All Content  prior to importing.  After deleting, you should also visit the Settings  >
Structure  tab and configure as desired.  Similarly, if you wish to create a file which has only items exported from your
Bookmarkshelf, you should export to a New File.

3.2.2  Extracting Bookmarks from Other Bookmarks Management
Applications

You can migrate your bookmarks from URL Manager Pro™,  Webnote™,  or Webnote Happy™  to the app via an
XBEL file.  To do this,

Launch any of those applications and click in their menu File  > Export.
Set the Format  to XBEL
Export to a file.  Verify that the exported file’s name ends in the extension .xbel.
Perform a One-Time Import, using  Choose File (Advanced),  then Existing File  of XBEL  format.
Navigate to and select the .xbel file.

3.2.3  Drag, Drop, Copy Paste

In addition to accepting drags and copy/pastes from other Bookmarkshelf documents,  Bookmarkshelf documents
accept drags and copy/pastes from many other applications, as well as text in a a a simple tab-return format
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3.3  Sort (Alphabetize)    

       Topics on this Page
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3.3.1  Sorting means “Putting in Alphanumeric Order”

Unfortunately, the word “sort” has two similar meanings in English:

To arrange data in a prescribed sequence or order
To separate, classify or group things into groups

For our purposes, Sort  employs the first meaning, in particular, to arrange items in alpha-numeric order.   Our
Engineering Department wanted to use a less ambiguous term, orderize  or alphanumericalize,  but our English
Department hit the roof upon hearing of that proposal.  Since order  is ambiguous also (being both a noun and a verb),
we decided to go with our Marketing Department’s recommendation and call it sort,  like other apps do.

3.3.2  Sorting Boundaries

Sorting never moves items from their current folder; it only re-orders items within folders that are sorted.  Also, sorting
will not move items across a separator.

3.3.3  When  Sorting is done

Sorting is done when you click in the menu Bookmarkshelf  > Sort All.   It may also done when a sync operation or
BookMacster Agent is triggered.  Sorting is not done  when you set the will be sorted  or sort this folder  attribute of an
folder; that only sets it up for sorting the next time  that sorting is done.

3.3.4  Which  Items are Sorted

In the Main Content View, a folder’s icon indicates whether or not it is set to be sorted the next time that sorting
occurs.  The app provides several mechanisms by which you can these settings.

Setting Individual Folders Explicitly



For the most fine-grained control, you may set explicitly whether or not individual folders will be sorted.  To do this,
select the folder and then either

Type the keyboard shortcut ⌘7, or
Secondary-click and select the desired setting in the contextual menu, or,
Show the Inspector Panel, and set the desired value in the popup menu…

Bookmarkshelf-Wide Settings
There are more general settings in the Settings > Sorting tab of a Bookmarkshelf().

Sort the Root
The Bookmarkshelf has an implicit root  folder, the parent of all items.  Some Clients accept and display the order in
which the app exports the items in root, and therefore whether or not the root is sorted makes a difference.  Since the
root item does not appear in the Main Content View, it cannot be selected and set explicitly as described above.  The
Sort the Root  checkbox provides this function.

For folders not explicitly set…
Since you would not want to explicitly set the “Do” or “Don’t” sort attribute on hundreds or thousands of folders, the
three radio buttons at the bottom allow you to set default values for these attributes.

3.3.5  Specifying Sort Order

The app provides several several settings by which you can specify the order in which a Bookmarkshelf’s folders are
sorted.

Forcing Items ↑ ↓
Content items have a Sort at…  attribute which you may edit to Top,  Bottom  or Normally  (the default setting).  Setting
this attribute to Sort at Top  will add an attribute to the selected item(s) which will cause them to be sorted to the top of
their folder, regardless of their name.  Sort at Bottom  is similar, for the bottom.  Sort Normally  sets it to be sorted in
normal alphanumeric order.

The Sort at Top  and Sort at Bottom  values are only available if you have set your your Sort by  setting for this
document to sort by name,  because otherwise these tags would have no effect.



The Sort at…  attribute can be set by selecting the item and clicking the desired setting in the Selection  menu, in
some contextual menus or, like all attributes, in the Inspector Panel.

Ignoring Prefixes
A checkbox in a Bookmarkshelf’s Settings > Sorting tells the app that you want certain prefixes, for example “The ” or
“Home Page of ” to be ignored.

This checkbox is only enabled when bookmarks are sorted by name .

If you check this box, the app will look at the prefixes in the list given in Preferences > Sorting, and ignore these
prefixes if they are found at the beginnings of names when sorting bookmarks by name.  (Note that, because the list is
in the Preferences, for BookMacster, it applies to all Bookmarkshelf Documents.)



For example, the entry A  in the list will cause a bookmark named A Big Bad Hockey Team  to be sorted with other
bookmarks whose names begins with B  instead of those whose names begin with A .

Checking the box at the end of an entry tells the app to append a space character to the entry. This is usually desired;
otherwise, for example, entering the word “A” would cause the name “Apple” to appear with names beginning with the
letter p . However, it is not usually desired when omitting a url-type prefix, such as “http://www”, as indicated in the
default prefixes. (You could get the same effect by putting a space after the entry, but the checkbox is easier to see
and understand.)

This feature can lead to unexpected results if more than one prefix in the list matches a name!  If one prefix “contains”
another, you should put the longer one first, because the app parses the list from top to bottom.

Sort by…
Although items are normally sorted by name, the app can also sort by URL, according to a Bookmarkshelf Setting…



by Name
When you add a bookmark to a site in a web browser, you are prompted to give it a name.  The default name  is the
title of the page which is provided by the site. For example, the title of Apple’s iTunes page is “Apple - iTunes”.  The
name is also what appears in the Bookmarks Menu.  Most people use this default option.

by entire URL
The entire url  (uniform resource locator) is the “address” which appears in Safari’s address bar, for example
“http://www.apple.com/itunes”.  Note that this method sorts firstly by the scheme,  which is the first “word” in the url,
which in this example is “http”. This method will typically sort with all “ftp” bookmarks first, then all “http”, then all
“https:”.

by domain, host, path
If you choose domain, host, path,  the app reverses the URL, sorting firstly using the top-level domain  (TLD). If the
TLDs are the same, it then sorts by 2nd-level domain,  then 3rd-level domain,  then 4th-level domain,  etc.

If the app finds more than one bookmark in a subfolder with the same host,  it then parses the path  to determine the
order among them. (The path  identifies the file on the remote host which is sent when you click on the bookmark.)

There may be other keys following the path,  such as password  and query.   The app ignores these other keys.

If you have not been giving good names to your bookmarks, you may want to sort by domain, host, path  until you get
things straightened out.

by Rating (stars)
Sorting by Rating (stars) will sort items with more stars in their rating before siblings with fewer stars.

Secondary and Tertiary Sorting
Particularly when sorting by Rating (stars), more than one item in a folder may have the same attribute (same number
of stars, for example).  When this happens, the app sorts those items using other attributes, in this order, until all such
ambiguities are resolved…



Type, putting folders above bookmarks
Name
Rating (stars)
An internal unique identifier

Because that last attribute is guaranteed to be unique, repeatedly sorting the same items always gives the same
result.

Folders ↑↓ Bookmarks
At the bottom of Settings  > Sorting  is a control which can set folders to be sorted above bookmarks, or vice versa…

This attribute is only editable when bookmarks are sorted by name.

Here is an example of a folder sorted with Folders above Bookmarks:

Here is the same folder sorted mixed:

Here is the same folder sorted with Bookmarks above Folders:



3.3.6  Keeping bookmarks sorted automatically

The app can keep your bookmarks in a browser such as Safari sorted automatically.  To set this up,

in Smarky or Synkmark  

Click in the menu: Preferences,  click the Sorting  tab and switch on the checkbox…

in BookMacster  

Add the browser as a Client, and then in the Settings  tab, > Agents,  switch on the Sort  checkbox number 2.

In the very simple case of only one web browser Client on one Mac, Settings  > Agents  should look like this…

If your document is using Advanced Agents, add Sort All  before Export  in the Commands  table.

3.3.7  Web Apps Cannot be Sorted 

Locally-installed web browsers such as Safari store bookmarks in the order in which you (or BookMacster) arrange
them.  However, web apps such as Delicious do not.  Therefore, exporting sorted bookmarks BookMacster to a web
app does not affect the order in which the web app will display them when you log into your account in their web app.
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3.4  Duplicates    
The app has tools to manage duplicate bookmarks, which we call Duplicate Groups, and also tools to manage
Duplicate Folders.

It is important to understand that the app can’t work on the bookmarks in Safari, Firefox or Chrome directly.  In
addition, the precise definition of what makes a duplicate  requires some discretion.  Here is how you eliminate
duplicates from bookmarks in a web browser…

Import the bookmarks from the web browser into Smarky, Synkmark, Markster or BookMacster.

Configure whether or not you wish to ignore duplicates that are in different hard folders.

If desired, mark special bookmarks as Duplicate Allowed.

Find the duplicates.

Delete the duplicates, either individually, or en masse.

Review your de-duplicated Content.

Export the bookmarks back out to the web browser.
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3.4.1  Duplicate Groups (Bookmarks)

A group of bookmarks in a Bookmarkshelf which have the same URL is said to form a duplicate group.   (Note that the
app normalizes URLs.)  The app is able to find duplicate groups within a Bookmarkshelf and displays a list of them in
the tab Reports  > Duplicates.



Note that some browser apps (for example, Google Bookmarks, Delicious, and Firefox) do not allow duplicate groups
within your account. If you create within or export a new bookmark into one of these apps which creates a duplicate
group with an existing bookmark, one of them (usually the existing one) will be immediately and silently deleted.

3.4.2  Finding Duplicates (Bookmarks)

Because the process of finding duplicates needs to compare each of your bookmarks with every other bookmark, it
can take quite a few seconds of intense computation when the number of bookmarks is large.  (For example, if you
have 1000 bookmarks, 1000 URLs may need to be computed, and 1000 × 999 / 2 = 499,500 comparisons must be
made.)  Therefore, the app does not always keep this report updated, and instead does so only when commanded to
update the report.

To find duplicates and thus update the report, you may click in the menu Bookmarkshelf  > Find Duplicates,

or else click the hyperlink in the tab Reports  > Duplicates.

If these controls are disabled, that means that no change which could have added duplicates has occurred since the
last such update, and therefore no update is necessary.

Deleting duplicate groups in response to changes is not as laborious as finding them, so the app observes such
changes and deletes defunct duplicate groups “on the fly”.



The app detects as duplicates bookmarks whose URLs are the same except for schemes http  vs https.

If you think that the app is not finding all the duplicates that you think are duplicates, see Aggressively Normalize
URLs, below.

3.4.3  Allowing Some Duplicates (Bookmarks)

Although duplicate bookmarks are undesirable in general, you may wish to allow duplicates of certain bookmarks for
easy access.  the app provides two mechanisms for you to do this.

Ignore Duplicates in different Hard Folders
Ignore Duplicates in different top-level Hard Folders  is a setting which is useful if you’d like to keep a few commonly-
used bookmarks in one hard folder, for example the Bookmarks Bar, but also have duplicates in another hard folder
such as the Bookmarks Menu.  If this box is checked, Duplicate Groups which involve bookmarks in different Hard
Folders are not reported.

Bookmarks whose lineage does not include one of these four hard folders, such as bookmarks in root directly, or
bookmarks which are in a soft folder which descends from root, are considered to be in a “root” hard folder.  Duplicate
Groups comprised of one bookmark in, for example, Bookmarks Bar, and another in the “root” will be ignored if this
setting is checked ON.

In Smarky, Synkmark and Markster, this setting is a checkbox in Preferences  > General.   In BookMacster, the
checkbox is in a document’s Settings  > General.

Duplicate Allowed  Attribute
Duplicate Allowed  is an is an attribute which may be switched on in any bookmark.  A bookmark so marked will never
appear in a Duplicate Group.  There are several ways to mark (or unmark) a bookmark with this attribute:

In the Inspector panel, there is a Duplicate Allowed  checkbox.
In the tab Reports  > Duplicates,  clicking the button:

will set the Duplicate Allowed  attribute of the selected bookmark(s).

In the User-Defined Column in the Main Content View, if you set the column header to Duplicate Allowed.

3.4.4  Removing Duplicates (Bookmarks)

Of course, the direct way to remove a duplicate group is to delete all of the bookmarks in it except one.  You can do
this in either the Content View or, as shown here, in Reports  > Duplicates& #8230;



Delete All Duplicates
But if you find yourself with more duplicate groups than you care to deal with individually, you can command the app to
Delete All  duplicate groups…

If you click Delete All, the app will step through each of the group and delete all except one in each.  (This is the same
as clicking from the main menu > Bookmarkshelf  Delete All Duplicates…. )

Although this is fast, it may in some cases delete bookmarks whose name and/or location you would have preferred.  It
is undo-able, so you can experiment.

Tags of deleted bookmarks.  If a deleted bookmarks has any tags, the app adds its tags to the tags of its surviving
bookmark in the group, so that no tags are lost in this process.

Which one will survive?  For each group of less than 12 bookmarks, the app decides which one one has higher item
quality.

For groups of 12 bookmarks or more, the app simply chooses one at random and deletes the remainder.  This is done
to reduce the amount of time that it takes.

3.4.5  Aggressively Normalize URLs

When the app enters a bookmark into a document, either because it was imported or because you typed it in, the app
normalizes its URL.  One of the effects of this is that all bookmarks in a document which must  refer to the same web
page have the same URL.  When the app finds duplicates, therefore, because normalization has already been done, it
simply looks for identical URLs.

Users often have some bookmarks which may  technically refer to different web pages, but in fact refer to the same
web page.  So the app will not recognize them as duplicates as the user would like.  The most notorious example is
bookmarks whose path  portion of its URL has one or more components, ending in a slash.  Here is an example,
showing two URLs for a bookmark whose path portion has one component, “/bar”

http://foo.com/bar



http://foo.com/bar/

Technically, according to IETF standards, these two URLs may refer to different web pages.  Therefore, the app’s
normalization does not  remove a trailing slash from the end of a URL’s path  if it has one or more components, and
the app will not recognize these as duplicates.

If you do  want the app to recognize these as duplicates, you can use the menu item Bookmarkshelf > Aggressively
Normalize URLs, which will strip any trailing slashes from the ends of the URLs of all bookmarks in the document
whose path has one or more components.  Note that this does not widen the app’s definition of a duplicate.  Instead, it
is a one-time operation which checks all of the URLs in a document, and modifies some of them.

To aggressively delete duplicates, including such “near” duplicates in a document,

Click in the menu: Bookmarkshelf  > Aggressively Normalize URLs
Review the results.
If you think this did more harm than good, click in the menu: Edit  > Undo  and instead remove undesired trailing
slashes manually.
Proceed to Find Duplicates.
If desired, Delete All Duplicates.

Note that if a URL has no  path components, the app will  add a one-character path, “/”  Example:

http://foo.com
http://foo.com/

The above two URLs are  technically the same, and the app will  automatically add a slash to the end of the first one
immediately upon it being imported or typed in to a document.

3.4.6  Consolidate Folders

The app’s definition of duplicate folders is more restrictive than that of a duplicate bookmarks.  To be considered
duplicates, folders must (a) have the same parent folder, that is, be siblings of one another and (b) have the same
name, where uppercase and lowercase differences are ignored so that, for example, “News” = “NEWS”.

In its main menu, the app provides Bookmarkshelf  > Consolidate Folders  menu item.  Clicking this menu item will
search for all such such duplicate folders, select the one with the higher item quality, and merge all bookmarks from
like folders into this one, emptying the others.  It will also search for and delete all empty soft folders.  Empty folders
are deleted whether they were made empty by the merging, or whether they were empty to begin with.

Note that merging some duplicate folders and deleting some empty folders is also performed in the normal course of
any Import or Export operation, but in this case the merging and deleting are only performed on folders which became
candidates as a result of the Import or Export.

3.4.7  Automatically Detect New Duplicates (BookMacster only) 

Because one person’s duplicate may be another person’s favorite bookmark, manually deduplicating, as described
above, is recommended.

If you have BookMacster, however, and are using Agents to sync or sort bookmarks, you can set it to check for
duplicates whenever bookmarks are changed, as part of each syncing job.  The same rule regarding Hard Folders,
and any Duplicate Allowed attributes you have set on special bookmarks are respected.

To configure automatic duplicate detection,

Configure Agents to sync some web browser(s).

In the Clients > Agents tab of your document, click the Advanced subtab.



In the Commands table, you should see three commands.  Hit the square “+” button, to create a new command.

Change the new command to Find Duplicates.

Drag it above Save Document, so that it is command number 3.

As always, after you have configured syncing, quit BookMacster.  BookMacster Agents work most quietly and
efficiently when BookMacster is not running.
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3.5  Verify Bookmarks    
       Topics on this Page

How Verify Works
Automatic URL Updates
Fixing Broken Bookmarks
Don’t Verify  Bookmarks
URL Maintainance Tips

3.5.1  How Verify Works

When you click Verify,

the app presents you with a choice of how many bookmarks to verify,

and then begins a process which sends a request to the resource indicated by each of the bookmarks in the
Bookmarkshelf.  In accordance with internet protocols, the site responds with either an “OK” or an error message.  By
analyzing this response (or lack thereof) and the response from your Mac, the app decides whether or not this
bookmark has a high probability of being broken, and if so, formulates a diagnosis and suggested treatment.

Progress Display
Detailed progress of a Verify  operation is shown in the right-side drawer which pops out of the Bookmarkshelf window



Your Mac is capable of handling many internet connections at once; therefore to improve the speed of the operation,
the app sends requests for additional bookmarks before receiving responses from the prior one.  Up to sixteen
requests may be outstanding in this way.  Actually, a broadband internet connection should be able to handle many
more, but we have found that some internet connections will employ traffic shaping if they see a computer visiting sites
too quickly, even if the amount of data transacted is minimal, as it is in the app’s Verify.  The traffic shaping we have
seen is that all additional requests will be summarily ignored for a minute or two; then they turn it on again.  When the
app detects all requests failing, it slows down to a very low rate of 1 or 2 per second until responses start appearing
again, then accelerates.  Limiting outstanding requests to sixteen limits the number of requests that will be dropped
between the time that traffic shaping is applied and the time that the app detects it.

After a first pass, the app performs a second pass, retesting any failed bookmarks at a much slower rate.

Throttle Adjustment
During the first pass of Verify, you may adjust the rate at which the app sends out its first requests to websites.  The
default rate of 20 requests per second (that is, 20 websites per second) works well if you have a single computer on a
typical DSL or broadband cable internet connection; typically a thousand bookmarks can be verified in just a few
minutes.

At this wicked rate, however, you will notice that the internet bandwidth available to other applications and other
computers using the same internet gateway will be reduced.  For example, Safari will load web pages more slowly and
multi-player games played over the internet will “lag” until the app completes the first pass of its verify operation.

To reduce the impairment seen by other applications and users, lower the throttle setting and allow Bookdog more time
to verify.

Slower computers will not be able to achieve 50 requests per second of regardless of internet connection; they will
simply go as fast as they can.  Also, if you have a dial-up internet connection, you will be able to complete only 2 to 5
requests per second. Although the overall verify time may be increased if the process is frequently waiting due to too
many outstanding requests, setting the throttle too high does not affect reliability too much, because Bookdog will
retest all non-responding resources in a second pass, done slowly, as described above.

HTTP Status Code
The first thing the app looks at in a response from a site is the HTTP Status Code.  If a website is working normally, the
app this is the number 200, which means OK .  Other codes indicate various errors.  The status codes 301 and 302,
for example indicate a redirect.   They come with a new url to use instead of the old url you have.  Proper protocol is to
send a “301” status code if the url has been moved permanently, or “302” if the url is changed temporarily.

Request Method
For those interested, the HTTP Method  specified in the request the app sends to each site is GET,  which retrieves
both header  and content.   Theoretically, a HEAD  method, which retrieves only the header  should be sufficient.  But
we have found that a small number of sites, maybe 2%, respond differently to a HEAD  request.  To reduce
unnecessary of network traffic, the app cancels the request once the header has been received.

Verify Result for a Bookmark

http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html
http://www.w3.org/Protocols/rfc2616/rfc2616-sec5.html#sec5.1.1


The app registers as an attribute with each bookmark the verify status code it receives and, possibly, a redirect URL.

3.5.2  Automatic URL Updates

When a Verify operation concludes or is cancelled, the app takes a second to sift through the results or partial results,
and automatically updates the URLs of bookmarks for which a better URL has been found.

Which bookmarks are automatically updated
Bookmarks which responded with HTTP Status Code 301 (“Permanent Move”), and some of the bookmarks which
responded with HTTP Status Code 302 (“Temporary Move”) are always automatically updated.

A literal reading of HTTP Status Code definitions implies that only bookmarks with HTTP Status Code 301 should be
updated.  However, we have found that many sites incorrectly respo and with HTTP Status Code 302 when these
moves are in fact permanent. Therefore, the app takes a closer look at bookmarks with HTTP Status Code 302 and
classifies them into three categories…

Probably Temporary  URLs which indeed appear to be temporary moves, as the site claims.
Probably Permanent  URLs which look much more like permanent moves.
Not Sure  URLs which score in between the other two cases.

Update Options for bookmarks returning HTTP Status Code 302
The radio buttons in the rows for Status Code 302 allow you to choose how aggressively the app automatically
updates URLs.

In the first row, note that the app never updates URLs which it deems are probably temporary address changes.  In the
second row, you tell the app how to deal with bookmarks which it deems are probably permanent address changes.  In
the third row, you tell the app how to deal with bookmarks which it is unsure about.

In either case, the choices are:

leave them alone and report them as being OK
to update their URL to the suggested URL
leave them alone and report them as being broken.

You may punch the buttons back and forth because the app remembers what it did and dynamically fixes and un-fixes
bookmarks as commanded.

How URLs are Rotated during Automatic Updating
When the app automatically updates  a bookmark, its rotates those three URLs such that the Suggested URL
becomes the Current URL,  the old Current URL  becomes the Prior URL,  and the old Prior URL  disappears
(although it is still available via Edit > Undo).  Saying that in a picture…

          Suggested ➞ Current ➞ Prior ➞ oblivion

If you un-automatically update  a bookmark, for example by changing the disposition of its category in the Verify Report
so that it is instead treated as OK  or Broken,  the opposite happens…

          Suggested ← Current ← Prior

3.5.3  Fixing Broken Bookmarks

Bookmarks which return a failing Verify Status Code, but cannot be automatically updated by the app are broken.   To

http://en.wikipedia.org/wiki/URL_redirection


fix  a broken bookmark, you’ll either delete it, change its URL, consolidate it with some other bookmark, etc.

Broken  bookmarks are summarized in a the columns in Reports  > Verify.

To see the list of broken bookmarks, click the magnifying glass button  next to the total.  This will send you into the
Find Report, and set up a search predicate to display all of the broken bookmarks which were not automatically
updated by the app.

Although that is usually what you want, we note in passing that you can change the predicate at the top to concentrate
first on a particular class of failures.  For example, say that you would like to see all bookmarks for which the Verify
Status Code is -1003, indicating “Can’t find host”.  Change the predicate in the FInd Report to this:

Clicking that magnifying glass will also open the Inspector Panel and open its bottom drawer:

The Inspector panel will display data of whichever bookmark is currently selected in the report.  Use the down-arrow
key (↓) to step through the results.

Information pertinent to Verify is in the bottom drawer of the Inspector.  The top left corner of this drawer gives you the
actual facts that were received.  The top right corner gives you the app’s advice, and the bottom shows up to three
URLs which the app has for this bookmark, with some buttons to swap and test them.

The Current  URL is the one that will be exported to browsers and used when visiting within the app.  If the URL



labelled Current  is the one you want, you’re done.  If you want one of the other two, swap the one you want into
Current  by clicking one of the swap  buttons with the circular arrows to the left of the URLs.

If you conclude that the bookmarked page is no longer available, hit the delete  key to delete the bookmark.

Reverifying the Unverified
Clicking the gear button  in the Unverified  row will initiate another Verify operation, verifying only those bookmarks
that are unverified.

3.5.4  Don’t Verify  Bookmarks

In analyzing the response from a website, the app uses an algorithm based on our experience to determine whether
the requested web page is OK , broken,  or not sure.   However, in some cases a site which is in fact OK  may be
detected as otherwise by the app.  The app will “learn” about a troublesome bookmark if you check on  its Don’t Verify,
causing the app to skip over this bookmark during future verify  operations.  You can set (or un-set) this attribute by
viewing its checkbox in a User-Defined column in the Content View, or else in the Inspector Panel:

You can display a list all bookmarks that are marked Don’t Verify  by searching for this attribute value in the Find
window.  There is a button in Reports  > Verify  that will configure such a search with one click.



Because a bookmark which has been marked as Don’t Verify  will never be verified, it will never have its URL updated
by the app, even if the website returns a 301 Moved Permanently  message. Thus, Don’t Verify  also means “Don’t
ever update my URL”.

3.5.5  URL Maintainance Tips

More than one URL seems to work fine!
Often, testing a bookmark which has a 302 “found” or “moved temporarily” redirect, you will find that both the url you
now have and the proposed new url take you to the same web page. Should you copy the new one or click Don’t
Verify  and continue to use your old one? You must use your judgment. If you see that the domain (the “main” part of
the url, for example “sheepsystems.com”) has changed, then probably you should copy the new domain. But if you see
that the proposed url ends with a question mark followed by something like “?sessionID=7A451E42” (technically called
the query  part of the url), then maybe you should try the new domain but delete the query (the part that begins with
the question-mark “?”). In many cases, both urls will continue to work for a long time, so don’t spend too much time
worrying about it.

Multiple Errors
Sometimes there are multiple errors in urls; for example, it may redirect you to a different url which turns out to not
exist either. It takes two Verify/Fix operations to fix this one!  Again, don’t worry about these; you’ll get them the next
time.

Unable to ever get an “error-free” Verify of all bookmarks
Testing, say, 1000 bookmarks, is getting a fairly good sample of the world.  And if only 99% of the world is working
properly at any given time, that’s going to result in 10 failed bookmarks.  Whether or not they “work” at any given time
depends on the internet, and on each webmaster whose site you have bookmarked.  All of these are ever-changing
and imperfect. It is interesting to repeat the Verify  process a second time, but any more than that will be frustrating,
possibly resulting in some of the 10 or so failures testing OK, but new failures appearing from among the 990 which
were OK the first time.  the app’s re-checking of nonresponders is quite effective, but often sites are unavailable for
minutes at a time.  That being said, if you believe that the app is consistently reporting bad results for a popular site
which is OK, or vice versa, please contact our Support team. We’ll investigate and see if we can improve our algorithm.

http://sheepsystems.com/support/


Load-Sharing Servers
Many web sites are hosted with load-sharing servers (computers) to distribute the traffic load, and these are often
indicated in the url with a small number following the server name. For example:

http://www01.sheepsystems.com
http://ww3.sheepsystems.com
http://www4.sheepsystems.com

These are different servers that all handle requests which are distributed to them from www.sheepsystems.com. Any of
them may be down, moved or permanently taken out of service at any time. Therefore, when you are adding a
bookmark to a site with a server name like this, you should immediately edit its url to indicate instead the “parent”
server, which in this example is “http://www.sheepsystems.com”.

Shoppers out there will also often see this with a “store” server, for example:

        http://store2.esellerate.net/store/catalog.aspx?s=STR6837001335&pc=

was one of three “store” servers used by our old distributor, esellerate. The correct url for our store was:

        http://store.esellerate.net/store/catalog.aspx?s=STR6837001335&pc=

The app knows about this problem and ignores “302” redirects to some parallel servers during Verify.

Home | Parent ← Go → Prior | Next
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3.6  Tagging    
There are several views in which you can tag, un-tag and revise tags in Smarky, Synkmark, Markster or BookMacster,
including bulk operations for editing multiple tags or multiple bookmarks

       Topics on this Page

Tags in the Content View
Tags in the Tags View
Tag Filter in the Tags View
Bulk Operations on Tags
Tags in the Inspector Panel

There are several views in which you can tag, un-tag and revise tags in Smarky, Synkmark, Markster or BookMacster,
including bulk operations involving multiple tags or bookmarks.

3.6.1  Tags in the Content View

In the Content Tab, just below the toolbar, is the Detail View.

The Detail View is a dual-purpose view which can access either lineage or tags.  You switch between the two using the
selector switch at its left end.  For this purpose, switch it to the string-tag icon, which means, of course tags.

The Detail view now shows you the tags of the bookmark selected in the Content below it.  You can add tags by typing
into this field, or delete tags by selecting one or more and hitting the delete key.  But it’s also cool if you have more
than one bookmark selected.  In this case, it will show the combined tags (for the mathematically versed, the union set)
of the tags of all of the selected bookmarks.  And if you can type in a new tag, it will be applied to all bookmarks in the
selection; similarly for deleting tags.

When typing in multiple tags, separate them with the Tag Delimiter that you have specified in the document’s Settings
> General…

By default, it is set to Your Default Tag Delimiter, which in turn is set in Preferences > General.  The idea here is that if
you have multiple Bookmarkshelf documents, each document can have a different tag delimiter.

3.6.2  Tags in the Tags View

To the left of the Content View is the Tags View.



The tooltip (the box which you see when you hover the mouse over the Tags View, as in that screenshot), explains with
the Tags View is and the short version of two cool things you can do in it.  Here is a longer version…

You can select multiple bookmarks, using ⌘-click or shift-click as usual, and then drag the selection left to the Tags
View, and drop them on a tag.  All of the dropped bookmarks will be tagged with the the tag you drop them on.   will
all be so tagged.

You can also do the opposite, selecting multiple tags with ⌘-click or shift-click, and dropping them onto a
bookmark.  The bookmark will be tagged with all of the tags.

You can delete a tag, or a selection of tags, by selecting it, or them,  in the Tags View and hitting the delete key.

You can rename or delete a tag by performing a secondary click (right/control click) on it in the Tags View and
using the contextual menu which will appear.

3.6.3  Tag Filter in the Tags View

At the top left of the Content Tab, the Tag Filter switch filters items in the Main Content View to show only items which
have a tag matching those which are selected in the Tags View just below it.  The switch has three settings.

  Switching the Tag Filter to the dash deactivates it, so that the Main Content View is not be affected by the
selection in the Tags View.

  Switching the Tag Filter to one checkmark will hide any items that do not have any  of the tags selected in the
Tags View.



  Switching the Tag filter two checkmarks will hide any items that do not have all  of the tags selected in the Tags
View.

If only one tag is selected, any  and all  are the same.  In this case, the  and  settings have the same effect.

3.6.4  Bulk Operations on Tags

To make the same tag changes to many bookmarks
If necessary, “tag” the first bookmark you want tagged by selecting it in the Content, then activate the Detail view,
enter the tag, then hit return.

Activate the Content and, using ⌘-click or shift- click, select all of the other bookmarks you want to have this tag.

Drag the selected items from the Content to the desired Tag in the Tags View.

Alternatively, if all of the target bookmarks currently have no tags, or have the same tags in the same order, you may
select all of them in the Content and then add or remove tags as desired in the Detail View.

To add several existing tags to a bookmark
Activate the Tags View and select the several Tags you want by using using ⌘-click or shift- click.

Drag the selected tags to the desired bookmark in the Content.

3.6.5  Tags in the Inspector Panel

You can manipulate tags of any single bookmark in the Inspector Panel.  To get the Inspector Panel, hit the Inspector
button at the right edge of the toolbar, or type  ⇧⌘I.
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3.7  Navigating Your Content    
The Bookmarks Content  of a Bookmarkshelf document is the bookmarks, folders and separators, all with their own
attributes and all arranged in a hierarchy which can mimic (exactly, if desired) the arrangement of bookmarks you see
in a web browser such as Safari or Firefox.  The content is displayed in the Content Tab  of the document window.

       Topics on this Page

Content View
If you don’t like folders popping open…
Tags View
Filtering to Find Selected Content
Heavy-Duty Searches
The Detail View
Moving items Across Bookmarkshelf Documents

3.7.1  Content View

The main (right) pane of the window shows a representation of the Bookmarkshelf’s content in either Outline Mode or
Table Mode.  In Table Mode, folders are shown at the bottom, and separators are not shown.

The Mode Switch at the upper left has two positions.

 Outline Mode  shows all items, with their lineage and hierarchy.

 Table Mode  omits Hard Folders, Soft Folders, and separators.  It shows bookmarks only, ordered
alphanumerically by name.  Because it does not show the hierarchy, this type of view is also called flat.

In either view, items have contextual menus.  To access a menu of available actions available for an item, secondary
click the item.

To select multiple items, hold down the shift  key to extend a  selection contiguously, or click with the ⌘ key down to
add individual items discontiguously.

A notation such as this…

        (99§ 888▐)

means that the document or folder contains, in this case, 99 subfolders and 888 bookmarks in all of its descendants.

3.7.2  If you don’t like folders popping open…



To prevent folders from springing open as you drag items across them, hold down the shift  key on your keyboard as
you begin the drag (or as you enter the Content View from another window).

3.7.3  Tags View

On the left side of the Content tab is the Tags View, which  shows the aggregate of all of the the tags, if any, attached
to the Bookmarkshelf’s bookmarks, in a box called a tag cloud.   The number [in square brackets] after the tag’s name
indicates the number of bookmarks in the Bookmarkshelf which have this tag.  The Tags View is ordered
alphanumerically starting at the top left.

If you don’t use tags, feel free to grab the little window divider handle to the right of the Tags View and slide it
all the way to the left.

3.7.4  Filtering to Find Selected Content

There are two filters  in the Content tab which filter the contents of the Main Content View, showing only those which
meet your search criteria in both  of them, if activated.

For more advanced searches, click to the Reports  > Find  tab.

Tags Filter

Operation of the Tags Filter is described in the section on Tagging .

Text Filter (Quick Search)



The Text Filter is the Quick Search  field in the Toolbar.  The Text Filter is activated automatically when you type any
characters into it, and deactivated when you delete all the characters in it.  The latter can also be done by clicking the
little  on the right.

Clicking the  magnifying glass icon on the left brings up a small contextual menu with several sections…

Search for Section.  In this section, you select the type of items which will be allowed to appear in the Main Content
View.  Clicking the items checks them (turns them on) or unchecks them (turns them off).  Checking on Bookmarks
allows bookmarks to appear, checking on Folders  allows folders to appear, and checking on both of them allows both
bookmarks and folders to appear.

Search in Section.  In this section, you select the attributes which will be search for the matching text you have
entered into the search field.  Again, clicking the items checks them (turns them on) or unchecks them (turns them
off).  For example, if you type in “Orange” and check on Name  and Tags,  then only items with containing the text
“orange” in either their Name or Tags will appear in the Main Content View.  The text filter is case-insensitive, meaning
that you’d also find items containing “oRAnGe”.

3.7.5  Heavy-Duty Searches

Although the Content Filters are handy for quick searches, the Reports > Find allows you to filter your bookmarks
content and find those with almost any criteria imaginable.  The interface is fairly self-explanatory except for the fact
that you can create compound predicates  by holding down the option  key as you click the ⊕ button.

Here is an illustrative example of a complicated predicate:



3.7.6  The Detail View

Near the top of the Content tab is a little subview which may show  either the tags  or the lineage  of the item(s)
selected in the Content.  The selection between tags and lineage is made using the switch at the left.

3.7.7  Moving items Across Bookmarkshelf Documents 

In this section we discuss a move  of items as opposed to a copy  of items.  The difference is that when items are
moved,  they are removed from their original location.

There are two ways to do this:

Drag and drop without holding down the option  key
Using the Move to  contextual menu item

In accordance with Apple Human Interface Guidelines, moving  items in this way from one Bookmarkshelf document to
another does not delete it from the source Bookmarkshelf.  It is actually a copy  operation.

RELATED TOPICS

Editing tags
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3.8  Create New Items    
In addition to importing content from browsers and files, cut/copy/pasting and dragging between BookMacster
Bookmarkshelf() documents, you can create new content items from scratch in the following ways.

From scratch. To create a new item, you may optionally select a “parent” or “sibling” where you would like it to

appear, then click  and select the type of item you would like to add.  Alternatively, you can add a folder,
bookmark or separator from the Selection  menu

From a .webloc  file. You can drag and drop in one or more Safari web location  files and it will create a new
bookmark. (These files have names that end with extension .webloc  and are created by dragging a url from
Safari’s url field to the desktop or a Finder window.)

From Safari’s address and search field.  You can create a bookmark to a web page you are viewing in Safari by
dragging in the icon (favicon) which appears in Safari at the left edge of the address and search field.

From Safari’s Show [All] Bookmarks . You can copy a bookmark or whole folder of bookmarks by dragging in an
item from Safari’s Show [All] Bookmarks  bookmarks manager.

From text in other applications.  The app accepts drags of text in a special tab-return format.
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4.0  Reference Topics    
This chapter contains technical details for troubleshooting and advanced usage.

       Topic Pages in Chapter 4

4.1  Glossary
4.2  Finding Your Settings
4.3  Import, Export & Syncing
4.4  Visiting Bookmarks
4.5  Visiting + Adding
4.6  Browser Add-Ons
4.7  Browsers (Clients)
4.8  Browser (Client) Oddities
4.9  Agents
4.10  Multi-Device Sync Configurations
4.11  Sync Loops
4.12  More About Syncing Among Macs
4.13  Hiding and Scripting
4.14  Bookmarkshelf  Document File
4.15  Bookmarkshelf Structure
4.16  Organizing In Folders vs. Tags
4.17  Bookdog Grads’ Startup
4.18  Resolving Errors
4.19  Interpreting Icons in Content
4.20  The Inspector Panel
4.21  Open, Save Automatic Actions
4.22  Bookmarks, Folders and Separators
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4.1  Glossary    
Our glossary includes quite a few standard Macintosh terms, which we were unable to find good definitions for
elsewhere.

❖❖ Active Application
Mac OS X allows you to have many applications (apps) running simultaneously, but only one is the active application
at any time.  The active application  is the one whose name appears next to the Apple  menu in the upper left corner
of your screen.

You can quickly switch to a new active application by holding down the ⌘ key while hitting your tab  key.

❖❖ Application Menu
The Application Menu  of a Mac app refers to the first main menu item, after the Apple  menu, at the top left of your
menu bar, whose title is the name of the application, in our case Smarky,  Synkmark,  Markster  or BookMacster.

❖❖ Auto Save and Versions
Auto Save and Versions is a feature of Mac OS X.  It works a little differently depending on whether you have OS X
10.7 or OS X 10.9.  OS X 10.8 takes some details from both of those documents.

❖❖ Tab-Return Format
When dragging bookmarks to or from other applications that accept text, Smarky, Synkmark, Markster and
BookMacster uses the following format:

    name-of-first-bookmark{TAB}url-of-first-bookmark{RETURN}
    name-of-second-bookmark{TAB}url-of-second-bookmark{RETURN}
    ...
    name-of-last-bookmark{TAB}url-of-last-bookmark{RETURN}

where {TAB} denotes the ASCII 0x09 character which is produced by the tab  key on your keyboard in most
applications, and {RETURN} denotes any of the newline characters 0x0a, 0x0d or 0x85, one or more of which is
produced by the return  key on your keyboard in most applications.  This behavior is configurable in most text editors.

If there is no tab character in a string that is dropped onto the Content View, the app assumes that the entire string is
the URL of a desired new bookmark, and creates one with the name “untitled”.

❖❖ Browser Apps, Local  and Web
A locally-installed browser app, commonly referred to as a web browser, is an app installed on your Mac.  The term
“desktop app” has been used for this, but “desktop” is now a misnomer since more Macs are actually “laptop”. 
Examples are: Safari, Firefox, Chrome, Opera.

A web-based browser app keeps your bookmarks data on a remote server.  These apps run inside your web
browser.  (Note that you never “installed” these applications onto your Mac.)  Examples are: Delicious, Pinboard, Diigo.

❖❖ Browser Profile
Some users may prefer to compartmentalize their web browsing, so that they have different sets of bookmarks, history,
and other browser app settings for different purposes.  For web-based browser apps,  this is done easily by creating
multiple user accounts.  This feature is also available some locally-installed browser apps,  in particular  Firefox and
browsers in the Google Chrome family.  Of course, in any web browser you get different bookmarks, history, and other
browser app settings in each Macintosh user account.

http://support.apple.com/kb/HT4753
http://support.apple.com/kb/PH14378
http://en.wikipedia.org/wiki/Web_browser
http://mzl.la/LL5Dxl
http://support.google.com/chrome/bin/answer.py?hl=en&answer=2364824


❖❖ Churn
When exporting to web browsers, the app must respect each browser’s rules regarding what types of items
(bookmarks, folders, separators) can be put where, and then when importing, not recognize that any moves made due
to these rules should not be re-imported into the Bookmarkshelf document.  If this is not done carefully, items can be
moved back and forth between two different locations during successive syncs (export + import cycles).  We refer to
this as churn.

❖❖ Contextual Menu
Rather than searching through the Main Menu bar to find one of the commands applicable to a particular item, some
application views provide menus that pop up on the item and show only these applicable commands.  To access a
contextual menu for an item, click it with a secondary click.

❖❖ Devices
It is fashionable nowadays to use the term devices  to refer to, collectively,

Personal computers (including Macintosh computers)
Tablets (including iPads)
Smart phones (including iPhones)
Smart music players (including iPod Touch)

❖❖ Dock Menu
Application items in your Mac OS X Dock show a menu when you click them with a secondary click.   Secondary-click
the app’s icon to see its Dock Menu.  Note that an application must be running in order to show the usual items in its
Dock Menu.

❖❖ Enabled vs. Disabled Controls
A control which has a “grayed-out” contrast does nothing when you click on it, because it is disabled.   This is in
contrast to a control in its normal enabled  state.

This happens to regular controls such as checkboxes…

http://support.apple.com/kb/HT2474


as well as menu items…

Note that the enabled  state is independent of whether the control is ON or OFF.  In the first screenshot there, the
Bookmarks Menu  checkbox is disabled,  although the checkmark indicates that its value  is ON.

❖❖ External Identifier
Most web browsers attach an identifier  attribute to each bookmark or folder in their content.  In Web-based browser
apps, which do not allow folders nor duplicate bookmarks, this is often a hash of the bookmark’s URL.  In any case, the
app uses this identifier, whenever possible, to identify this item when syncing as one that has already been synced.  If
you need to see the external identifiers which the app has stored for an item, show the item in the Inspector Panel,
hold down the option  key on your keyboard, and click on the Export Exclusions  button at the bottom.  The items
external (and internal) identifiers will be logged in an entry to your system Console.

❖❖ Hidden Preference
In addition to the options available when you click Preferences  in an application’s application  menu, some
applications have other preferences available to advanced users.  Preferences are hidden because either because we
didn’t think it was important and thought that our time would be better spent on other stuff, and/or that we thought
exposing the option to all users would make the app more confusing to the average user and have a net negative
value.  To request a hidden preference, contact our Support team.

❖❖ Internal Bookmarks
The internal bookmarks  of a web browser such as Safari refers to those bookmarks which you see when you click its
Bookmarks  menu item.  Internal bookmarks may also appear in the toolbar at the top of a browser window in these
applications.  This so-called Bookmarks Bar  or Bookmarks Toolbar  is part  of a browser’s internal bookmarks. 
Bookmarks in the Bookmarks  menu itself may comprise all or part of the internal bookmarks, depending on the
browser’s design.

We use this term to distinguish these browsers’ bookmarks from the bookmarks stored in a  Bookmarkshelf document.

❖❖ Lineage and Hierarchy
The lineage  of a bookmarks content item is its “location” or “place” in a hierarchy,  defined by the following sequence:

The folder it is in, called its parent
The folder that its parent is in, called its grandparent
The folder that its grandparent is in, called its great-grandparent
…
The “highest level” folder that its ancestors are in, often a hard folder.
The root.

Several things to note here…

In Smarky, Synkmark, Markster, and BookMacster, and in bookmarks views in other apps, what you see is an
upside-down version of the above list.  The root is at the top; the parent is at the bottom.
The root  is not shown in any app.  It is “just there”.
Usually, the sequence is not this long and the above descriptions are combined.  For example, the parent may be a
hard folder, and the grandparent may be the root.

An efficient way to view the hierarchy of items, is using an outline view  or as we call it, Outline Mode.  The app uses
the icon  to indicate lineage, and  to indicate Outline Mode.

If the lineage of bookmarks content items is ignored, viewing them results in a “flat” view, simply a list, or as we call it,
Table Mode.  The app uses the icon  to indicate  Table Mode.

http://sheepsystems.com/support/
http://en.wikipedia.org/wiki/Web_browser


❖❖ Macintosh User Account
The Macintosh supports multiple users, keeping all of your documents, settings and personal data, including
bookmarks, separated into different Macintosh User Accounts.  The data in each account is stored in a different Home
Folder.  If you are the only user of your Mac, you probably have only one Macintosh User Account on it, but computers
shared among families or company employees are often configured with one account for each user.  When each
person logs into their Macintosh User Account, they see only their own documents, data, settings and bookmarks, from
their own Home folder.

A Macintosh User Account can only be on Macintosh computer at one time.  If you regularly use two Macintosh
computers, even if they have the same account name in the upper-right corner of the menu bar, you are actually using
two different Macintosh accounts unless  you carry the Home folder around on a portable hard drive or thumb drive
and plug it in to whatever Mac you are using.  The account is still only one one Macintosh at a time, but it is portable.

❖❖ Mac OS X Keychain
Although used under the hood by Safari and many applications to securely store passwords, the Keychain is an not-
well-understood feature of Mac OS X.  Even Apple itself does not tell us very much about it.  We did find a good
MacWorld article written back in 2004 by Dan Frakes.

❖❖ Nontrivial Attributes
A nontrivial attribute  is any attribute of a bookmarks content item which is not one of the following trivial attributes.

Add Date
Expanded
External Identifier for a Client
Last Visited Date
Last Modified Date
Last Checked Date (may be visible in future version)
RSS Articles
Visit Count

Note that an item’s index,  that is, its position among its siblings, is not a trivial attribute.  (If it were, then we would not
export the changes when bookmarks are only sorted.)

❖❖ Online File Syncing Service, Online Synced Folder
An Online File Syncing Service is a service that keeps items in a designated folder or folders on your different Macs
synchronized,  which means that any files in this folder that you change on one Mac are, typically some minutes later,
or as soon as they wake up, copied to your other Macs.  We refer to such a folder as an Online Synced Folder.  An
Online File Syncing Service  also provides a backup for this data, because it is also stored on their servers.  We
maintain a web page showing our current evaluations of various such services

Putting your Bookmarkshelf document in such a designated folder is one way to get the same bookmarks on multiple
Macs.

We maintain a web page with our current evaluations of various Online File Syncing Services useable with Synkmark
or BookMacster.

❖❖ Orphaned Items
An orphaned item  is a bookmark, folder, etc. which has no parent and therefore no place in a the hierarchy of a the
bookmarks content of a Bookmarkshelf().  It cannot be displayed, and may cause confusion if it matches to incoming
items during an Import operation.

❖❖ Rating (stars)
In the Inspector panel, you can assign a bookmark or folder to have 1-5 stars.   Generally, this is to indicate how useful
the bookmark is, but you can use it however you want.  By default, items have 0 stars which means that they are
unrated.

http://www.macworld.com/article/40403/2004/10/workingmac.html
http://www.sheepsystems.com/files/products/bkmx/cloudSyncServices/
http://sheepsystems.com/files/products/bkmx/cloudSyncServices


❖❖ Readable Web Browser Application
A Readable Web Browser Application  is a web browser from which Markster or BookMacster can extract the current
web page to create a bookmark.  The Readable Web Browser Applications are: Safari, Firefox, Google Chrome,
Chromium, Canary, and OmniWeb.

❖❖ Secondary Click
Performing a secondary click  on an item brings up its contextual menu.   There are several ways to do it.

With any mouse or trackpad, hold down the control  key on your keyboard while clicking the primary (or only)
mouse button.  This is also called a control click.

With a trackpad, if you have this default gesture enabled, tap the item with two fingers.

If you have an Apple Magic Mouse  with Secondary Click  enabled, tap in your Secondary Click area.

If you have a multi-button mouse, click with your “secondary” mouse button.  By default, this is the right-side mouse
button.

So that we don’t have to keep referring to secondary click or right-click or control-click,  we refer to any of the above
using what appears to be Apple’s latest term, secondary click.

❖❖ Source and Destination
In an Import operation, the Import Client(s) are source(s) and the Bookmarkshelf() is the destination.  In an Export
operation, the Bookmarkshelf() is the source and the Export Clients are destination(s).

❖❖ Status Bar
The Status Bar  is the line of text and sometimes other controls which is along the bottom of the app’s document
window.

After an Import or Export operation, the numbers + , Δ,  ↕  and -  respectively indicate the number of

❖❖ Status Menulet
Status Menulet  refers to one of the icons you see lined up at the top of your screen, starting at the right side.

Apple uses the variously the terms Status Menu  or Menu Extra,  or in their technical documentation the term Status
Item,  and many Mac users have adopted the more descriptive term Menulet.   So, it’s not your fault that you’re so
confused!

Status Menulets are handy, but the problem is that space is limited and Apple gives them secondary priority to the
Main Menu Bar of the active application, which is displayed starting on the left side.  If the active application’s Main

http://support.apple.com/kb/HT3821
http://developer.apple.com/mac/library/documentation/cocoa/conceptual/StatusBar/StatusBar.html#//apple_ref/doc/uid/10000073
http://mactoids.com/mac-os-x-leopard-menulets/


Menu has too many items with long names, its Main Menu Bar will collide with the Status Menulets in the middle, and
the Main Menu Bar wins.  Status Menulets which do not fit are wiped out.  Therefore, particularly on a laptop or other
small-screen Mac, you need to economize and only activate the menulets which are most useful to you.

Status Menulets are only shown when their application is running, and when running, most apps allow you to turn their
Status Menulet ON or OFF in their Preferences Window.  The control for the app’s Status Menulet is in
Preferences > General.  By default, it is OFF.

Like most applications, the app duplicates the content of its Status Menulet in its Dock Menu.  So, if you don’t have
room for it in your menu bar, you can access the same functions in BookMacter’s Dock Menu.

❖❖ Syncing  Agent
A Syncing  Agent is an Agent which can Import or Export.  That is, at least one of its Commands is an Import  or
Export  command.

❖❖ Tag Delimiter
For historical reasons, in browser apps which support tags, you enter the tags into one long text field, and therefore
there must be a character which you type to signal the end of one tag and the beginning of another tag.  We call this
character the tag delimiter.

For Pinboard and iCab, the tag delimiter is the space character, ” “.  This means that if you want a tag which is more
than one word, you must connect the words by something other than a space.  For example, computer software  is no
good but computer-software  will work.

For Delicious, Firefox, the tag delimiter is a comma, “,”.  For Smarky, Synkmark, Markster, or BookMacster, you can set
the tag delimiter to one of several choices in Preferences  > General,  and you may override this choice for any
Bookmarkshelf Document in the tool Settings,  tab General.   In a Bookmarkshelf Document which syncs with only one
tab-supporting Client, you may want to set the tag delimiter to the same tag delimiter which is used by that Client.

For Diigo, the tag delimiter character is, effectively, the doublequote character, “”“.  But they do it a little differently; tags
are doublequoted.  Diigo does other weird character replacements too.

❖❖ Tag Delimiter Replacement
A problem arises when syncing between Clients that use different tag delimiters – tags may be merged together or split
apart.  Smarky, Synkmark, Markster, and BookMacster solve this problem by replacing delimiter characters found
within tags by your preferred Tag Delimiter Replacement.   You specify this in Preferences  > General.   By default, it is
the underscore character.  For example, when you support the tag computer software  to Delicious, it will be exported
as computer_software.

❖❖ Tags
Tags  are phrases that you may attach to bookmarks to aid in searching later, as explained in this Wikipedia article.

❖❖ Trace
As a verb, to log the processing actions verbosely, that is, with more entries than the normal Log you see when you
click in the menu application menu > Logs…  > Messages.   As a noun, the text file which is written to your Desktop
containing the trace entries.  This can be useful in troubleshooting problems.  To produce a trace file during an Import
or Export operation, hold down the shift  and option  keys on your keyboard while the operation is beginning.  Keep
them held down until you hear the Submarine  alert sound.

❖❖ Traffic-Shaping Policies
Traffic Shaping  is the set of programmed rules or algorithms by which servers on the internet which serve content, or
routers within the internet, may choose to delay, sometimes infinitely, transmission of packets or entire requests for
data.  For reasons which the reader can surmise, there seems to be not much information available publicly on this
topic.  Again, the best starting point may be a Wikipedia article.

http://en.wikipedia.org/wiki/Tag_(metadata)
http://en.wikipedia.org/wiki/Traffic_Shaping


❖❖ Tooltip
Mac OS X provides tooltips,  helpful explanations that appear in small borderless windows when you hover your
mouse over items that the app designer felt needed more explanation for new users, without cluttering the view for
experienced users.

(Prior to OS X 10.10 Yosemite, the rectangle was yellow instead of gray.)

The idea is that new users will set their mouse over a confusing item, then stop and scratch their heads for a few
seconds.

How Mac OS X decides when you’re doing this is a little more complicated and rather inscrutable, and this is
sometimes frustrating.  If you really want a tooltip for an item, first make sure that the item’s window is active.  Then put
your mouse over it and let go.  Wait 5 seconds.  If nothing appears, move your mouse away, bring it back, let go and
wait another 5 seconds.  If nothing appears after the second try, the item probably does not have a tooltip.

If your subject is a control in a table, hover over the column heading which names the control, rather than the row in
the table.

❖❖ Unsaved Changes Dot
The left side of the title bar in a Macintosh document window has three buttons: red, yellow and green.  The red one
closes the window when clicked, but also indicates if the document has unsaved changes, with a black dot at its
center.  If you attempt to close a window when the black dot is present, you will be asked whether or not to save the
unsaved changes.

❖❖ Untyped Item
An orphaned item  is an item in the bookmarks content of a Bookmarkshelf() which does not have enough attributes to
be properly displayed, because we don’t even know if it is a bookmark or a folder.

❖❖ XBEL File Format
The XML Bookmark Exchange Language (XBEL) file format is a mechanism by which Smarky, Synkmark, Markster or
BookMacster can import and export its content with other bookmarks management applications which also support
XBEL.  XBEL supports folders and hierarchy.  It also supports the following item attributes: name, URL, comments,
date added, last modified date and last visited date.  In addition to these officially supported attributes, the app is able
to import tags and comments which are kindly exported by Webnote™.

Home | Parent ← Go → Prior | Next

http://xbel.sourceforge.net/
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4.2  Finding Your Settings    

4.2.1  Preferences   

Settings which affect all documents are in the Preferences window.  Because Smarky, Synkmark and Markster
support a single Bookmarkshelf document, their document settings are all in the Preferences  window.

To edit Preferences in the Application Menu > Preferences.

4.2.2  Per-Document Settings 

Because BookMacster supports multiple documents, it has an additional, per-document level of settings.   Controls for
these settings are in the Settings  tab of the document.

4.2.3  Local Settings

Some settings, although associated with a document, are more related to its usage in a particular Macintosh User
Account or different Mac.  We call such settings Local Settings.  Local Settings are not stored in the Bookmarkshelf
.bkmslf file but are stored separately (see below).

If a .bkmslf file is copied to another Macintosh User Account, either manually or if synced by an Online File Syncing
Service as part of your multi-device syncing strategy, you will see that these Local Sttings are reset to default or empty
values.  You need to set what you want on each Mac.

There are two such groups of Local Settings

Open, Save Automatic Actions 

Open, Save Automatic Actions are actions you have set to occur automatically when a document opens.  These are
only available in BookMacster.

Synced Browsers or Clients   

These settings control which web browsers or clients are automatically  synced, and how.

In Smarky and Synkmark, this is configured in the Syncing  tab of the Preferences  window.
Markster does not support synced browsers or clients, so there are no controls.
In BookMacster, relevant settings are in the document window, tabs Settings  > Clients  and Settings  > Agents.

4.2.4  Technical Note     

Local Settings are stored in a file named Settings-XXXXXXXX-XXXXX-XXXX-XXXXXXXXXXXX.sql  in
~/Library/Application Support/BookMacster.  For BookMacster, the XXX  number is the unique identifier you see when
you click menu > Bookmarkshelf > Document Information.  For the other apps, you should have only one such file.  If
you have more than one, they are probably from BookMacster or discarded documents.  Look at the file modification



dates.

Home | Parent ← Go → Prior | Next
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4.3  Import, Export & Syncing    
       Topics on this Page

What is Import and Export?
Import/Export from all  vs. to only
What is Syncing?
Mapping and Remapping
May Ignore Some Moves from Import Clients 
Delete Unmatched Items
Safe Sync Limit
Sync Snapshots
Merge by URL
Mapping Between Folders and Tags
Share New Items
No Export if No Changes
Import and Export of Tags
Exclude Export of Special Bookmarks
Import and Export of Separator Changes 
Merge Folders
Content Not Exported
Clients’ Hidden Proprietary Attributes
Normalization of URLs
Undo and Redo
Reading Your Sync History
How Our Apps Access Browser (Client) Content

4.3.1  What is Import and Export?

The following picture shows what Import and Export do.

In words,

An Import copies changes from web browser(s) to the bookmarks manager.

An Export copies changes from the bookmarks manager to the browser(s).

You can command an immediate Import or Export manually from the File menu.

During Import and Export operations, by default, our bookmarks managers make the bookmarks in the destination
(where the arrow is pointing to) look like the bookmarks in the source (where the arrow is coming from).  In particular,



items not in the source are deleted.

You can change this default behavior if you want to, either temporarily or permanently, by using Advanced Client
Settings and, for imports, Import Postprocessing.

4.3.2  Import/Export from all  vs. to only   

Import from all  and Export to all
 In Synkmark, the all  referred to in these menu items are the browsers which you have listed and activated in the

Syncing  tab of the Preferences  window.

 In BookMacster, the all  referred to in these menu items are the Clients which you have listed and activated in the
tab Settings  > Clients  of the current Bookmarkshelf Document.  These Import and Export operations are the same
which are typically performed by BookMacster Agents during syncing operations.

Import from only* and Export to only
These menu items have submenus in which you choose the Client you’d like to import from or export to.  The
submenus include all Clients available on your Mac, not only the ones you have configured Settings  > Clients.   For
that reason, you will also be asked if you wish to perform a Normal  or Overlay  operation.  A normal  import or export
wipes everything out in the destination and makes it look like the source.  An overlay  does a more graceful merge.

4.3.3  What is Syncing?   

When you activate syncing in Smarky or Synkmark, or switch on simple Agents in BookMacster, your bookmarks are
kept in sync automatically.   This means that when you add, update or delete bookmarks in one browser, depending on
your configuration, bookmarks may be sorted (alphabetized) in that browser and/or copied to other browsers after a
few minutes.  This is done by importing (as described above), possibly sorting, and then exporting (as described
above).  In other words, a a Sync operation is composed of an Import from all , followed by an Export to all .

If the Syncing button in your document’s toolbar has a green dot in it like this:

It means that an Agent is actively watching for changes to sync.

If you wanted to do a Sync manually, you should do the same three steps manually.

Import, by clicking one of the Import  commands in the File  menu.

If alphabetizing is desired, Sort.

Export, by clicking one of the Export  commands in the File  menu.

4.3.4  Mapping and Remapping    

In general, bookmarks are mapped  into the same location in the destination as they were in the source; Bookmarks
Bar to Bar, Menu to Menu, etc.  However, because Clients, and the Bookmarkshelves, have different structures, some
of the bookmarks content content copied during an Import or Export have nowhere to go.  For example, if bookmarks
from a Firefox Client, containing items in its Unsorted Bookmarks  Hard Folder are migrated to a Camino Client, which
does not have such an Unsorted Bookmarks folder, the subject items must be remapped into a different location.

Using Smarky, Synkmark, Markster or BookMacster, such a migration is performed by an Import + Export, with the app
“in the middle”.  Depending on the structure of the Import Client, Bookmarkshelf, and Export Client, remapping  may be
necessary during Import, Export or both.  You can configure some of the remapping rules with the settings described in



the next section.

Mapping and the Default Parent
During either an Import or Export, the process of “mapping” computes where a content item should be placed in the
destination based on its location in the source.  As previously discussed, even with the best of intentions and
configurations, an item may not be allowed where it would be directly mapped.  For example, loose bookmarks are not
allowed into the Root of an export destined for Chrome, or Firefox.

If directly mapping an item is not allowed, the app checks to see if it can be remapped to the Default Parent  for the
destination.

For importing into a Bookmarkshelf, you set a Default Parent  in the Import Postprocessing sheet.

For exporting to Clients, you can change the a Default Parent  in the Advanced Client Settings for each Client.

If the item is not allowed in the Default Parent either,the app tries the other Hard Folders until it finds one where the
item is allowed and remaps it to there.  (The order in which Hard Folders are tried is a hidden preference.)

4.3.5  May Ignore Some Moves from Import Clients     

If you move  an item from one folder to another in a Client’s built-in Bookmarks Manager,the app recognizes this move,
imports it, and later exports it to other Clients, unless the move could be accounted for as the result of an automatic
mapping during a prior export.  There are two such cases of these automatic mappings.  Both of them rare…

The Client would not allow the item to be exported to its current location in the Bookmarkshelf document, and the
apparent moved-to folder is the default parent of the item.
The Client in which the move is apparent has a Tag Mapping whose target folder is the apparent moved-to folder,
and whose tag is one of the item’s tags.

These exceptions are necessary so that automatic mappings which should only be applied to one Client do not get
applied to all Clients when importing from that one Client only.

We recommend that, when it’s time to do housecleaning on your bookmarks (moving, renaming, and deleting items,
etc.) please open your Bookmarkshelf document, do the work inthe app, and, when done, Export to all Clients.

4.3.6  Delete Unmatched Items    

As the result of an Export operation, usually you want the browser or file to which you exported to contain only the
items which were exported from Smarky, Synkmark, Markster, or BookMacster.  Checking on the Delete Unmatched
Items  option will do this by deleting any destination items which were not be matched to source items during the
merge  process described above.  You should check this box if you want the content of the Client to look as much as
possible like the content of your Bookmarkshelf().  You can control Delete Unmatched Items  in the Advanced Client
Settings.

Delete Unmatched Items  is also available during Import Postprocessing, and is used as part of making your
Bookmarkshelf exactly match the content in its Import Clients.  Note that there is only one “Delete Unmatched Items”
checkbox for a document, not one for each Client in the table.  This is because, in this case, there is only one
destination (the Bookmarkshelf) from which items can be deleted, and also it cannot be determined whether or not a
given item has been matched until after all Import Clients have been imported.

4.3.7  Safe Sync Limit    

The Safe Sync Limit  controls protect your bookmarks from massive changes in the event of some unexpected file
corruption.  For example, if some errant Firefox extension deleted all the bookmarks, and you had an Agent to sync
Firefox and Safari, this Agent would  dutifully wipe out your Safari bookmarks too.  To avoid propagating errors like this,
the app provides a Safe Sync Limit.   If the number of additions + updates + deletions exceeds the applicable Safe
Sync Limit  in an Import or Export operation, the operation will be aborted and you will be alerted by an Error.  (Note
that the number of slides is ignored.  This is because, for example, adding a single bookmark at the top of a folder of



100 items will cause 100 items to slide  down; counting slides would thus make a big deal out of a little deal.)

In Smarky and Synkmark, the Safe Limit  control is in Preferences > Syncing.   In BookMacster, there are are separate
Safe Sync Limit  controls for import in Import Postprocessing, and for exporting, in the Advanced Client Settings of
each Client.

Safe Sync Limit  controls are set to 25 by default.

4.3.8  Sync Snapshots    

To complement the Versions Browser which allows you to turn the clock back on Content in Smarky, Synkmark,
Markster, or BookMacster, you can also turn the clock back on exports to web browsers.  This may be necessary, for
example, if you neglect to import bookmarks from a web browser and then export to it after you have disabled
warnings, or accidentallly click through the warnings without thinking.  To rescue you from this situation,the app
archives a Sync Snapshot  file containing the web browser’s bookmarks before each export.

Sync Snapshots are stored in ~/Library/Application Support/BookMacster.  We have a video which shows how to
restore from them.

Of course, to limit disk space usage, the app keeps only a limited number of Sync Snapshots, by discarding the oldest
when a new one is added.  You can set this number in Preferences > Syncing.  The default number to keep is 5, but
setting it to 0 is not unreasonable if you have plenty of other backups (Time Machine, etc.) and know how to use them. 
(Warning to power users: Do not mess with Safari’s Bookmarks.plist file while iCloud Safari syncing is on.)

4.3.9  Merge by URL    

During an Import or Export, the app will compare bookmarks content items between the Bookmarkshelf and the Client,
looking for items that were previously imported or exported.  It can do this because it remembers the items’ external
identifiers.  When a match is found, Smarky, Synkmark, Markster, or BookMacster or  will merge  the items by keeping
either the item from the Client, or the item from the Bookmarkshelf().

If no previously-imported or exported item is found for a given bookmark, there is another chance for a match if the
Merge by URL  box is checked.  In this case, a second search is done, for a bookmark with the same URL.  (Note that
the app normalizes URLs.)  If found, the items are similarly merged, keeping the item from either the Client or
Bookmarkshelf, as indicated by your setting of the Keep matched item from  control in the Advanced Client Settings.  If
more than one such bookmark is found, the source and candidate destination bookmarks’ parents are compared, and
if that still does not result in a unique match, the bookmarks’ names are compared, and if that still does not result in a
unique match, one is chosen arbitrarily.

For Exporting to a Client which does not accept duplicate items, Merge By URL is forced on and the control is
disabled.

4.3.10  Mapping Between Folders and Tags    

When performing an Import or Export operation, Smarky, Synkmark, Markster, or BookMacster provides features that
allow you to translate between Clients that support folders instead of tags, and Clients that support tags instead of
folders.

For a one-time conversion of all of your bookmarks, consider Fabricate Folders  or Fabricate Tags,  which will map all
of the bookmarks in the document.  For browsers that support hierarchy but not tags, during an Import you may
Fabricate Tags,  and during an Export you may Fabricate Folders.   For browsers that support tags but not hierarchy,
it’s just the opposite – during an Import you may Fabricate Folders,  and during an Export you may Fabricate Tags.

For a permanent configuration which will map certain special folders to certain special tags or vice versa, use Tag ↔
Folder Mappings

Fabricate Tags
If the Fabricate Tags box is checked on, the names of a bookmark’s parent, grandparent, etc. folders which are not

http://www.sheepsystems.com/files/support_articles/bkmx/restore-yesterday/


presently among the bookmark’s tags will be added to bookmark’s tags.  Only names of soft folders are added, of
course.  Names of hard folders such as Bookmarks Bar or Bookmarks Menu are not informational and therefore are
not added as tags.  This is useful if your goal is to use tags instead of folders.

Fabricate Folders
Fabricate Folders  s useful if your goal is to use folders instead of tags.  If checked ON, any item which has a tag will
be placed into a subfolder which has the same name as its first tag, creating the folder if necessary.  If in addition the
One for each tag  setting is checked ON, for items with more than one tag, the same will be done for each additional
tag, placing copies of the bookmark into subfolders for each tag, creating additional subfolders if necessary.  Note that
this can fabricate many duplicate bookmarks.

The number of folders created, however is reduced by the fact that, during Fabricate Folders, only one folder is
created to contain multiple bookmarks which require it.

The Fabricate Folders  option will not fabricate a folder that would not be allowed at the required location.  Currently,
there is in practice only one example of this:  If Fabricate Folders  is checked on , and bookmark(s) at root have tags,
but the structure of the destination (either external store or document) does not allow soft folders at the root level, then
folders are not created for the tags of these bookmarks.

Tag ↔ Folder Mappings
This feature is used if, for example, you collect bookmarks in a web-based browser app such as Delicious or Pinboard,
tag them with a tag such as to-read,  and want them automatically moved into a certain folder such as your Reading
List  when you sync this service with Safari, or vice versa.

To configure Tag ↔ Folder Mappings,

Open a Bookmarkshelf document which has been configured for syncing.
Click the tab Settings,  then Clients.
Click the gear button for one of the Clients.  This will show its Advanced Client Settings sheet.
At the bottom of the sheet, click the Tag ↔ Folder Mappings  button.  Another, deeper sheet will appear.  (Some
Clients, Roccat for example, support neither tags nor folders, and in that case this button is not available.)
Click the [+] button below one of the two tables, to add the behavior you want in this Client.
Enter your choices in each of the three columns.
Click Done  twice.
Repeat for the other Client.

Note that there are four possible types of Tag ↔ Folder Mappings.  In the upper table, you configure Folder to Tag
Mappings, specifying whether to do this during Import  or Export  operations.  In the lower table you similarly configure
Tag to Folder  Mappings.  For most Clients, only two types are available; only the Import  or only the Export  item are
available in the Do during  popup.  This is because most Clients which support tags do not support folders, and vice
versa.  The exception is Firefox, which supports both tags and folders.

Example: Creating a Reading List  in Chrome
You can string together a Folder to Tag  mapping together with a Tag to Folder  mapping, in order to map items from a
particular folder in, say, Google Chrome, into your Reading List in Safari.  Any item which you place in this folder while
browsing in Chrome will appear after syncing in Safari’s Reading List.   To do this,

Designate to yourself, or create the folder into which you shall put your Reading List  items while you are browsing
in Chrome.
Activate Smarky, Synkmark, Markster, or BookMacster and open your Bookmarkshelf document.
Navigate to Clients > Chrome > Advanced Settings > Tag ↔ Folder Mappings as detailed above.
In the upper table, create an Import mapping from your designated folder to a special tag, such as maybe to-read.
Click Done  twice.
Navigate to Clients > Safari > Advanced Settings > Tag ↔ Folder Mappings.
In the lower table, create an Export mapping from your designated tag, to-read  or whatever, to the
Reading/Unsorted  folder.  (Note that the app exports its Reading/Unsorted  folder to the Reading List  in Safari
and to Unsorted Bookmarks  in Firefox.)
Click Done  twice.

One more thing.  Because all items will have been moved out of your designated folder when exporting to Safari,
Safari will now have that folder, empty, which will cause confustion.  To prevent that, you can use an Export



Exclusion.   To do that, while still in your Bookmarkshelf Document,

Select that designated folder in the Content View.
If the Inspector is not showing, click in the menu: Selection  > Show Inspector.
Click the Export Exclusions  button at the bottom of the window.
In the drawer which appears, switch off the checkbox for Safari.

4.3.11  Share New Items    

Bookmarks stored in Clients which are social bookmarking web apps such as Delicious often have an attribute called
Shared,  or, conversely, “Private”.  Bookmarks which are exported as Shared  become viewable by other people who
visit your bookmarks page.

BookMacster supports a ‘Shared” attribute to its bookmarks, and this attribute is exported to such a Client.  So the
question arises:  When items are imported from a Client such as Safari which does not support the Shared  attribute,
should the Shared  attribute be turned on or off.

You provide the answer by switching the Share new items  checkbox in the Advanced Client Settings.

4.3.12  No Export if No Changes   

To execute an Export, the app first reads in all of the current bookmarks content from the Export Client and compares it
to the bookmarks content from the Bookmarkshelf() which is proposed to be exported.  It determines the number of
each type of change which needs to be made.  If there are no additions, deletions, moves, or slides, and if none of the
items have any updates to a nontrivial attribute, the operation is terminated without writing the file or uploading
anything.

4.3.13  Import and Export of Tags    

During an Import, tags are given a special, conservative treatment.  When a bookmark existing in the Bookmarkshelf is
matched and merged with one from a Client, any new tags on the bookmark in the Client are added to the bookmark in
the Bookmarkshelf, and none are deleted.

During an Export, tags are treated like any other attribute.  When a bookmark existing in the Client is matched and
merged with one from the Bookmarkshelf, the tags on the bookmark in the Client are completely replaced by the tags
on the bookmark in the Bookmarkshelf.  Any tags on the Client bookmark not on the Bookmarkshelf bookmark are
deleted.

Conclusion: If you are using the app to sync browser Clients and want to delete tags, you must delete them in the (in
the Content tab of a Bookmarkshelf).

4.3.14  Exclude Export of Special Bookmarks    

In the Advanced Client Settings for each Client, in the Export  section, there are checkboxes in which you can
selectively exclude exporting bookmarks to local files, JavaScript bookmarklets, RSS feeds and Firefox Live
bookmarks.

4.3.15  Import and Export of Separator Changes     

When we speak of changes to separators,  we mean adding new separators, moving separators, and/or deleting
separators.  The behaviors described in this section are the same, with the additional requirement that, in order to
delete separators, the relevant Delete Unmatched Items  checkbox must be switched ON, and this must be a regular
export and not an Overlay.

Separators are a structural element which you have usually set to your liking in one  Client or another.  Therefore,
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when importing and exporting with multiple Clients,  Smarky, Synkmark, Markster, or BookMacster filter changes to
separators according to special rules which prevent undesired duplications.  The underlying idea is that you want
separators from source or destination, but not both.  Which one you want is determined by the setting of the relevant
Merging Keep  option, and there is also an option to not export any separators at all.  (This may be desirable if you are
exporting to Safari and Safari bookmarks will be subsequently synced to the iPhone via iCloud.  Separators may be
unwanted in the iPhone due to the small screen size.)

The behavior you get with the default settings is probably “what you want” and should “just work”.  But for clarity (and
our internal quality assurance testing), the rules are detailed in this section, first in words and then in a tabular format.

Importing Separators
To be precise, we need to define three classes of separators, imagining that separators are imported from Clients on
the Left, to a Bookmarkshelf on the Right.

Left.  A separator in a Client which does not exist in the Bookmarkshelf (either because it was never im/exported or
was im/exported and subsequently deleted) is called a Left separator.  Left separators are imported to the
Bookmarkshelf if Keep matched item from  is set to Client,  but not imported if Keep matched item from  is set to
BkmxDoc.

Matched.  A separator in the Bookmarkshelf which also exists in all Clients (due to prior im/export) is called a matched
separator.  A matched separator will always remain standing.  (Actually, the one in the Bookmarkshelf is either
overwritten by a mate imported from a Client, or is untouched, depending on whether Keep matched item from  is set
to Client or BkmxDoc.  But since separators have no visible attributes, you can’t tell the difference).

Right.  A separator in the Bookmarkshelf which is not matched by one in all of the Clients (either because it was never
im/exported or was im/exported and subsequently deleted from a Client) is called a Right separator.  If the Keep
matched item from  option is set to Client,  or if Import Postprocessing Delete Unmatched Items is checked ON (☑),
Right separators deleted.  Otherwise, Right separators are untouched.

Table.  The above rules are summarized in the following table.  The settings in the first row are the default settings,
which are what you should have if you have never changed any of the Advanced Settings (by clicking one of the “gear”
buttons).

Settings
Behavior of Separators during

Import

‘Delete Unmatched Items’ in Import
Postprocessing (Advanced) Settings

‘Merging Keep’ in Client
Advanced Settings : Import

Left
Separators

Matched
Separators

Right
Separators

ON (☑) Client Imported Imported
(*) Deleted

OFF (⎕) Client Imported Imported
(*) Deleted

ON (☑) BkmxDoc Not
imported Untouched Untouched

OFF (⎕) BkmxDoc Not
imported Untouched Untouched

(*) Since separators do not have any attributes, the effect of “Imported” in this case is the same as that of “Untouched”
– the separator appears to survive unchanged.

Exporting Separators
For exporting, we redefine the three classes of separators, because Bookmarkshelf and Client are now swapped in our
imagined “Left to Right” movement.

Left.  A separator in the Bookmarkshelf which does not exist in the Client (either because it was never im/exported or
was im/exported and subsequently deleted) is called a Left separator.  Action may be affected by the setting of the



Export Separators  checkbox:

A Left separator is exported only if both this box is checked and and the Keep matched item from  is set to BkmxDoc.

Matched.  A separator in the Client which also exists in the Bookmarkshelf (due to a prior im/export) is called a
matched separator.  A matched separator will always remain standing.  (Actually, the one in the Client is either
overwritten by its mate exported from the Bookmarkshelf, or is untouched, depending on whether Keep matched item
from  is set to BkmxDoc or Client.  But since separators have no visible attributes, you can’t tell the difference).

Right.  A separator in the Client which is not matched by one in the Bookmarkshelf (either because it was never
im/exported or was im/exported and subsequently deleted) is called a Right separator.  Right separators are deleted if
Keep matched item from  is set to BkmxDoc, but untouched if set to Client.

Table.  The above rules are summarized in the following table.  The settings in the first row are the default settings,
which are what you should have if you have never changed any of the Advanced Settings (by clicking one of the “gear”
buttons).

Client’s Advanced Settings : Export Behavior of Separators during Export

Merging 
Keep Item From Export Separators Left Separators Matched Separators Right Separators

Bookmarkshelf ON   ☑ Exported Exported (*) Deleted

Bookmarkshelf OFF   ⎕ Not exported Untouched Untouched

Client ON   ☑ Not exported Untouched Untouched

Client OFF   ⎕ Not exported Untouched Untouched

(*) Since separators do not have any attributes, the effect of “Exported” in this case is the same as that of “Untouched”
– the separator appears to survive unchanged.

Note that the Separators’ Behavior does not depend on the Export Client’s Delete Unmatched Items setting.  (First of
all, only the first two of the above four combinations are possible, since if the Export Client’s Delete Unmatched Items
is ON (☑), Keep matched item from  must be set to BkmxDoc.  Of these two cases that remain, the separators which
would be affected by the Export Client’s Delete Unmatched Items, the Right separators, are deleted due to the action
of the Keep matched item from  = BkmxDoc.  So, the Export Client’s Delete Unmatched Items does not matter.)

4.3.16  Merge Folders    

You might create a folder with a certain name, say, News,  in, say, the Safari Bookmarks Bar, and then also create a
folder with the same name, News  in Firefox in the same corresponding location.  Then you might import from Safari
and Firefox, expecting that the items in your two News  folders would be merged into one News  folder.  Smarky,
Synkmark, Markster, and BookMacster do indeed do this.

What, When and Where
To make this happen, very near the end of an Import or Export operation, the app merges pairs of folders within the
same parent, which have the same name, if they come from different sources (either different Clients or Client vs.
Bookmarkshelf).  Because it does so starting from the root, all such pairs folders will be detected, provided that they
have the same lineage.  When a pair of folders with the same lineage and name is so discovered, one folder will be
kept and the other folder will have its items moved into the first folder and itself be deleted.  Also, any external
identifiers in the deleted folder not already existing in the kept folder are appended to kept folder.

A more aggressive merging of folders may be performed by executing a Consolidate Folders command.

Which one is Kept?
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If during an Import operation, the two folders are from different Clients, the one from the higher-priority Client (higher in
the list in Settings > Clients) is kept.

Otherwise, if both folders are new (not previously in the destination), the one with the earlier Date Added is kept.  This
is important for the following reason.  If you are merging from two or more import clients which have similar but not
identical hierarchies, for folders which exist in multiple Clients but not in the Bookmarkshelf, if these clients do not
themselves provide an Date Added, Date Added is assigned as the time of their import.  Therefore, the folder from the
client which is first in the Import Clients table will have an older Date Added, typically by a few seconds, and therefore
will be the one that is kept.

If both folders were in the Destination before the Import or Export, then the one which has higher item quality is kept.

If one folder is from the source and the other is from the destination, which one is kept depends on the Merging Keep
setting: If Merging Keep  is set to Client,  the folder from the Client is kept.  If set to Bookmarkshelf(),  …
Bookmarkshelf.  (As stated above, if set to Both,  the Merge Folders operation is not even performed.)

Why does it Matter which is Kept?
In most cases, it does not.  A folder with the same lineage and the same name is pretty much the same folder.  The
only differences might be a couple of attributes which are only used by Smarky, Synkmark, Markster, or BookMacster,
such as sorted or not,  sort at top/bottom,  and the Auto-Click  attribute which supported by a couple of browser apps.

4.3.17  Content Not Exported    

Before writing or uploading items, Smarky, Synkmark, Markster, and BookMacster remove items which are not allowed
or not desirable in the given the Export Client, or won’t work in any Client.  Most of these are fairly obvious, but here
are a few examples…

Bookmarks whose URLs have no characters, or illegal characters in their host portions, for example http:///,  are
not exported to any Client.
Bookmarks whose URLs contain a percent-escaped NULL, “%00”, in their path portions will not be exported to any
Client because this causes weird behavior in Chrome, Firefox, and possibly other apps.
Google Bookmarks does not allow items that have the same URL.  (Note that, like BookMacstedr Google
Bookmarks normalizes URLs.)  Prior to uploading, BookMacster will detect such duplicates and omit uploading one
of them.
Delicious and Google Bookmarks do not allow folders or separators, only bookmarks.
Because they are typically huge, useless to Clients except Safari, and can cause errors in some Clients, the Safari
Logins Bookmarklet  created by 1Password version 3.x, and the old 1Password bookmarklet created by
1Password version 2.x, are exported only to Safari Clients.
Safari does not allow separators “out of the box”.  But instead of not exporting them, Smarky, Synkmark, Markster,
and BookMacster convert separators when exporting to Safari to its own fake separators, or to Glims separators if
you have Glims 1.0 or later installed.

4.3.18  Clients’ Hidden Proprietary Attributes    

Some web browsers have esoteric, proprietary attributes on their bookmarks which are of no interest to Smarky,
Synkmark, Markster, BookMacster, you, or other browsers.  For example, Opera sports an “ACTIVE” attribute to
indicate that an item is selected in Opera’s Manage Bookmarks  window, so that if you quit Opera and relaunch, that
same item will be selected.   OmniWeb also adds several of its own attributes that hardly anyone even knows exist.

The app ignores such hidden proprietary attributes during an Import operation, and will therefore not  pass them to
another Client of the same type (another Opera, for example) if your Bookmarkshelf document is synced to another
Mac as part of your multi-device syncing strategy.

During an Export operation, the app preserves these attributes in the local Client.

4.3.19  Normalization of URLs    
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Some local Clients, notably Chrome and Firefox, and in particular the web app Clients (Google Bookmarks, Pinboard,
Delicious)  apply minor corrections or what we call normalization  to the URLs of your bookmarks.  For example,
launch Firefox Show All Bookmarks,  create a new bookmark and type in the URL “http://apple.com”.  Notice that when
you hit ‘return’, Firefox automatically adds a slash character to the end of the bookmark (signifying an empty “path”
portion).

Actually this change can occur in one or more of three places:

What URL you see in the Show [All] Bookmarks,  web page, or similar user interface

What URL they visit when you click the bookmark.

What URL gets returned to BookMacster when it downloads your bookmarks as part of an Import  operation.

The last item is the one relevant to Smarky, Synkmark, Markster, and BookMacster.  This is because these apps
merge incoming and existing bookmarks during an Import  or Export  operation.  For example, let’s say you that your
perform an Export  in BookMacster to Google Bookmarks, which uploads a bookmark whose URL is
http://UpPpeR.cOM.   If you later perform an Import  from this Google account, BookMacster will receive a URL which
has been normalized to contain only lower-case characters in the host  portion, http://upper.com.

To minimize confusion and churning of bookmarks, the apps also normalize any bookmark that you enter into it.  There
are a couple dozen rules in our algorithm, and our My Eyes Glaze Over  Department did not allow us to enter them
here.  Generally, the app mimics the behavior of Firefox and Chrome, which we have found to be reasonable except
for a couple cases.  Therefore, since the exported URL is already normalized, the Client will not make any further
changes, and churn rarely occurs.  One of these rare instances is when the path of a URL ends in ‘index.html’ and it is
exported to Google Bookmarks.  Google Bookmarks incorrectly, we believe, omits the ‘index.html’, and therefore when
you re-import such a bookmark into BookMacster for the first time, an “update” of its URL will be tallied.

4.3.20  Undo and Redo    

In Smarky, Synkmark, Markster, and BookMacster, as in most applications, Undo and Redo recall the state  of the
document (the Bookmarkshelf()) before or after an action was performed and simply replace the current state with the
the prior state.  That is, they reverse the effect of the action on the document   but do not, as their title implies, actually
undo or redo the action.

This subtle difference is apparent with  Import  command.  After you Import,  the Edit  menu’s Undo  item will be titled
“Undo Import”.  If you click this, your Bookmarkshelf’s content will be set back to the way it was before you imported
from the browser/file(s).

Then, the Undo  item will titled “Redo Import”.  Now if you click this, your Bookmarkshelf’s content will be set back to
the way it was after you imported from the Import Client(s), reflecting the content in the Client(s) at the time the original
import was done.  Thus, Redo recalls the content in the Clients at the the time the original import was done.  Redo
does not import their current  contents, which may be different if data was changed within the Client, for example by
adding a bookmark, in the meantime.

This concept is even more apparent when performing an Export.   The app’s Undo domain does not extend into other
apps.  And there is no Undo action available after an export; the Unsaved Changes Dot is not affected.  (Actually, the
app does record the time of the export for considering whether future exports need to be done, but this change is
recorded in Local Settings and therefore does not change the Bookmarkshelf.  If it did, this would cause Online File
Syncing Services to upload this local “change” to their server after saving, which would be incorrect.)

There are two ways to restore pre-export content in the Client itself.  The first way is to restore the content of a
Bookmarkshelf to the way it was before the export in the client, and then export again.  The second way, available to
advanced users and not applicable to web app Clients, is to quit the Client application, then restore the relevant file(s)
from a Time Machine or other backup.

4.3.21  Reading Your Sync History    

Reading the Status Bar after an Import or Export
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After an Import or Export operation, the numbers + , Δ,  ↕  and -  respectively indicate the number of additions,
updates,  slides  or deletions  as a result of the operation.  The indication Same-Skip  indicates that operation was
skipped because the app pre-determined there to be no differences between the content in the source and that of the
destination.

Sync Logs
For more detailed and longer-term history, the Reports  > Sync Log  tab shows the changes  to your Content which
occurred during recent Import/Export operations.

Changes
There are five types of Changes:

Additions are new items which previously did not exist in the destination.

Moves are moves of items to a different parent.

Slides are moves of items within the same folder (parent).  If an item is added at the top of a folder containing 3
items, the 3 items below it will undergo a slide.   Sorting  bookmarks produces only slides.

Updates are changes to one or more of the nontrivial attributes, except for position (which is a slide) , of existing
items in the destination.  Updates are indicated by the Greek letter delta,  the triangle, Δ.  An item which was both
slid  and updated  is counted only as an update.

Deletions are items deleted from the destination.

Here’s an example.  Say that you have just imported from Safari.  Next, you switch to Safari and add a bookmark,
placing it  above 12 existing bookmarks in a given parent folder.  Now, switch back to the app and import again.  The
Status Bar will indicate “Safari (+1, Δ1, ↕12, -0)”.  The +1 is, of course, the new bookmark.  The Δ1 indicates the new
item’s parent folder, because it gained a child.   The ↕12 indicates the 12 items changed which were slid (had their
position  incremented by one) in order to make room for the new bookmark.

In some oddball cases, it might take more than one of Import and Export before the number of changes stabilizes to +0
Δ0 ↕0 -0.  Here’s an example to illustrate the point.  Say that a Bookmarkshelf’s Client settings list Camino and Safari
with both Import and Export active.  A bookmark is added at the root level in Safari.  Say that in the Bookmarkshelf’s
Structure, bookmarks are allowed at Root.  During the next Import, this is imported to the Bookmarkshelf at the root
level.  During the next Export, it is exported to Camino, but since Camino does not allow bookmarks at Root, it goes to
the Default Parent for Camino, which is, say, the Bookmarks Menu.  (This is the default setting.)  So it is exported to
the Bookmarks Menu in Camino.  Say that in the Bookmarkshelf’s Clients, Camino Advanced settings are set to Keep
items from Camino instead of the Bookmarkshelf.  (This is also a default setting.)  Also say that Camino precedes
Safari.  Thus, during the next Import, this bookmark will be moved into the Bookmarks Menu.  Then, during the next
Export, it will also be moved to the Bookmarks Menu in Safari, and, finally, during the next Import there will be no more
changes.  Summarizing, we had two Imports and two Exports before we finally saw no changes in the next Import.

4.3.22  How Our Apps Access Browser (Client) Content    

In order to execute an Import or Export command, Smarky, Synkmark, Markster and BookMacster must somehow
access the bookmarks content of the Client that you chose in the popup menu in Settings  > Clients.

This section explains how that is done, for each of the different types of Clients.

Accessing Locally-Installed Browser Apps’ Bookmarks

Bookmarks in your Macintosh User Account
The apps has two methods for importing from and exporting to Locally-installed browser apps (Safari, Firefox, etc.). 



The app automatically chooses the appropriate method based on current conditions.

The quick direct sync is to import from and/or export to the file or files on the disk which the browser app itself uses. 
This is the only method available with Safari.  Safari allows us to do this while Safari is running, provided that we are
careful to maintain iCloud data.  This is also the only method availalable with Opera and the older browsers, although
in these cases our app must quit the browser before importing and/or exporting.  If the desired operation cannot be
safely performed without quitting a running browser app, our app presents a dialog asking you if it is OK to quit the
app, and then to re-launch it when done.  Our app can also use the quick direct sync for Chrome and Firefox.

The other method is the coordinated sync.  This method, which is only available in Chrome and Firefox,
communicates the import or export through a browser add-on, and hence works while a browser app is running.   Our
app installs the browser add-on into your browser profile when you add Chrome or Firefox as a Client.  For Chrome,
this is done silently, while Firefox requires your OK.

Launch Browser to Coordinate with Other Sync Services
In multi-device sync configurations, our app’s imports and exports must be coordinated with other services sign as
Chrome’s Sign In to Google or Firefox’ Firefox Sync, and in general this means that the coordinated sync  described
above must be used, and therefore the browser must be launched  if it is not running.

A simple example explains why.  Say that our app is syncing Safari and Chrome, and you also have Chrome on your
iPhone synced to Chrome on your Mac via Sign in to Google.   When you add a new bookmark in Safari, our app could
export that to Chrome using the quick direct sync  if Chrome was not running, but only Chrome can push that new
bookmark to Chrome on your iPhone, which won’t happen if Chrome is not running.  The same thing happens in the
reverse direction; a bookmark added to Chrome on your iPhone can not show up in our app or Safari without Chrome’s
help.

Therefore, before an Import or Export, if Chrome or Firefox are involved and are not running, our app looks to see if
Sign in to Google  or Firefox Sync  are active in the profiles involved, and if so, by default it automatically launches
Chrome or Firefox.

If you have our advanced app, BookMacster, you can control this behavior by clicking the tab Settings  > Clients,  and
then clicking the Advanced Client Settings  (gear) button for the subject Chrome or Firefox profile.

In the Special Settings  section you will see a popup menu to set launch browser during Syncs.

If you do not want to leave Chrome or Firefox running in the background, and you find it annoying when our app
launches them automatically, and you don’t mind bookmarks syncing being delayed, or occasional omitted bookmarks
due to conflicts, you may change this setting to Never.

The opposite situation arises if you using another external syncinc service instead of the built-in Sign in to Google  or
Firefox Sync.   In this case, such a service may have its own add-on installed into Chrome or Firefox, and again, our
app should  launch Chrome or Firefox prior to an import or export in order to coordinate syncing with it.  But our app is
not aware of external syncing services.  To fix this, you can make sure that syncing is always properly coordinated by
setting the popup to Always.

But you can make all of the above moot.  There are two other solutions to eliminate the annoyance of browsers
launching and quitting while maintaining reliable bookmarks sync.



Solution 1.  If you are not using Chrome or Firefox on other devices, and do not need Sign in to Google  or Firefox
Sync,  turn them off.  That is, for Chrome Sign out  of your Google account, or at least switch off the Bookmarks
option under Advanced Sync Settings.   For Firefox, in Preferences  > Sync,  either Unlink this Device  or at least
switch off the Bookmarks  checkbox.

Solution 2.  add Firefox or Chrome to your Login Items, and just leave them running.   You can close all of their
windows if you are not using them.  With no open windows, there is not much activity, and, thanks to the use of modern
virtual memory by Mac OS X, there will not be any noticeable performance degradation.   This is even more so if you
have Mac OS X 10.9 which features App Nap.   I hardly ever bother quitting apps on this MacBook Air.  Currently it has
been running or sleeping for 4 days, and I have 35 apps running.

Bookmarks in Other Macintosh User Accounts 

When you set a Client on an Other Macintosh User Account,  BookMacster accesses the same file it would access
normally, except if looks in a different Home Folder.

Authentication may be required.  If BookMacster cannot obtain the required credential from your Mac OS X Keychain,
it will ask you.  However, if one of BookMacster’s Agent’s Workers cannot obtain a required credential for some
reason, it will simply fail and try again the next time it is triggered.

In contrast to how BookMacster accesses bookmarks in your Macintosh User Account (explained in the previous
section), on other Mactintosh user accounts, only the quick direct sync method is available.  Neither BookMacster nor
its Workers check to see if a web browser is running when accessing files on an Other Macintosh User Account,
although it does warn you to check.  Thus, if you are using this advanced feature, you need to be careful about
whether or not web browsers are running in the other account.  To be safe, just quit them before importing or exporting.

Accessing Web Apps 

The bookmarks of web-based browser apps such as Delicious can be accessed at any time, typically using an
“application programming interface” (API).  Where available, BookMacster uses such an API.  The web apps’
synchronize changes uploaded and downloaded by BookMacster.

Accessing content from a web app requires that BookMacster be able to get a password from your Mac OS X
Keychain If you want a BookMacster Agent to be importing from or exporting to a web app, when setting the Client,
make sure to check the box that says Keep in my Mac OS X Keychain.

In order to minimize loading on their servers, web apps require that BookMacster maintain a local cache of your
bookmarks content.  Sometimes a glitch may result in the  server telling BookMacster that its local cache is
synchronized with their data when in fact it is not.  If you are seeing inconsistencies between BookMacster and a web
app, you can force BookMacster to re-download all bookmarks content from the server on the next import by emptying
BookMacster’s local cache.  To do this, in the menu click BookMacster  > Empty Cache.   The web apps don’t like if
you do this too frequently (within minutes) and may temporarily ban your IP address if they feel offended. 
BookMacster keeps track of this for you, if you are in danger of being banned, usually warns you and refuses to
perform the command.

Accessing Bookmarks in Loose Files    

When you set a Client using the Choose File (Advanced).  item in the popup menu it the Import or Export table,
BookMacster remembers the Macintosh file system’s “alias” so that if you move the file, it cam still be found.  Again, no
checks or warnings on browser running are made before performing an Import or Export.

Home | Parent ← Go → Prior | Next
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Home | Parent ← Go → Prior | Next

4.4  Visiting Bookmarks    
The main menu and contextual menus in Smarky, Synkmark, Markster, and BookMacster contain Visit  menu items
which visit bookmarks when clicked.

You can also visit items by doubleclicking them in the document window, and visit from the app’s Floating Menu.

If you want Smarky, Synkmark, Markster or BookMacster to remain the active application, hold down the option  key as
you click this menu item.  (This does not work when using the keyboard shortcut ⌘K.  That is, ⌘⌥K does not work.)

4.4.1  Designated Web Browser

The designated web browser for a bookmark  depends on several factors.

At the lowest level, which operates per bookmark  is the Visit this bookmark with:  attribute in the Inspector panel.

We’ll explain the two bottom choices:

Your Default Browser (whatever)  Your Macintosh User Account has a default  browser set to use in opening links
from other applications, such as Smarky, Synkmark, Markster or BookMacster.  Selecting this option tells the app to
use that default  browser.

(To change your default browser, activate Safari, then click menu Preferences  > General  and find Default web
browser.   More info is available in this Apple article.)

Mac OS X may sometimes not behave as expected.  If you have more than one copy of your default browser installed,
the Mac OS sometimes gets confused and defaults to using Safari instead.  Also, if your default browser is on another
disk drive, it will show in this menu as (Unknown),  even though it will probably work correctly.

Use Document Default Settings  Selecting this option tells BookMacster to use the browser that you have set as
default.  In Smarky, Synkmark and Markster, this is in Preferences > General.  In BookMacster, you set this per each
Bookmarkshelf in each document’s Settings  > General.

To summarize: By default, BookMacster visits bookmarks with your Mac OS X Default Web Browser, but you have fine-
grained control down to the level of a single bookmark if you want to use it.
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4.5  Visiting + Adding  
This page describes the features which make Markster and BookMacster available to you, for visiting and adding
bookmarks, while web browsers are active.

       Topics on this Page

Floating Menu
Bookmark Name  and Comments  are Generated Automatically
Landing New Bookmarks via the Menu Items and Toolbar Buttons in Web Browsers
Landing new bookmarkss via the BookMacsterize  Bookmarklet
Which browser is used for visiting

4.5.1  Floating Menu

The Floating Menu  brings the power of Markster or BookMacster into your web browsers.  There are three ways to
access it

Global keyboard shortcut

Dock Menu

Status Menulet

In the Floating Menu, you can visit a bookmark you have previously stored in a Bookmarkshelf, or land  a new
bookmark to the web page you are currently viewing.

To visit a bookmark, you can use either the Mini Search  or Bookmarks Tree.   To land a new bookmark, you can use
either the Add to  menu item, or the Add Here  menu items in the Bookmarks Tree.

Using Mini Search  to visit a bookmark
Hit the ↓ key on your keyboard, down to the Mini Search  menu item.

Type in a few characters, until the of results is short enough to be navigable.

Hit the tab  key,

Hit the ↓ key to select the bookmark you want to visit.

Hit ‘return’ to visit the site.



By default, Mini Search searches bookmark names  and tags,  but by clicking the magnifying glass you may remove
these and/or add other attributes.

Using Add to  to land a new bookmark
View the page you want to bookmark in a web browser in Camino, Chromium, Firefox, Google Chrome, Chrome
Canary, OmniWeb, Opera, or Safari.

Activate Markster’s or BookMacster’s Floating Menu.

Hit the ↓ key on your keyboard, down to the Add [My New Bookmark] to  menu item.

Hit the → key.

Hit the ↓ as needed to select either your Default Landing or one of the Recent Landings in the submenu.  If you
want to put the new bookmark in to a different folder which is not listed, choose the first folder in the submenu and
we’ll fix it later.

Hit the ‘return’ key to create the new bookmark in the folder you have selected.

If you wanted a different folder which was not listed, re-activate the Floating Menu and select the item Inspect [My
New Bookmark],  then in the Inspector panel whick appears, under the Comments,  click the Move  hyperlink and



move the bookmark to its final destination.  This final destination will be added to the Recent Landings, ready for
your next use without this extra step.

Using the Bookmarks Tree to add or visit a bookmark
The Bookmarks Tree is only visible if, in Preferences > Appearance > Floating Menu, the checkbox Bookmarks
Tree  is switched on.  Users who prefer to use the Mini Search  and Add to  menu items described above may
switch this off to reduce clutter.

Visiting

Hit the ↓ key on your keyboard, down to the Bookmarkshelf document name or Hard Folder (Bar, Menu, etc.)
containing the bookmark you want.  (To use the tree, you need to know the lineage of the bookmark.)

Navigate further into the subfolder containing it by using the arrow keys.  The → key takes you down to the next
child level.  The ← key pops you out to the parent level.  The ↑ and ↓ keys navigate up and down the presently-
displayed menu.  Note that the → and ← keys do as we said above; they don’t necessarily move you to the “right”
or “left”.  It makes sense after you become accustomed to it.  You can also navigate through the menu using the
mouse, but this is not recommended because it’s too easy to fall off the edge, which causes the whole hierarchy to
disappear and then you need to start all over.

Once you’ve reached the desired menu item, hit the ‘return’ key to visit it.

Landing

View the page you want to bookmark in a web browser in Camino, Chromium, Firefox, Google Chrome, Chrome



Canary, OmniWeb, Opera, or Safari.

Activate Markster’s or BookMacster’s Floating Menu.

Navigate into the Tree as described in the previous section (Visiting) , but instead of selecting a bookmark, after
you’ve reached your target folder, select the Add Here  menu item at the top of the submenu, or else select … into
a new subfolder …  to create a new subfolder.

4.5.2  Bookmark Name  and Comments  are Generated Automatically

A newly-landed bookmark will have its Name  set initially to the title of the window in the web browser (which is
generally the name provided by the website publisher

If you have selected any text on the web page, the bookmark’s Comments  will initially be set to your selected text. 
(This does not work in all browsers.  It works in Chrome and Camino.  For Safari, OmniWeb and Opera, this works if
you are using Mac OS X 10.8 or earlier.  In Mac OS X 10.9, we found that Apple would require you to jump through a
security hoop, granting Markster or BookMacster access to “control your computer”, and then even after you do that, it
still doesn’t work.  So we filed a bug to Apple and disabled it in these cases.)

4.5.3  Landing New Bookmarks via the Menu Items and Toolbar Buttons
in Web Browsers

Through the magic of browser add-ons, Markster or BookMacster are able to install controls into some web browsers
which send bookmarks directly to BookMacster.  In Firefox, you can have two menu items added to Firefox’
Bookmarks  menu:

In Google Chrome, Canary and Chromium, you can have a browser action button  which sits to the right of the
browser’s address field:

Although there is only one action in these browsers, you can still Add Quickly  or Add & Inspect  by using the option
key to control whether or not the Inspector appears.

These controls are not installed by default.  To install them, in Markster or BookMacster, click in the application menu >
Manage Browser Add-Ons  and switch the desired checkboxes in the rows labeled Menu Items  or Toolbar Button  on
or off.

4.5.4  Landing new bookmarkss via the BookMacsterize  Bookmarklet

The BookMacsterize Bookmarklet  is not as handy as the Floating Menu and is not recommended for new users.

Although it looks like any other bookmark, clicking this bookmark does not visit any site.  Instead, it sends the title of
the web page you are visiting, its URL, and any static text which you have selected in the page, to Markster or
BookMacster.  The app immediately creates a new bookmark from this information, entering the selected static text
into its Comments  field.

Creating the BookMacsterize  Bookmarklet



There are two ways to create a BookMacsterize bookmarklet.

Install in Browser (Recommended).  Clicking in the menu File  > Install Bookmarklet into ▸  will create a
BookMacsterize bookmarklet in the frontmost open Bookmarkshelf if one does not exist, and then export only the
BookMacsterize bookmarklet to a selected Client browser.

Add to Bookmarkshelf.  One of the menu options under the [+] (Add) button in the upper-right corner of the Content
Tab is to add a BookMacsterize bookmarklet.

After you perform an Export, this BookMacsterize bookmarklet will appear in the Bookmarks Bar/Toolbar/Favorites (or
whatever it is called) in any locally-installed web browser app which you exported to.

Managing the BookMacsterize  Bookmarklet
The URL of the BookMacsterize  Bookmarklet is a bit of JavaScript which sends the information to Markster or
BookMacster.  Modifying this JavaScript may render it no longer functional.

By default, the BookMacsterize  bookmarklet is placed at the end of the Bookmarks Bar/Toolbar/Favorites, but you
may move it to wherever you wish, or you may delete it if you don’t want to use this feature.  You can restore a missing
or broken BookMacsterize  bookmarklet by selecting its menu item under the + button in the top-right corner of the
Content View.

You may also rename it.  For example, to conserve space on your Bookmarks Bar, you may want a shorter name.  The
letter “B” works fine.  You might also find a suitable symbol by clicking in the menu Edit  > Special Characters.   We
didn’t find any that we liked enough to use as default, but here are some you might consider:  ◆ ✸ ✔ β ◉.  Tip: You
can copy and paste from here.

4.5.5  Which browser is used for visiting

However you choose to initiate a visit,

If the active application is a web browser, the bookmark will be visited with that web browser.  This is normally the
case if you are browsing the web with, say Safari.  Thus, you can visit any bookmark with any browser at any time by
activating the desired web browser before clicking the bookmark.

If the active application is not a web browser, the bookmark will be visited with the app’s designated web browser
for that bookmark.

Thus, if you want to visit a bookmark with your designated web browser for that bookmark, activate any app which is
not a web browser (not Safari, not Firefox, not Google Chrome, etc.) before clicking the bookmark.  Note that the latter
case always applies if you doubleclick a bookmark in a Bookmarkshelf window, because at that time Markster or
BookMacster itself is the active application, and these apps are not web browsers.
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4.6  Browser Add-Ons   
The developers of Firefox, Chrome and Chromium have thoughtfully provided some hooks into which BookMacster
adds on  its own software components which empower it to work more intimately with these browsers.  Borrowing a
general term from Mozilla, we call these our Add-Ons.

       Topics on this Page

Purposes of Browser Add-Ons
Management of Browser Add-Ons
Updates
File Components

4.6.1  Purposes of Browser Add-Ons

The Browser Add-Ons

   empower Synkmark, Markster or BookMacster to export bookmarks content to, and for some
browsers, Import bookmarks content from, the browser app while it is running.

Notify a BookMacster Agent when you have changed (added, deleted, moved, or updated) a bookmark or folder in
the browser’s built-in bookmarks, so that a Worker can sort the new bookmark into place and/or import it and then
export to other browsers’ built-in bookmarks.

  provide a Toolbar Button or Menu Items in the browser  by which you can add new bookmarks directly
to Markster, or a BookMacster Bookmarkshelf.  They look like this

In Google Chrome and related browsers, you can have a Toolbar Button like this…

In Firefox, you can have two Menu Items like this…

4.6.2  Management of Browser Add-Ons

The file components that comprise the Browser Add-Ons are included in the Synkmark, Markster or BookMacster
application package, and controls to install them are in the app.  You do not need to download them separately, and
they are not available from Mozilla’s site nor the Google App Store.

The first time you command an import from or export to a web browser supporting an add-on while it is running in the
importing or exported profile,  Synkmark, Markster or BookMacster will install the add-on components which will make
quitting the browser unnecessary in future such imports or exports.  For Chrome, Canary or Chromium, this is done
silently.  For Firefox, you must make two or three mouse clicks to “approve” the installation.  The app will guide you
through this.

http://addons.mozilla.org/


Manage Browser Add-Ons  window
BookMacster also provides an interface to “manually” install, uninstall, and test browser add-ons.  To access it, click in
the application menu > Manage Browser Add-Ons.

In this window, the notation (Loaded)  means that the extension is installed in the profile, and that the browser is
running, in this profile.  Firefox can only run in one profile at a time.  Google Chrome can be running multiple profiles in
different windows, each with its own extension loaded, or not, and once an extension is loaded,  it will stay loaded
even if all of its windows are closed.  Thus, clicking the Refresh  button and noting whether extensions are (Loaded)
and (Not Loaded)  is the only true method to determine the current state of Sheep Systems’ Extensions in a given
profile.

The More Tests…  button at the bottom of the window exposes a test which gives an accounting of the Firefox and
Chrome browser profiles in use, and also provides a little monitor which indicates whenever bookmarks change
notifications are issued by our Firefox and Chrome, Canary and Chromium extensions.  This test may help determine
the problem if you think Synkmark or BookMacster is not syncing when bookmarks changes occur in these browsers,
but the Test  buttons indicate OK.  (This type of problem is often caused by a mixup in browser profiles.)

4.6.3  Updates

In order to add new features, fix bugs, or maintain compatibility, just like Synkmark, Markster or BookMacster, although
less often, our browser Add-Ons are occasionally updated to a new version.  Again, such updates are shipped inside
Synkmark, Markster and BookMacster updates and you shouldn’t need to worry about them.  Each time one of these
apps launches, it checks the versions of any already installed  browser add-ons, and installs any updates that are
necessary.  You may be asked to assist with a mouse click or two, to indicate your approval.

Because the Add-Ons are not distributed nor updated through Mozilla’s Add-Ons For Firefox  or Google’s Chrome
Web Store,  whatever update  settings you set in Chrome or Firefox for our Add-Ons have no effect.

4.6.4  File Components

The files that comprise our browser Add-Ons are all installed into your Home’s Library.

Firefox
Our Add-On for Firefox is installed as a single package of software called an extension.  This extension contains a
JavaScript XPCOM Component communicates to Synkmark, Markster or BookMacster via a js-ctypes dynamic library. 
It is first installed in your Firefox profile folder at this path:

path/to/profile/extensions/staged/firefoxextension@sheepsystems.com

and then after the next time Firefox launches, Firefox moves it to

path/to/profile/extensions/firefoxextension@sheepsystems.com

Chrom-ish Browsers (Chrome, Canary, Chromium)
Our Add-Ons for the Chrom-ish browsers (Chrome, Canary and Chromium) each consist of one or two extensions.

The BookMacster Sync  extension is installed for syncing with the browser’s bookmarks.  This includes importing or
exporting while the Chrom-ish browser is running, and importing or exporting if you are signed into Chrome  and have
enabled Bookmarks  syncing, whether the browser is running or not, and notifying Synkmark or BookMacster of
changes that need to be imported and synced to other Clients.

The BookMacster Button  extension provides the toolbar button which may be used to send bookmarks to Synkmark,
Markster, or BookMacster directly, which is one of the tools available for using BookMacster as a central bookmarks
store.

Depending on whether you want syncing, the toolbar button, or both, either or both extension may be installed in any
given browser/profile.

http://support.mozilla.org/en-US/kb/extensions-add-features-to-firefox
https://developer.mozilla.org/en/XPCOM
https://developer.mozilla.org/en-US/docs/Mozilla/js-ctypes
http://support.google.com/chrome/bin/answer.py?hl=en&answer=154007


Both of these extensions are installed by Synkmark, Markster or BookMacster as External Extensions.  In addition to
the Manage Browser Add-Ons  window in Synkmark, Markster or BookMacster, you can also observe and control the
status of these extensions in the Chrom-ish browser, by clicking in its main menu: Window  > Extensions.

Both of these extensions communicate with Synkmark, Markster or BookMacster via our Chromessenger  helper tool,
which resides in the Synkmark, Markster or BookMacster application package.  When you launch any of the Chromish
browsers, it launches one Chromessenger process for each User Profile into which either of our Chromish extensions
is installed.  When you install one of our extensions, it also installs a special manifest file  in the NativeMessagingHosts
subdirectory of the browser’s application support directory, for examples…

   ~/Library/Application
Support/Google/Chrome/NativeMessagingHosts/com.sheepsystems.chromessenger.json
   ~/Library/Application Support/Google/Chrome
Canary/NativeMessagingHosts/com.sheepsystems.chromessenger.json    ~/Library/Application
Support/Chromium/NativeMessagingHosts/com.sheepsystems.chromessenger.json

Prior to Synkmark/Markster/BookMacster version 1.22.9 (July 2014), our Chrom-ish extensions required an NPAPI
Plugin, installed at

   ~/Library/Internet Plug-Ins/SheepSystemsNPAPIPlugin.plugin

It is not used by versions 1.22.9 or later of our apps, and these versions will delete it upon launching.  If you find any
SheepSystemsNPAPIPlugin.plugin left hanging around anywhere, you should delete it.
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4.7  Browsers (Clients)   
In BookMacster, A Client  is usually a web browser.  More generally, a client is a thing from which a Bookmarkshelf
will get bookmarks content during its Import,  and to which it will send them during its Export.   In the first context, it is
referred to as an Import Client  and in the second, an Export Client.   You add and remove Clients in the Import and
Export tables in a Bookmarkshelf’s Settings  > Clients  tab.

In Synkmark, Safari, Firefox and Chrome profiles are actually all clients  under the hood, but they are always one of
these three, so we just call them “browsers”.

In Smarky, Safari is actually a client  under the hood, but we just call it “Safari”!

       Topics on this Page
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4.7.1  Types of Clients

There are actually four types of clients.

   Most often, a Client is a locally-installed web browser app, with its bookmarks in your Mac
account.  Client “Safari” simply means your  Safari bookmarks.  For browser apps that support multiple profiles,
each profile is a different Client.  (This is the only type of Client supported by Smarky and Synkmark.)

 A Client can also be a web-based browser app account.  If you have multiple accounts, for example, two
Delicious accounts, each will appear as a separate Client in BookMacster.

 A Client may also reference the bookmarks of a particular locally-installed web browser app on another Mac
account on your network, for example, the Chrome bookmarks in profile “Suzie” in server Old Mac Mini.   This will
appear in the popup menu as “Old Mac Mini:Suzie:Chrome”.

  Finally, a Client can be a loose  file  of bookmarks which you accessed using the Choose File (Advanced)
menu item.  BookMacster tracks this file using the path and file alias mechanism built into Mac OS X.

4.7.2  Proprietary Syncing Services   

Major web browser publishers now provide proprietary sync services] for your bookmarks, open tabs, browsing history
and other data among their browsers on multiple devices.  For syncing, you may need to consider how they interact
with Smarky, Synkmark or BookMacster.  The following list gives links to the instructions you need to control these
services.

For Safari, Apple provides iCloud’s Safari service.  That article is a little vague.  To switch Safari bookmarks
syncing on or off, click in the menu  > System Preferences  > Internet & Wireless  > iCloud,  then switch the
checkbox labelled Safari  (Mac OS X 10.8 or later) or Bookmarks  (Mac OS X 10.7).  We’ve also found this even
better explanation.
For Chrome, Google provides Sign In.
For Firefox, Mozilla provides Firefox Sync
For Opera, Opera Software provides Opera Link.
iCab offers a syncing facility if you bring your own WebDAV server.  Launch iCab and click Preferences  > Show
All  > Browser  > Bookmarks  > Synchronizing.
Ditto for OmniWeb.  Launch OmniWeb and click Preferences  > Bookmarks.

http://support.apple.com/kb/PH11421
http://osxdaily.com/2013/03/28/how-to-sync-safari-bookmarks-between-mac-os-x-windows-iphone-ipad/
http://www.opera.com/link


4.7.3  Browser (Client) Settings   

  In Smarky and Synkmark, settings for browsers are in Preferences  > Syncing.

In BookMacster, settings for Clients are in BookMacster’s document window, tab Settings  > Clients.

In all cases, these settings are not kept in the .bkmslf document.  Instead, they are Local Settings.

Browser (Client) Popup  

The control contains a popup menu for each Browser (Client), in which you specify its target
browser/service/account/profile.  Browser (clients) found on your Macintosh User Account are listed explicitly. 
Otherwise, you can click one of the special menu items at the bottom:

To access bookmarks in a web app account which does not have a password in your keychain, click New/Other.
To access bookmarks of a Client app in another Macintosh user account, click Other Macintosh User Account
To access bookmarks in a “loose” file, Choose File.

After clicking one of these special items, appropriate dialogs will appear for navigation, account or application
identification, and/or authentication as required.

Smarky does not have this popup because it supports only the single Safari profile in the current Macintosh user
account.

Import  and Export  Checkboxes  

For normal syncing of bookmarks, leave both the Import  and Export  checkboxes switched ON.  (For Smarky, there
are no such checkboxes because both Import  and Export  are always enabled.)

If you don’t want bookmarks changes from the Client to be synced to Synkmark BookMacster, other Clients, other
Macs, etc. then switch off Import.   If you don’t want the Client to get bookmarks changes from Synkmark or
BookMacster, other Clients, other Macs, etc. then switch off Export.

Advanced Client Settings 

Mapping data such as bookmarks from the format used by one application (Client) into that of another always involves
decisions and often compromises, which we call remapping.  BookMacster tries to handle these in the way you expect,
and usually the default results are satisfactory.  But BookMacster provides many controls for those who want to more
precisely set the behavior of Import and Export operations.  They are available in two contexts…



Per-Client Contexts
To the right of each Client listed in Settings > Clients tabs is a small button with a gear icon.  Clicking this button
displays a sheet of the Advanced Settings for that particular Client.  In the sheet, you’ll see sub-contexts Import,
Export  and Special  in which the settings are applied.  The Special  subsection is for settings which are only
applicable to a certain Client type, and therefore will not be shown for all Clients.

Import Postprocessing Context
Besides making adjustments during an Import operation for each Client, a few adjustments, for example Delete
Unmatched Items, cannot be performed until after all Clients have been imported.  You can set the parameters for
these adjustments by clicking the larger button with a gear icon nearest the top of the Settings > Clients tab.

Reordering Buttons  

By clicking the up and down triangles at the far right, you can arrange the order of which Clients’ imports and exports. 
This may make a difference when bookmarks content is imported.  For example, if two Clients each have a bookmark
with the same URL, and are set to merge by URL, which of the two is actually imported is affected by which one is
imported first.  (Note that BookMacster normalizes URLs.)  For Export operations, however, because exporting does
not affect the Bookmarkshelf’s content, the order of Clients does not matter.

Browser (Client) Name in Red, prefixed by X  

If a Client’s name appears in a red font, prefixed by a heavy red X, that means the Client’s bookmarks data can no
longer be found on the disk, and thus it is defunct.  There are three ways to resolve this situation:

Click the disappeared Client’s popup and re-assign it a different client which is currently available.

Restore the data of the disappeared client, possibly from a backup.  If you don’t know how the data disappeared,
try changing a bookmark in the Client.

Delete the defunct Client by clicking round “-” button.

Firefox clients, in particular, will go defunct after you have  somehow caused a Firefox Reset, because in so doing,
Firefox suffixes the re-created profile name with a unix epoch timestamp.  In this case, you should see the new
client/profile in the popup, available for reassignment.

4.7.4  Warning to power users 

Your knowledge of where bookmarks files are stored is nice but dangerous.   Do not use the Choose File  advanced
feature if you simply want to access the bookmarks of a locally-installed app.  Doing so will make browser-related
triggers unavailable and bypass checking to see whether or not a browser is running when later executing an Import or
Export, which can result in bookmarks loss or corruption.  To set, for example, your Safari bookmarks as a Client,
simply click “Safari” in the Clients popup menu.  And, by the way, never touch Safari’s Bookmarks.plist  file while
Safari  or Bookmarks  syncing is switched on in iCloud  in your System Preferences.  If not done properly, iCloud will
quietly raise hell, not always immediately.
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http://mzl.la/MLVHSq
https://bugzilla.mozilla.org/show_bug.cgi?id=717070
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4.8  Browser (Client) Oddities    
This page explains several subtle behaviors in some Import and Export operations which apply only when certain
browser or client types are involved.

       Topics on this Page
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4.8.1  Safari Issues

Separators in Safari
If you have Glims installed, Smarky, Synkmark, Markster or BookMacster will detect this and export Safari separators
in Glims style.  That is, when exporting from Safari or a standalone file designated as Safari file type, any separator will
be exported as a bookmark whose name is a single dash (“-“) character.  Glims will detect this and replace them with
beautiful separators in Safari’s Bookmarks Bar and Bookmarks Menu (but not in Safari’s Edit Bookmarks) .

If you do not have Glims installed, the same idea is used but instead of a single dash, the name is exported as a
horizontal line of em-dashes, unless the bookmark’s parent is the Bookmarks Bar, then it is the pipe character (“|”). 
The idea is the same but the Glims separators look better.  When importing, a bookmark with either of these names, or
with Glims’ “-“, will be interpreted to be a separator.

Mapping into Safari’s Reading List
Beginning with Safari version 5.1, Safari has a third hard folder called Reading List.   The idea of this is similar to the
Unsorted Bookmarks  in Firefox (except that it has a name which makes a little more sense).  They are both intended
to be a place where you might quickly drop bookmarks discovered while browsing the web that you would like to read
later, and then either “sort” (where here we have mean categorize  instead of alphabetize)  into a regular folder or
delete.

Therefore, during Import and Export operations, Smarky, Synkmark, Markster or BookMacster map Safari’s Reading
List  into its Reading/Unsorted  hard folder, along with those of Firefox.  One issue, however, is that while Firefox
allows folders (subfolders) in its Unsorted Bookmarks,  Safari does not.  Therefore, when exporting to Safari, if a
Reading List  is found (indicating that the bookmarks of Safari 5.1 or later), any folders found in Reading/Unsorted  are
mapped into the root level of Safari instead of Safari’s Reading List.   If a Reading List  is not found (indicating that the
boomarks are of Safari version 5.0.x or earlier), then the contents of Reading/Unsorted  is exported to your Default
Parent you have indicated for Safari.

http://www.machangout.com/


Sorting (Ordering) of the Reading List
When Safari displays its Reading List, it ignores the order imposed by Smarky, Synkmark, Markster or BookMacster
and instead seems to display according to date added, with the more recent first.  Although we could probably override
this behavior, we don’t.

4.8.2  Confusion between Google Chrome and Google Bookmarks

Google Inc. provides two separate products:

The Chrome  web browser is a locally-installed browser app.   It replaces web browsers like Safari and Firefox. 
Within Smarky, Synkmark, Markster or BookMacster, it is referred to as Chrome.

Google Bookmarks  is an online web-based browser app,  like Delicious.

Further confusion is caused by the Chrome > Set up Sync… menu item in Chrome.  Using this feature syncs to other
Chrome applications you may use on other Macs, but these bookmarks are not  your Google Bookmarks.   They are
stored separately.  Google does not provide any connection between the two.  In particular, Google does not provide a
way to synchronize bookmarks between Chrome and Google Bookmarks.  This capability is provided by Smarky,
Synkmark, Markster or BookMacster.

4.8.3  Chrome, Canary and Chromium Issues

Chrome, Canary, and Chromium
Chrome and Chromium are the same web browser built on the Chromium open-source code, simply with different
names and file locations.  Smarky, Synkmark, Markster or BookMacster supports importing and exporting with either or
both, whatever you have installed, as separate browsers or clients.  The same is true for Google Chrome Canary,
which is the alpha  or early adopter  version of Google Chrome.

You could sync two or three of these Chrome-ish browsers’ together via a Google account, using their built-in syncing,
but if you do that, be careful you don’t create a sync loop.

Sign In / Out
The Chrom-ish browsers (Chrome, Canary and Chromium) have a built-in sync which allows you to sync their
bookmarks via a Google account among the Chrom-ish browsers on multiple Macs, PCs, Android and iOS devices
over the internet.  If you are using this facility, and also syncing with Synkmark, Markster or BookMacster, make sure
that you don’t create a sync loop.

To control your usage of this facility,

Activate Chrome, Canary, or Chromium.
In the leftmost (Chrome/Canary/Chromium) menu, click Preferences.
Click in the left sidebar: Settings.

Read under Sign in.   If you are not  signed in, you are not  using the built-in Sync.  Otherwise, click Advanced sync
settings…  and observe the Bookmarks  checkbox.

Mobile Bookmarks
Smarky, Synkmark, Markster and BookMacster ignore but preserves Chrome’s Mobile Bookmarks.   Our idea is that
you should use Mobile Bookmrks  for bookmarks which you only want on your mobile device.

You should put bookmarks which you want synced in either Desktop Bookmarks  or Other Bookmarks.   Chrome gives
you a choice at the bottom of the popover.  Change “Mobile Bookmarks”, and whatever you change it to will become
your new default new-bookmark location.

If you have already started syncing with Smarky, Synkmark, Markster or BookMacster, and want to move your Chrome
bookmarks out of Mobile Bookmarks,  do this…

http://www.google.com/chrome/intl/en/landing_chrome_mac.html
http://build.chromium.org/buildbot/snapshots/chromium-rel-mac/
http://code.google.com/intl/en/chromium/
https://www.google.com/intl/en/chrome/browser/canary.html


Activate Smarky, Synkmark, Markster or BookMacster.

Open your Bookmarkshelf Document if it does not open.

Click the Syncing  button in the toolbar to Pause  syncing.

Activate Chrome on your Mac.

Click in the menu: Bookmarks  > Show All Bookmarks.

In the left sidebar, select Mobile Bookmarks

Drag all the bookmarks you want from Mobile Bookmarks  into Other Bookmarks  or Bookmark Bar.

Reorganize if desired.

Activate Smarky, Synkmark, Markster or BookMacster.

Click in the menu: File > Import from only > Chrome.

Click the “Syncing” button in the toolbar to “Resume” syncing.

Export as prompted.

Sometimes Need Your Help to Load a Profile
There is a pathological case in which Smarky, Synkmark, Markster or BookMacster or one of its Agents’ Workers will
ask you to help a little by load a certain user profile so that it can import to or export from a Chrom-ish browser.  This
will occur under the following conditions.

You have created multiple profiles in a Chrom-ish browser.
You have configured Agents to sync a certain profile ‘X’.
In the browser, in profile ‘X’ , you have signed in to Chrome  with a Google account, have have not switched off the
sub-setting to sync Bookmarks,  which is on by default.
The browser is running, but profile ‘X’ has not been loaded.  This will happen if the browser had been launched into
a different profile, and no window has been opened into profile ‘X’ since launching.
Smarky, Synkmark, Markster or BookMacster, or one of its Agents’ Workers, requires to Export  to Chrome profile
‘X’.

Once you load the profile, it will stay loaded until the browser quits, and will re-open automatically provided that you
have a window open to this profile when quitting the browser.  In other words, this will not occur if you regularly use the
profiles to which you are syncing.

We have requested that the Chrome developers provide a better facility for bookmarks syncing so that we may
someday remove this annoyance.

4.8.4  OmniWeb Issues

Moving OmniWeb Items among its Collections
External identifiers of OmniWeb items are not unique among their three top-level collections – Favorites, Bookmarks
Menu and My Shared Bookmarks.  Each of these collections can have an item numbered, for example, 57, and
Smarky, Synkmark, Markster or BookMacster must therefore prepend a “collection identifier” to its identifier upon
importing and remove it when exporting.

This sometimes causes little glitches.  For example, let’s say you have a bookmark in OmniWeb’s Personal Bookmarks
that has been happily imported to and exported from a Bookmarkshelf document .  In such a document, it appears in
the Bookmarks Menu since this is the equivalent of OmniWeb’s Personal Bookmarks.  Now, in OmniWeb, click menu >
Bookmarks > Show Bookmarks Page, move this bookmark into Favorites.  Because it’s in a different collection now,
OmniWeb must assign it a different identifier.  Now activate the Bookmarkshelf document and Import from OmniWeb. 
Because it has a different identifier, the app will not recognize it as the one that was originally in the Personal
Bookmarks/Bookmarks Menu, and will import it as a new bookmark, so now you’ll have a duplicate.

You can prevent the duplicate from being created by setting the Merge Keep  control to Client  or Bookmarkshelf  and
also checking on  Merge URL.



OmniWeb’s bookmarks storage format was designed many years ago when the advantages of truly unique persistent
identifiers were not as widely appreciated.  One hopes that if Omni Group continues development of OmniWeb, they
will someday update update their bookmarks storage to realize this, as Opera Software did when they shipped Opera
9.5.

Shortcuts Associated with URLs
OmniWeb associates its shortcuts with URLs instead of with bookmarks.  This means that if you have, for example,
two bookmarks to the same URL, one with a shortcut and one without a shortcut, and export OmniWeb, in OmniWeb
they will both have the shortcut.  Then when you import back from OmniWeb, Smarky, Synkmark, Markster or
BookMacster will apply the shortcut to both of them.  However, if you are importing from other Clients at the same time,
this conflict can cause spurious changes or churn to be indicated in the Sync Log.

4.8.5  Firefox Issues

Same Tags apply to Duplicate Bookmarks
In Firefox, when you click menu Bookmarks  > Manage Bookmarks  and get the bookmarks Library  window, it appears
as though tags are associated with bookmarks, but they are not.  In Firefox, tags are actually associated with URLs.  In
Smarky, Synkmark, Markster or BookMacster, tags are associated with bookmarks, just as they look.  To maintain the
same content as you see in Firefox, when performing a Import from Firefox, the app creates the same tags for all
bookmarks that have the same url.

If you don’t have any duplicate bookmarks (bookmarks with the same normalized URL), then this doesn’t matter, but if
you do, it does.  For example, say that you have one or more bookmarks with the same normalized URL, and put a tag
on, one of them, then Export to Firefox.  If you then inspect the content in Firefox’ Organize Bookmarks window, you
will see that all of the several bookmarks have this tag.

Slow Exports while Firefox is Running
Firefox is quite slow at changing bookmarks, dreadfully slow when tags are involved, and apparently Firefox does all of
this on its main thread, meaning that it beachballs you cannot do anything else in Firefox until it is done.  Usually, if
you’re just adding a few bookmarks, it’s not a problem, but if, as is typical in a first export from Smarky, Synkmark,
Markster or BookMacster, you’re changing thousands of items, it can take several minutes on a typical Mac.  New
users don’t have our Firefox extension installed at this point, so the app asks the user to quit Firefox and then, with
Firefox out of the way, the app can export quickly.  However, in case you export many changes for some reason after
installing our Firefox extension, while Firefox is running, the app will stop and advise you to quit Firefox first if it
estimates that the change will take more than 1 minute.  This happens if there are more than several hundred changes
or more.

(You can demonstrate the slowness of Firefox all by itself.  Put several thousand bookmarks into Firefox, open Show
All Bookmarks  (Library), select folder(s) containing several thousand bookmarks in aggregate, and and hit ‘delete’. 
Firefox will beachball for several minutes, and show its Unresponsive Script  warning sheet several times, citing
Firefox’ Bookmark Service or Tagging Service.  This happens even if you have disabled all Add-Ons and restarted
Firefox.)

Visit Count
Firefox keeps a visit count  attribute for each bookmark, which, as the name implies, is supposed to increment each
time a bookmark is visited in Firefox.  To see the visit count  for a bookmark, display it in Firefox’ Show All Bookmarks
(“Library”), then perform a secondary click on any column heading and switch on Visit Count  in the contextual menu. 
A Visit Count  column will appear.

Smarky, Synkmark, Markster and BookMacster ignore Firefox’ visit count.   The visit count  that you see in Firefox is
the count of visits from Firefox only.  The visit count  that you see in Smarky, Synkmark, Markster or BookMacster is
the count of visits from the app plus visits from other synced browsers which properly support import and export of visit
count:  Camino and OmniWeb.  (The design of Firefox makes syncing to their visit count  problematic.)

Firefox Sync



The publisher of Firefox, Mozilla, provides a facility called Firefox Sync.  This facility empowers you to sync your
Firefox bookmarks and other data among Firefoxes on differenct devices.  If you see a button titled Set Up Sync…
when you do as indicated in that link, you are not using Firefox Sync.  Otherwise, you are using Firefox Sync to sync
bookmarks if the Bookmarks  checkbox is switched on.

4.8.6  iCab Issues

The Wandering Bookmarks Bar
iCab allows you to designate any folder,  anywhere in the hierarchy,  to be your Favorites.   The items in the Favorites
folder appear in a toolbar across the top of the window.  It is thus like the Bookmarks Bar  or Bookmarks Toolbar
present in other browsers.

Smarky, Synkmark, Markster or BookMacster treats this folder as a Bookmarks Bar, but does not allow it to be
anywhere.  When you Import from iCab, the Favorites  folder, wherever it is, is moved to be the first child of the root, as
in all other browsers.  However, the app remembers where it came from, and when you export to iCab, it is restored to
its original location.

4.8.7  Roccat Issues

Bookmarks storage in Roccat is primitive.  Obviously,

You cannot create soft folders.  All bookmarks are in the same flat list.
This same list appears in both the Bookmarks toolbar and in the Bookmarks menu.

Bogs Down with too many bookmarks
Roccat may bog down if you export too many bookmarks to it.  If you export too many bookmarks to Roccat and find
the performance to be unacceptable, you can remove all of the bookmarks from Roccat by doing this…

Quit Roccat if it is running.
Activate Smarky, Synkmark, Markster or BookMacster.
Click in the menu: File > New Bookmarkshelf.
Switch on Roccat as a Client.
When asked if you want to Import from Clients now,  click Later.
After the new Bookmarkshelf is created, click in the menu: File > Export.  The idea is that you are exporting an
empty  bookmarkshelf to Roccat, thus removing all bookmarks.
Since this empty document is now useless, click the menu: File > Close and Delete, then OK to trash it.

Note that, in its Bookmarks  menu, Roccat allows you to visit the bookmarks of Safari, Firefox and Chrome.  Although
you cannot add  bookmarks to other browsers from within Roccat, this may be acceptable for some users.  You can
add new bookmarks to Roccat and synchronize by, in your Settings > Clients, switching off the Export  checkbox for
Roccat, so that you import only.  Another solution is to not use the Bookmarks  in Roccat at all, and instead access
bookmarks directly, using Markster, or BookMacster as a central bookmarks store.

No External Identifiers
Roccat does not provide unique, persistent external identifiers like other browsers do.  Smarky, Synkmark, Markster or
BookMacster therefore creates its own pseudo-unique external identifiers based on the name, url and location of a
bookmark.  The result is undue churn when importing from and exporting to Roccat.

4.8.8  Opera Issues

Sort by…  Preference
Opera has options built in to sort bookmarks by name, address, description (comments), etc.  By default, it sorts all

http://mozilla.org/
http://www.mozilla.org/en-US/mobile/sync/


folders by name, according to its own rules (which are basically to sort everything). Therefore, in order to see sorting
done according to the sorting settings in  the Bookmarkshelf, we must change this option to “Sort by my order”. This
option is available to you in Opera’s toolbar…

However, you normally don’t have to do this, because Smarky, Synkmark, Markster or BookMacster changes this in
Opera’s preference file whenever it executes an Export to the Opera Client associated with your Macintosh User
Account.  This occurs if the Export Client is the Opera bookmarks of your Macintosh user account, or of another
Macintosh user’s account, but not if the Export Client is a loose file.

Import/Export of items in Bookmarks kBar
The Bookmarks Bar  in Opera looks  like the Bookmarks Bar  in other Client browsers, but is in fact quite different for
our purposes.  (If you don’t see a Bookmarks Bar in Opera, in the Opera first if a tab is showing your Bookmarks,
close it; then in the menu click View  > Toolbars  > Bookmarks Bar.   It should be switched on (checked).)

In other browsers, the items in the Bookmarks Bar are unique items.  In Opera, the Bookmarks Bar and the Panel
contain only references to items which are actually in other collections.  In this regard, they are like the Smart Playlists
in iTunes and Smart Albums in iPhoto, which contain only references  to songs and photos which are actually
elsewhere in your iTunes and iPhoto Libraries.

In Opera’s Manage Bookmarks  window, when you Show Info  on an item and then check the box Show on bookmarks
bar  or Show in panel,  you set a flag which tells Opera to display the item both in its “actual” location and in this other
location.

So, a question arises when importing such an item: Should it be imported into the “actual” location, or moved into the
Bookmarks Bar?  You answer this question by switching on the Import items marked “Show on bookmarks bar” into
Bookmarks Bar  checkbox in the Per-Client Advanced Client Settings for Opera.

If this box is checked on, items specified in Opera as Show on bookmarks bar  will be imported into the Bookmarks Bar
of the Bookmarkshelf instead of into the location corresponding to their location in Opera.  Whether or not you check
this box depends on what is more important to you – preserving items in the Bookmarks Bar, or preserving items in
their other location.  By default it is off,  because this may cause churn during exports, in some pathological cases
which we have not discovered yet.

Trash
Another unique feature of Opera’s bookmarks is the Trash, a special folder into which deleted bookmarks go.  Because
it can be surprising to see these deleted bookmarks showing up in other browsers, the Per-Client Advanced Client
Settings for Opera also has a checkbox which tells it to not import these items.

Trick to see Bookmarks in Opera’s Manage Bookmarks
In Opera, when you click Bookmarks  > Manage Bookmarks,  you get a window with a left sidebar.  The right pane will
show the contents of whatever folder is selected in the left sidebar.  Opera does allow you to create bookmarks at the
root/menu level, but the root/menu does not exist as an explicit folder in Opera, so they never show when scanning
through the left sidebar with the ↑ and ↓ keys.  In order to see these “loose” bookmarks at the root/level menu, click
with the mouse in the empty area at the bottom of the left sidebar, to deselect all folders in the left sidebar.  Poof!  The
missing bookmarks appear!

Expanded/Collapsed Folders



Smarky, Synkmark, Markster or BookMacster remembers the Expanded/Collapsed state of folders when you save a
document, and also exchanges this information with Opera which exhibits similar behavior in its Manage Bookmarks
window.  (An exception is the Trash folder which, by Opera’s design, is always collapsed the next time you open it in
Opera.)

4.8.9  Pinboard 

Short version: After making changes in Pinboard on the web, sometimes you need to wait 15 minutes or so before
importing the changes to Smarky, Synkmark, Markster or BookMacster, or exporting additional changes from
BookMacster to Pinboard.

Long Version:  In order to reduce network traffic and improve performance, BookMacster maintains a local cache of
bookmarks stored on the remote servers, such as Pinboard’s.  Prior to importing from or exporting to Pinboard,
BookMacster sends a query (“posts/update”) to Pinboard asking when was the last time that bookmarks were changed
on the remote server.  If it matches the time that the local cache was stored, BookMacster skips downloading data from
Pinboard and uses what it has.  Well, on 2012 June 13 we found that a download didn’t occur as expected, and found
that this was because Pinboard was returning a stale date to our “posts/update” query.  It did this for at least 10
minutes, but returned the correct date after 15 minutes.  If you don’t want to wait, click in the menu BookMacster >
Empty Cache….

4.8.10  Shiira

A number of behaviors in Shiira are inexplicable.  The most noticeable is that it always reads your Safari  bookmarks
and puts them at the top of its Bookmarks Cabinet.   BookMacster does not do this, and exporting from BookMacster
to Shiira cannot over-ride it.

4.8.11  Delicious Issues 

Duplicate bookmarks
Delicious does not allow your account to have more than one bookmark with the same URL.  If you submit such a
bookmark which duplicates an existing bookmark, the existing bookmark is deleted.

Editing URL in Delicious ⇒ Duplicate in BookMacster
This is because the external identifier used by Delicious is based on its URL.  Delicious also allows you to edit the URL
of a bookmark within their web app.  If you do so, and then re-import from this Delicious account into a
Bookmarkshelf(), BookMacster will therefore get a new identifier for this bookmark and treat it as a new bookmark that
you just added.  Further, if this import is done with the Delete Unmatched Items  option checked off, BookMacster will
not delete the old bookmark, so you will have two bookmarks – one with the old URL, and one with the new URL.  This
is appears to be a limitation in the design of Delicious.  (The identifier generated by BookMacster for a Google
Bookmarks item is also based on its URL, but Google Bookmarks does not have this problem because Google
Bookmarks does not allow you to edit the URL of a bookmark in their web app – you must create a new bookmark
anyhow.)

feed:// Becomes http://
If you enter a bookmark with a URL that has a “feed://” scheme, Delicious will silently change the scheme to “http://”.

Slow or Interrupted Import or Export
Service Unavailable  Messages.  When dealing with a web app, the proprietor (Delicious) can change their traffic
shaping policies policies at any time.  Although BookMacster was designed to handle the policies which we have
discovered at the time we last looked at them, changes could have occured, resulting in Timeout,  Service
Unavailable,  or Please Retry Later  messages from Delicious.  Refer to the article on our web page, near the bottom

http://www.sheepsystems.com/support/delicious.html


for the latest news.

Whitespace
Delicious will not allow consecutive spaces, or any leading or trailing whitespace, in bookmark names (titles) or
comments (notes).  BookMacster collapses consecutive spaces in these attributes into one space, and leading or
trailing whitespace is trimmed, before exporting (uploading) to Delicious.

4.8.12  Google Bookmarks Issues 

Unsupported Schemes such as javascript: or file:
Google Bookmarks supports only bookmarks with schemes http:, https: and ftp:.  When exporting to Google
Bookmarks, BookMacster will skip over bookmarks whose urls have other schemes save as javascript: or file:.

Dates
When viewing your Google Bookmarks at http://google.com/bookmarks, the date which appears adjacent bookmark
name is the date that it was added or  modified.  This is the only “date” attribute supported by Google Bookmarks.

Duplicates
Google Bookmarks does not allow you to have more than one bookmark with the same URL.  If you submit such a
bookmark which duplicates an existing bookmark, the existing bookmark is deleted, and a new bookmark added with
other attributes of your new submission.

Google Sign In
BookMacster cannot access Google Bookmarks directly, as it can with Pinboard, Delicious or Diigo.  Instead,
BookMacster borrows access from Safari.

By default, BookMacster requires you to verify prior to each Import or Export operation that you are signed in  to
Google with the appropriate account.  You can avoid this inconvenience if you (a) have only one Google account and
(b) never sign out of Google in Safari.  In this case, when you are presented with the warning, you may switch on the
checkbox I’m ALWAYS signed in to Google as …blank….  From now on, don’t ask.

With this setting enabled, you can also add your Google Bookmarks account as a Client, and BookMacster Agents can
export changes to  Google Bookmarks automatically.  The danger of this setting is that if you switch it on, but then
start using a second Google account, BookMacster could import from or export to the wrong Google account.

This setting is also available in Settings  > Clients.   Click the Advanced Settings  (gear) button the for relevant Google
Bookmarks account.

Then, in Special Settings,  look for the checkbox.

Why Safari?   It does not matter if your default browser is a different browser.  This intimacy with Safari is inherent in
the URL Loading System of Mac OS X.  Oddly, though, Safari does not need to be running for BookMacster’s
Google Bookmarks functions to work.  So if you don’t ever use Safari, that’s great.  Launch Safari, sign in to Google,
quit it, and leave it quit.

Historical Note:   Until late 2013, BookMacster was able to determine which account, if any, you had signed in  to
Google in Safari and, if necessary, sign out, grab a password from your Mac OS X Keychain, and then sign back in to
perform an Import or Export operation on a different account.  We were quite proud of this achievement until late 2013,

http://google.com/bookmarks


when Google installed additional security measures which rendered such robotic sign-ins no longer possible.  This
capabiility was therefore removed in BookMacster 1.19.7.

Limit of 10,000 Bookmarks
During tests in May 2014, we found that, once you have 10,000 bookmarks in your account, if you add more, Google
Bookmarks will delete older bookmarks unpredictably, to make room for the new one while keeping the total at 10,001.

Furthermore, if you delete all of your bookmarks in that account, and then start re-adding the same bookmarks that you
had before, the bookmarks which had been unpredictably deleted will fail to add, even if you use their web app.  So,
it’s like they still remember  the bookmarks that they unpredictably deleted bookmarks even after you’ve deleted all of
the others.

Deleting Bookmarks Takes Too Long
BookMacster is at the mercy of Google’s servers during Imports and Exports, and some operations are slow.  Deleting
(or updating) bookmarks during an export is particularly bad; 1-10 seconds per bookmark  is typical.  By contrast,
uploading a slew of bookmarks is fast.  Therefore, if you have many deletions or updates in an Export to Google
Bookmarks, it is faster to start from scratch.  To do that, visit the Google Bookmarks Web App, and click the link to
Delete All.   Then immediately export from BookMacster.

External Identifiers
Like other clients, Google Bookmarks does assign a unique identifier to each bookmark, however BookMacster does
not use it, because it is only available in an RSS download, which cannot download any more than 1000 bookmarks
reliably.  Therefore, the external identifier that you see in the Inspector panel side drawer of a bookmark for Google
Bookmarks is not Google’s identifier but is the identifier assigned by BookMacster.  To create this identifier,
BookMacster uses the fact that, like Delicious, Google Bookmarks does not allow bookmarks with the same URL, and
does not allow editing of bookmark urls.  (If you edit – change – the url of a bookmark in BookMacster, then upload to
Google Bookmarks, it actually destroys the old bookmark and creates a new one.)  The external identifier used by
BookMacster is therefore a string representation of the md5 hash of the bookmark’s url.  Note: BookMacster’s legacy
app, Bookdog, does  use the actual identifier assigned by Google Bookmarks, which is why Bookdog does not support
more than 1000 bookmarks in a Google account.

On the bright side, because the web interface of Google Bookmarks does not allow users edit the URL of a bookmark,
the identifiers created by BookMacster are in fact persistent.  And because Google Bookmarks does not allow items
with the same URL in the same account, they are also in fact unique.  Therefore, our patching of Google Bookmarks’
identifiers does not seem to cause any misbehavior in the operation of BookMacster.

Whitespace
Google Bookmarks will not allow consecutive spaces, or any leading or trailing whitespace in bookmark names (titles)
or descriptions (notes).  BookMacster collapses consecutive spaces in these attributes into one space, and leading or
trailing whitespace is trimmed,  before exporting (uploading) to Google Bookmarks.  (Actually, leading and trailing
whitespace can be entered into Google Bookmarks’ web app, but this seems to be a bug.  When BookMacster
downloads the bookmarks, these leading and trailing whitespaces are trimmed.  BookMacster therefore trims them
when exporting to Google Bookmarks to avoid detection of extraneous “changes” when they are later re-imported.)

4.8.13  Punctuation in Diigo Tags 

Besides the fact that doublequotes serve as tag delimiters in Diigo, other punctuation characters will get changed. 
Commas get changed to spaces, forward and back slashes, and backslash-escaped doublequotes (as in “"”) get
changed to underscores.  This is just what we’ve noticed; there may be other substitutions.  These are not
documented anywhere in Diigo documentation.

4.8.14  Separators in Camino

http://google.com/bookmarks
http://en.wikipedia.org/wiki/MD5


Because Camino does not endow its separators with external identifiers, Smarky, Synkmark, Markster and
BookMacster create their own external identifier for separators imported from Camino based on it’s parent’s external
identifier and its position.  The only noticeable effect of this, that we know of, is that if you move a separator in Camino
(or move other items above it, causing its position to be changed), and then Import from this Client with Merge Keep
set to Client,  the corresponding separator in the app will be deleted and a new one created at the new location,
instead of moving the existing one.  (Now you know you must be at the bottom of the page!)

4.8.15  Smart Keyword Searches

Firefox, iCab, Camino, Google Chrome, Opera, and Safari with Glims installed all support Smart Keyword Searches. 
However, they are implemented differently.

In Firefox, iCab and Camino, Smart Keyword Searches  are stored as bookmarks.   Smarky, Synkmark, Markster
or BookMacster will import them from these browsers, you’ll see them in the Content of a Bookmarkshelf
document, you can edit them in BookMacster, and they’ll be exported to these browser Clients.

In Google Chrome, Opera, Safari with Glims installed, Smart Keyword Searches are stored elsewhere, such as in
Preferences.  You will never see them in Smarky, Synkmark, Markster or BookMacster.

Smarky, Synkmark, Markster or BookMacster will omit Firefox Smart Keyword Search Bookmarks when exporting to
any other browser except Camino, because they won’t like they do in Firefox.  (They don’t work in iCab because iCab
does not support a Keyword or Shortcut attribute.)

4.8.16  Multiple Web App Accounts and the Mac OS X Keychain  

If you have multiple accounts for a web app such as Delicious, each is a separate  Client  as far as BookMacaster is
concerned.  BookMacster discovers these accounts and populates them into the Import  and Export  popup menus in
Settings  > Clients  by looking in your Mac OS X Keychain for passwords you have stored to the web apps’ domain, for
example, Delicious.  Some of these may have been entered previously by Safari, Cocoalicious or another Keychain-
aware  app.  To remove old accounts that are no longer used, launch the Keychain Access  application
(/Applications/Utilities/Keychain Access.app), search for and delete them.

When connecting to a web app, if BookMacster finds a password which you have not previously authorized
BookMacster to use, Keychain will ask your permission. If BookMacster does not find the password even in Keychain,
BookMacster will ask you to to enter it into as secure field, and give you the option to store it in Keychain for future use
by BookMacster or any other (Keychain-aware)  app which is smart enough to look there for it.

4.8.17   Download Policy Options for Web Apps

During an Export operation to Delicious, Diigo, Pinboard or Google Bookmarks, BookMacster should find out what
bookmarks are currently on the server and merge them per your settings.  Ideally, BookMacster would ask the server
to just tell me all of the bookmarks, if any, that have been added, updated or deleted since we last synced.   But this
information is not always available, sometimes not reliable, and in its absence BookMacster should download all
bookmarks from the server.  This can take several or many minutes if you have thousands of bookmarks on the remote
server.  Therefore, BookMacster allows you to manually override the default automatic behavior.  To access these
controls, open the advanced settings for the relevant Client, and look in the Special Settings  section.

Note that these settings are only available for permanent Clients which you have specified in the Settings > Clients
tab.  The temporary Clients which are used when you click in the menu: File  > Import from Only  or Esport to Only  will
always  download all bookmarks from the server (in BookMacster 1.22.4 or later).

http://mzl.la/L8rNu0


The setting Import  > Never  is not available because it would defeat the purpose of the whole operation.  If you don’t
want a permanent client to Import, switch off its Import  checkbox in Settings  > Clients.

For Google Bookmarks, at this time, the current status is never available.  Therefore, setting one of these controls to
Automatic  has the same effect as setting it to to Always  – it will always download.

Better Reliability: Always Download during Exports
Over the years we have seen bugs in the various web apps come and go, and at some times the indication from the
server telling BookMacster that nothing has changed, you can skip downloading  turns out to be  not true.  For best
reliability, if you don’t export to a web app very often, you may prefer to Always  download during Exports.

Faster: Never Download during Exports
At the other extreme, to avoid the extended export times that can result if you have thousands of bookmarks to
download, you may wish that BookMacster never  download them.  This is technically OK if you use the web app only
to visit  bookmarks and always change (add, update, edit, modify, delete) bookmarks in BookMacster only, you
may prefer to Never  download during Exports.

If there are other clients, it might also make sense to switch off the Import  checkbox for this client (see above)

This can be efficient, but will will cause bad results if you ever forget and in fact change bookmarks changed on the
remote server, using the client’s web app, or some other tool, because this all happens effectively behind
BookMacster’s back.  For example, if you switch on this checkbox and then add bookmarks to the remote server using
the web app or some other service, these bookmarks will be deleted the next time that you export from BookMacster,
even if you have Delete unmatched items  switched off.  Or if you delete 100 bookmarks on the remote server, then
export from BookMacster, BookMacster will re-upload them if they are still in BookMacster, or waste time re-deleting
them if not.
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4.9  Agents    
Agents are little observers installed into Mac OS X which watch for certain triggers, such as bookmarks changing in a
web browser.  When a trigger occurs, an Agent launches a little Worker process.  The Worker runs several commands
that typically sync and maybe sort your bookmarks, and then terminates itself.

Your settings for Agents are not kept in the .bkmslf document.  Instead, they are Local Settings.

       Topics on this Page

Controls for Agents
Advanced Agents
Agents are Lazy
Agents Use launchd
Workers
Clean-Up of Orphaned Agents

4.9.1  Controls for Agents   

Smarky and Synkmark use Agents under the hood to perform their syncing, and you control them in Preferences  >
Syncing.

Markster does not support syncing nor Agents.

In BookMacster, you have fine-grained control over Agents in a document’s Settings  > Agents  tab.  By default, the
Simple  Agents subtab is displayed.  This tab is gives enough detail to configure agents for keeping bookmarks in a
single browser sorted, or sync multiple browsers.  Users who desire more (or less) may use the Advanced  Agents
subtab.

4.9.2  Advanced Agents 

In the Settings  > Agents  > Advanced  tab of a Bookmarkshelf, you can create customized Agents.   Agents are a
feature provided by Mac OS X which dispatch a BookMacster Worker  process to do some work on your
Bookmarkshelf whenever certain triggers occur.

The conditions which trigger Agents to spring into action are called, well, Triggers, and the work that they do is defined
by a sequence of Commands.

In the Advanced view, note that the Triggers and Commands shown in the two lower tables are those of the Agent

which is selected  in the upper table.  To add an item, click the nearby  button.

The order of Triggers does not make any difference, but of course the order of Command execution is significant.  To
reorder commands, either drag and drop, or select a command and type ⌘↑ or ⌘↓.

Deactivating or Removing Agents
If you would like to temporarily deactivate an Agent, un-check the box in its Active  column.  To remove an Agent

permanently, select it and click the  button next in the top table in the Settings > Agents tab.

Triggers
Triggers are events which cause the Commands of a BookMacster Agent to execute.

Triggers have a trigger type  and an optional detail.   For example, the scheduled  trigger type is triggered every day or
every week at a certain time.  Its detail is the scheduled time and days.  The available trigger types  are explained in



subsequent sections on this page.

The necessary trigger(s) are created for you automatically when you check one of the boxes in the Simple  tab of
Settings > Agents.   To see what trigger(s) were created, or to modify triggers, click the Advanced  tab.

If an Agent has more than one trigger, there is no significance to the order of the triggers.

Trigger Types

I log in to my Mac  Trigger Type
This trigger will run commands when you log into your Macintosh User Account.  Besides being handy for people who
like to start their day in sync, this trigger is recommended if your Bookmarkshelf document file might be updated while
you are logged out.  ChronoAgent, for example, can do this, and it is conceivable that other processes could update a
.bkmslf file before Mac OS X has loaded the *Other Mac updates this file” trigger. This trigger has an option; choose
one of the following…

only if this .bkmslf has changed  reduces system resource usage by checking document metadata to see if a
change has occurred.  If not, the Worker terminates without even opening the .bkmslf document.

every login, always  is useful in case you want the commands to run because something may have updated
bookmarks in web browsers, that you want to overwrite unconditionally.

Bookmarks Changed  Trigger Type
The Bookmarks Changed trigger is available only if one of your Import or Export Clients is the Safari, Firefox, or one of
the (Google) Chrome bookmarks on your Mac account.  The reason is that only these browsers are capable of notificy
BookMacster when their bookmarks change.  For other locally-installed browser apps, use the Browser Quit  trigger
(see below) instead.  For web-based browser apps (Delicious, Pinboard, Diigo, Google Bookmarks), this trigger does
not function because none of these services push  their changes.

Other Mac updates this file  Trigger Type
This trigger is activated whenever a Online File Syncing Service (or, actually, any other app) updates the
Bookmarkshelf file.  Note that when setting Commands for such a trigger, it is not necessary to “reload” or “reopen” the
Bookmarkshelf, even if it is already open, because Bookmacster does that automatically, presenting the new content. 
Typically, with this trigger you will only execute one Command, which is to Export – this is the trigger that is set when
you activate the Simple Agent to Export Changes from Other Macs to Clients.

New bookmark is landed from browser  Trigger Type
This trigger is activated following each [landing  of a new bookmark to BookMacster directly.   The export is delayed in
case you want to edit the newly-landed bookmark in the Inspector panel.  If the Inspector is not displayed when the
new bookmark is landed, the export occurs immediately.  If the Inspector is being displayed, the export occurs when
you close the Inspector panel, or until you do not edit anything for 30 seconds, whichever comes first.

(Because this trigger can only occur when BookMacster is running, it does not require a launchd Agent like the other
trigger types, but is really just a switch inside BookMacster.)

Browser Quit  Trigger Type
The Browser Quit trigger is only available if one or more of your Import or Export Clients is that of a local browser app
with bookmarks on your Mac account.  This trigger is actually “as soon as possible” for browsers that do not allow
BookMacster or its Worker to edit their bookmarks while they are running.  (For Safari, you can get a sooner trigger by
using the Bookmarks Changed  trigger, see above.)

Scheduled  Trigger Type
This trigger allows you to schedule an action to be performed daily or weekly at a specified time.  The time must be
entered in the right-hand column using the 24-hour clock system.

Commands

http://simple.wikipedia.org/wiki/24-hour_clock


Commands  is a sequence of instructions which an Agent gives to a worker to perform the task you desire.  A
command is typically something that you could do manually yourself by clicking an item in the main menu.  Often, they
have the same name and do the same thing.  Some commands are Import,  Sort,  Export,  Save Document,  etc.

Note that there is no Open  or Open Document  command because this is implied.  Commands are attributes of an
Agent which are in turn attributes of a particular Bookmarkshelf document that must be opened in order for the
commands to be performed.

Some commands have a detail  associated with them.  For example, the Export  commands have a detail setting
which specifies what to do if the export cannot be executed because a web browser app is running (abort, quit the web
browser app, or force quit the web browser app).

The necessary command(s) are created for you automatically when you check one of the boxes in the Simple  tab of
Settings > Agents.   To see what command(s) were created, or to modify commands, click the Advanced  tab.

In the Advanced view, you can move a command within the sequence by selecting it and typing ⌘↑ or ⌘↓, or by drag
and drop.

The Revert  command is now superfluous in most cases, because current versions of BookMacster are constantly
watching open .bkmslf files and immediately read in any changes they see, and of course Workers must always load
the Bookmarkshelf file from the disk when they begin because they are transient creatures.  This command is kept for
compatibility.

Options for Import  and Export  Commands
When you select an Import  or Export  command, the next detail  column offers a popup menu in which you select what
to do if a web browser which is involved is running, and will not allow BookMacster to read or write its bookmarks as
required.

Cancel.  The commands (sorting, whatever) will not be performed.  The Agent will try to run the commands again at
the next scheduled time.

Quit.  The browser will be asked to Quit.  Normally, it will quit.  But there are many circumstances under which a
browser could refuse to quit.  One example is if you have set in the browser’s preferences an option to “ask you” if
windows or tabs should be closed.  It will display a dialog.  Another example, unexpected, is if the browser has recently
been launched and is displaying a “Update is available, do you want me to install it now” message.  Finally, if you start
to enter data into a web form, most browsers will display a dialog warning you that the data you have entered will be
lost.  In any of these cases, if you are not there to dismiss the dialog, the browser will refuse to quit.

Force Quit.  In this case the browser will be asked to Quit, and if it refuses, BookMacster will “kill” it without regard to
what dialogs are being displayed.

If BookMacster quits or force-quits a browser, it will automatically re-launch the browser for you after it is done.  Most
browsers nowadays have a preference setting to restore your previous windows and tabs, loading all of the web pages
currently being displayed.  Thus, with such a preference setting enabled, the Quit option is a good choice if your Agent
is scheduled to run when you are not normally at your computer.  When you return, the job will have run and your
browser will be displaying the same web pages as it was before the job started.

4.9.3  Agents are Lazy    

In order to not slow down your Mac and your internet connection with frivolous processing, Smarky, Synkmark,
BookMacster and Online File Syncing Services are designed to coalesce changes and sync lazily.   Changes from one
Client to another on a local Mac may take up 9 minutes, and changes to Clients on another Mac may take up to 12
minutes to appear.  (Usually, those times are only 5 and 8 minutes, but there is an additional wait immediately after the
app has synced, which you come into play if you make some changes, the app syncs, and then you make more
changes.)

This works fine as long as you only work on one Mac at a time.  If you feel you know what you’re doing and want
syncing to be faster, you can change the value in Preferences  > Syncing  > Minutes to wait before importing changes
from web browsers.   When set to the minimum value of 0-1,  syncing should occur within 2 minutes on the local Mac
and 5 minutes to your other Macs.  The latter time depends greatly on your Online File Syncing Service.

4.9.4  Agents Use launchd    



Most Agents are implemented by one or more  launchd agents,  a facility provided by Mac OS X.  Their launchd agent
files are in the directory

   ~/Library/LaunchAgents/

The launchd agent files are either trigger  files, or a special quit watch  file.

A trigger  file implements a single Trigger in a single Agent, and has a name of the form

   com.sheepsystems.BookMacster.XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX.YYY.ZZZ.plist

The part with all the XXXs is the unique identifier of the Bookmarkshelf on whose behalf it acts.  The YYY is three
decimal digits saying which agent in the Bookmarkshelf this launchd agent is acting for, and the ZZZ is similarly three
decimal digits saying which trigger it implements.  The YYY and ZZZ begin with 000 for the first agent or trigger in the
table, 001 for the second, etc.

The special quit watch  file has a name of the form

   com.sheepsystems.BookMacster.QuatchRunner.plist

This special file is installed whenever you save a Bookmarkshelf whose Agents contain one or more triggers that are of
the browser  quit trigger type.  Its job is to keep running a little process which watches for browser apps to quit
(because, unfortunately, launchd does not provide this service).  The process it keeps running is an instance of
BookMacster-Quatch  which is included in the application package.

4.9.5  Workers   

Agents, however, do not do any actual work.  When one of its triggers occurs, an Agent triggers an invisible Worker
process.  Technically, the Worker is a running instance of the BookMacster-Worker  helper tool which is included in the
application package.  It typically runs for ten seconds or so and then terminates itself, when the work is done.

First, the Worker does several checks to make sure that Smarky, Synkmark or BookMacster itself has not caused the
trigger by an export, that another Worker is not already running, that the relevant Agent has not just been created
within the last few seconds, that a Online File Syncing Service is not in the process of writing the file, etc.  If all the
tests pass, then the Worker determines what to do as follows…

• If Smarky, Synkmark or BookMacster is the active application and the Bookmarkshelf which the Worker needs is
open and has unsaved changes, the syncing is skipped.  The pending changes will be imported the next time that a
syncing is triggered.

• If Smarky, Synkmark or BookMacster is running, and the Agent’s Bookmarkshelf is open, the Worker sends an
AppleScript message to the app, instructing it to perform the Commands.  If the bottom of the Bookmarkshelf is visible
on the screen when this happens, you may notice the progress being indicated in the Status Bar.  If your use case is
for the app to sync bookmarks, we recommend leaving the app quit in order to avoid this annoyance, except when you
want to do bookmarks housekeeping.  Before beginnning your housekeeping, click the Syncing  button to temporarily
pause  syncing.

• If Smarky, Synkmark or BookMacster is not running, or if the app is running but the Agent’s Bookmarkshelf is not
open, then the Worker opens the Bookmarkshelf and silently performs the Commands itself.  If a Worker finds that a
browser is running and you have set it to Force Quit if necessary, it will first try a normal Quit and Force Quit only if the
normal Quit fails.  In either case, after reading or writing bookmarks, the Worker will re-launch any browser that has
been Quit or Force Quit.

In all cases, the Worker process terminates itself when the work is done.

Testing and Troubleshooting Aids
If syncing is not performing as you expect, it is sometimes helpful to be alerted when actions occur, or watch what is
happening as it happens.

Sound Effects
In the application menu click Preferences,  then the Syncing  tab and finally the Sound Effects…  button which will

https://developer.apple.com/library/mac/documentation/MacOSX/Conceptual/BPSystemStartup/Chapters/CreatingLaunchdJobs.html


show some checkboxes.

Real-Time Log
To see  Workers in action, in even more detail, in the application menu click Logs  and view the Logs  tab.  Periodically
hit the round Refresh  button at the top of Logs  to get new entries from Workers.

Workers have Your File System Permissions
Worker operations spawned by Agents will fail if you do not have permission to access the required data.  For
example, when you import or export bookmarks on another Macintosh User Account manually in Smarky, Synkmark or
BookMacster, the app requires you to enter an administrator password.  However, your Worker does not know the
password, so the operation will fail.

4.9.6  Clean-Up of Orphaned Agents   

Smarky, Synkmark or BookMacster remember the documents in which you have set Agents.  Each time you launch the
app, in the background, it runs through each of these and makes sure that they exist, are not in your Trash, and have
not been replaced by a Online File Syncing Service update.   If any of these tests fail, the app removes any of their
Agents.  The same thing happens if an Agent cannot find its document when it tries to run.

Also, when the last Bookmarkshelf() which had an Agent with a browser quit trigger type is saved without such a
trigger, the quit watch  file is removed and the BookMacster-Quatch  process is terminated.  In other words,
BookMacster-Quatch  only runs if one or more Bookmarkshelves need it.

Home | Parent ← Go → Prior | Next



Home | Parent ← Go → Prior | Next

4.10  Multi-Device Sync Configurations   
Because of restrictions imposed by web browser publishers and device manufacturers, no single app or service can
sync bookmarks between all browsers and devices.  But Synkmark or BookMacster can be used in conjunction with
other services to the job, and using multiple services gives you workarounds in case one of them fails.  The information
in this section will empower you to sketch out a system that works for you.

Major web browser publishers now provide proprietary sync services for your bookmarks among their browsers on
multiple devices.  They do not talk to one another.  Synkmark or BookMacster can be the missing bridge among
them.

Unless you’re starting from scratch, which is rare, syncing among multiple devices or browsers requires a little thought
to get all of your bookmarks in the correct place  before you start checking boxes.  We recommend sketching it out.

If you only use one web browser, such as only Safari, and want it synced among multiple [devices]90, we recommend
using Smarky, Synkmark or BookMacster only to sort and otherwise manage your bookmarks, but do not enable
Syncing or Agents.  Instead, switch on the proprietary syncing service which is built into the web browser.  These
services are able to sync not only bookmarks but open tabs, history and other data.

To illustate what is possible, we describe two examples.

4.10.1  Example 1: One Synkmark or BookMacster on One Bridge  Mac

In this example, Synkmark or BookMacster is only one Mac, serviing as the bridge  between Safari, Firefox, and
Chrome, which are synced to the Safaris, Firefoxes, and Chromes on the other devices via the proprietary services:
iCloud, Firefox Sync, and Sign In to Chrome (Google).  We call the one with Synkmark or BookMacster the Bridge
Mac.

Just be careful not to create a Sync Loop.



4.10.2  Example 2: Synkmark or BookMacster via an Online File Syncing
Service

You can install Synkmark or BookMacster on more than one Mac, using a single synced Bookmarkshelf Document,
meaning one that you’ve placed into a synced folder, one synced by a Online File Syncing Service, and then Synkmark
or BookMacster will not only bridge among browsers but also among Macs.  You activate the browsers’ proprietary
services only as needed to branch off to any non-Mac devices where Synkmark or BookMacster can’t go.

We maintain a web page with our current evaluations of various services.

Again, be careful not to create a Sync Loop.  Connecting more than more than one Mac to one of these syncing
services, if the Macs are also connected via Synkmark or BookMacster, will create a sync loop.

Instead of connecting Firefox Sync on one Mac and iCloud on another Mac as in the picture, you could again choose a
Bridge  Mac and connect both services to it.

4.10.3  What Will Work for Me?

Example 1 has the advantage of syncing not only bookmarks but other browser data (open tabs, history, etc.) within
each browser.   Safari open tabs on one device will sync to Safari open tabs on another device.  Safari open tabs will
not sync to Firefox open tabs.  Method 2 does not support syncing of open tabs or other data, because it relies on
Synkmark or BookMacster between devices, and the app syncs only bookmarks.

In general, if you have a Mac which you leave on, or at least use regularly, that should be the Bridge  Mac which
connects to iCloud, Firefox Sync, and/or Sign in to Chrome (Google).  The key consideration is that lines going through
Synkmark or BookMacster can only sync when that Mac is on, and you are logged in.  (Agents do not require
Synkmark or BookMacster to be running, but they do require you to be logged in to your Macintosh user account.)  If
all of the Macs with Synkmark or BookMacster are always left on and logged in, syncing will occur within minutes
regardless of which example you follow.

For an example of how syncing may be delayed in Example 1, look at the Example 1 picture and say that you add a
bookmark on the iPad in Safari, the Bridge Mac is off, and then you start using Chrome on that iPad.   The new
bookmark will not be present in Chrome until after that Bridge Mac is turned on for a few minutes.

http://www.sheepsystems.com/files/products/bkmx/cloudSyncServices/


Turning to the Method 2 picture, say that you add a bookmark to Chrome on the MacBook Air at the lower right.  It will
appear within minutes in Safari on that iPad, but wlil not appear in Firefox on the PC at the top of the picture until the
iMac at the lower left comes online.

One might be tempted to bypass the off  Mac by activating more of the other services on more devices.  But don’t do
that because it will create a Sync Loop when all devices are on.

4.10.4  Bookmarks on a Local Network

Because a Bookmarkshelf Document (.bkmslf) file is just a document file, if you don’t want to synchronize over the
internet, you can get the same effect as synchronizing by simply accessing this file from multiple Macs.  The following
figure shows three ways to do that.  Note, however, that in all cases here your Bookmarkshelf file is stored on only one
device.  Therefore, whichever device is hosting your .Bookmarkshelf file should have some kind of backup system,
Apple’s Time Machine™ for example, in case the device fails or suffers some natural or man-made disaster.
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4.11  Sync Loops   
Sync Loops are not complicated to understand, but because it’s so important not to create one, we have a lengthy description, to
make sure that everyone gets  it.  You may stop reading as soon as you understand what a Sync Loop  is.

Putting a Bookmarkshelf Document into a Online Synced Folder and activating an Agent between them creates a bookmarks syncing
service.  Firefox Sync,  Chrome’s Sign in,  and iCloud - Safari syncing are also syncing services.

It is OK to use more than one syncing service, as long as they are syncing separate pairs or groups of browsers and
devices, and only meet at one point.

A Sync Loop  is created when you configure two syncing services to do the same job; to keep the same bookmarks in sync.  To make
sure you don’t have a Sync Loop, draw a diagram of your setup, showing your devices and browsers, like the diagrams in our
example sketches.  Note that in our setups, you cannot start at one browser on a device, trace around the blue lines and come back
to the same browser from a different direction.  There are no complete loops of blue lines.  No loops.  That’s what you want.



Syncing services in a Sync Loop will step on one another’s work as they fight over your bookmarks, continually un-doing and re-
doing.  Deleted bookmarks will reappear, and may even multiply.  Don’t create a Sync Loop.

Because Smarky, Synkmark and BookMacster only runs on Macs, if you only have one Mac, you don’t need to worry about Sync
Loops involving these apps.

To fix a Sync Loop, choose which syncing service you want to do the syncing between two device/browsers, and disable the other
service.  For example, disable Firefox Sync, or in Google Chrome, Sign out. .  In Smarky, Synkmark or BookMacster, that means to
switch off syncing (agents)

RELATED TOPICS

Multi-Device Bookmarks Syncing Configurations
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4.12  More About Syncing Among Macs    
This section gives technical detail which may be helpful for troubleshooting any problems that might occur when
synchronizing your bookmarks among Macs, assuming that you have fully activated Simple Agents for two-way
syncing like this…

4.12.1  Step By Step

We show the actions which occur when you add or otherwise change a bookmark in a client web browser’s built-in
bookmarks under the above conditions, using Dropbox as the Online File Syncing Service.

As you read the steps below, you can follow along in this drawing…



A.  Due to the to Import Changes from Clients  checkbox, after 1-5 minutes, bookmarks changes you make in the bulit-
in bookmarks of your web browsers are detected and imported into Smarky, Synkmark or BookMacster.  If the app is
running and has the subject Bookmarkshelf open, the Worker will instruct the app to process the file and you’ll see the
actions in the Status Bar; otherwise, the invisible Worker will process the file itself and you won’t see anything.  If you
have checked the box Export Results to Clients,  the app, or a Worker, will export changes, if any, to the other client
web browsers on the local Mac.

B.  Internally, this Agent has a command to Save Document  after the export, so the Bookmarkshelf() (.bkmxDoc file),
which is in your Dropbox folder, gets saved to your Dropbox folder.

C.  The Dropbox application is always watching your Dropbox folder.  When it sees the changes in your
Bookmarkshelf, it compresses them and then…

D.  Uploads the changes to the nearest Dropbox server.

E.  The Dropbox servers synchronize each other over the internet.

F.  The Dropbox application on your other Mac will receive the changes.  If you have just logged in or waken from
sleep, Dropbox waits about 60 seconds for the things to calm down, and probably to get some assurance that the
connection is going to stick around.

G.  The Dropbox application on your other Mac moves the original version to an archive in ~/.dropbox/cache, and then
reconstructs the file, including the changes it receives, back into the Dropbox folder.  After Dropbox has received the
file, you’ll see a Growl notification from Dropbox (unless you’ve disabled them).

H.  A Smarky, Synkmark or BookMacster Agent sees that the file has changed, and activates an Agent’s Worker.  Or, if



you leave a Bookmarkshelf open, the app itself detects when changes are received from  the remote server and
automatically reloads the file – this behavior is hard-wired ON, even if you are not using Dropbox and have not
enabled any Agents.  In the latter case, if the Bookmarkshelf is the active window or has unsaved changes when its file
is updated, an Alert is displayed, and you must choose whether to Update  to the server’s version and lose your
changes, or vice versa.  In either case…

I.  The same Agent has a command (its only command) to Export changes to the Client web browsers on your other
Mac.

(The cloud and network icons in the figure are provided by Open Security Architecture under the Creative Commons
License.)

4.12.2  Slow but Sure

Although Smarky, Synkmark or BookMacster have built in methods to handle file conflicts, as do Online File Syncing
Services, it is best if conflicts do not occur because the dialogs you will be asked to click through are annoying.  To
minimize conflicts, before an Agent’s Worker performs work on a Bookmarkshelf which is located in your Dropbox, it
takes some samples of Dropbox app activity to make sure it is not busy.  This analysis takes about 15 seconds.  Also,
because Dropbox is somewhat active during Time Machine backups, Worker activity on a Bookmarkshelf in your
Dropbox is also usually delayed for an additional minute or two while Time Machine is doing a backup.  It gives up after
20 minutes.

4.12.3  Deleted or Replaced Files

If a file is deleted or replaced on one Mac, Dropbox moves it into a special cache folder on other Macs, and appends
(deleted)  and a string of characters to its name, resulting in something funky like this:

   My Bookmarks (deleted 95d803a1e8aa701e86fbcbd1506e338e).bkmxDoc

Therefore, if you want to trash a Bookmarkshelf document file which is in your Dropbox, you must trash it on each
Mac.  To do that,

Find and select it from the submenu File  > Open Recent.
After it opens, click in the menu: File  > Close and Delete.
OK  to trash it.

If you’ve changed your mind about this document and instead you want to keep it, instead of Close and Delete,  you’ll
want to rename and move the document.  To rename and move,

If you have Mac OS X 10.8 or later, click in the menu: click File  > Move To….   In the sheet which appears,
navigate to any desired location in your Home Folder.  Then, click File  > Rename…  and change the funky name.

If you have Mac OS X 10.7 or earlier, click in the menu File  > Save As Move….   In the sheet which appears,
change the funky name and navigate to any desired location in your Home Folder.

RELATED TOPICS

The Dropbox Cache/Trash
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4.13  Hiding and Scripting    

4.13.1  Hiding

Just Quit It   

If you have activated syncing to manage web browsers singly or sync web browsers, there is no need to leave Smarky,
Synkmark or BookMacster running, and no need for it to be a Login Item in your System Preferences.  The app’s
agents work more efficiently when the app is not running.  Just quit BookMacster, and leave it quit until the
next time you want to do bookmarks housekeeping.

Do not quit Markster, and do not quit BookMacster if you are using BookMacster as a Central Store.  Instead, use one
of these other methods it you want it to remain hidden…

Minimize to the Dock  

In OS X, you may minimize a window to your Dock by typing ⌘M.

Running it in the background   

Preference for how the app is launched
In Markster or BookMacster, in Preferences  > General,  there is a checkbox to Launch in Background.   If you switch
that box on, the next time you launch the app it will be a background application,  meaning that it will not appear in
your Dock and not appear in your ⌘-tab Application Switcher.

To enable that checkbox, you must have set either a keyboard shortcut to the app’s Floating Menu or else enabled the
app’s Status Menulet.  That is because you must have at least one means available to interact with the app.  (If Launch
in Background  is on and you violate this by switching both of these off, the app will silently switch Launch in
Background  off.)

If you are running Markster or BookMacster in the background, without the status menulet, wherein the only way to
interact with the app is via your keyboard shortcut to its Floating Menu, you are in a “super stealth” background mode
wherein the app  is completely invisible.  When the app is launched in this mode, for users of Mac OS X 10.8 and later,
a notification appears in the Mac OS X Notification Center reminding you of the keyboard shortcut which is necessary
to show the app.

Switching Between Background and Foreground
Regardless of how Markster or BookMacster is launched, you may want to switch it from one Background to
Foreground or vice versa.

To switch the app from the foreground into the background, If you have Mac OS X 10.7 or later, clicking Background
Markster|BookMacster  in either the application menu, Dock Menu or Status Menulet.  If you do not have Mac OS X
10.7 or later, you must switch your Launch in Background  preference on, quit and re-launch.

If your Mac is running a system earlier than Mac OS X 10.9, after clicking Show Markster|BookMacster,  the app will
not show its menu until you activate a third application and switch back to the app.  Just hit ⌘-tab a couple times, then
⌘-shift-tab.  (This is due to a bug in Mac OS X which Apple provided a workaround for in 10.9.)

4.13.2  Scripting

http://support.apple.com/kb/HT2307
http://support.apple.com/kb/HT2307?viewlocale=en_US&locale=en_US


Smarky, Synkmark, Markster and BookMacster implement some AppleScript commands which make additional
behaviors possible.  For example,

Users who want more fine-grained control over when their bookmarks are synced than is available from
BookMacster’s built-in Triggers may delete all of an Agent’s Triggers and instead trigger the Agent to perform  with
their own AppleScript.

New bookmarks may be landed into Markster or BookMacster directly from other scriptable applications such as
NetNewsWire.

To get started AppleScripting , launch AppleScript Editor and File > Open the app’s scripting dictionary.  Also,
download BookMacster’s sample AppleScripts.
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https://developer.apple.com/library/mac/#documentation/AppleScript/Conceptual/AppleScriptX/Concepts/work_with_as.html%23//apple_ref/doc/uid/TP40001568-BABEBGCF
http://sheepsystems.com/bookmacster/BookMacster-AppleScripts.zip
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4.14  Bookmarkshelf  Document File    
Smarky, Synkmark, Markster and BookMacster are all document-based  Macintosh apps.  Your bookmarks and some
settings are stored in the Bookmarkshelf Document (.bkmslf) file, which  contains bookmarks and folders (your
content) .  A Bookmarkshelf document can be Opened,  Saved,  backed-up, Saved As,  Duplicated,   or even Trashed
or Deleted.   All apps have adopted Apple’s auto save.

The Bookmarkshelf document, however, varies from documents in other apps in these ways:

In Smarky, Synkmark, Markster, you have only one Bookmarkshelf document.  It is opened (if necessary, created)
for you automatically when you launch the app, and when you close the document, the app quits.

Bookmarkshelf Documents have associated behaviors which which you control with Local Settings.   With local
settings,  you can tell the app to do certain things when you launch BookMacster or open the document, and keep
web browser bookmarks in sync with the document, and with each other.

4.14.1  Multiple Bookmarkshelf Document files 

Most users want all of their bookmarks in one place, and if this applies to you, you should create only one
Bookmarkshelf in BookMacster (or use Smarky, Synkmark or Markster which support only one).  This single
Bookmarkshelf can be set (and is so set, by default), to be opened whenever you launch BookMacster.

After OKing our warning, though, you can create multiple Bookmarkshelf Documents if you want to.  Some good
reasons for multiple Bookmarkshelf documents are:

You prefer to keep a different bookmarks set in each client browser.
You want to create a sub-set of your bookmarks for an associate.
You prefer to strictly compartmentalize Work, Home Hobbies, etc.

If you think that you created multiple Bookmarkshelf document files inadvertently, and want to combine them, you
should be aware of the following features in BookMacster and Mac OS X.

In the main menu, File  > Open Recent >  will show all of the documents you’ve ever created that still exist, unless
you have a large number.

Mac OS X makes it easy to find where the current document is located in your file hierarchy.

A quick way to find and trash any and all documents is to Reset and Start Over.

The menu item: BookMacster  > Stop Workers (), Agents ()…  will show documents that currently have syncing
agents active, if any.  The notattion (0)  means that there are none.

The magnifying glass in the upper right corner of your screen is the Spotlight  feature of Mac OS X.  To find all
Bookmarkshelf documents, click Spotlight and enter .bkmslf.   A list will appear.  To open one of them, click it.  If
you have Mac OS X 10.9 or later, to simply show where it is in the filesystem without opening it, mouse over it until
the popover appears showing info, and then  hold down the command (⌘) key on your keyboard.  The file path
will appear at the bottom of the popover.

4.14.2  Automatic Saving    

Since you may be adding bookmarks sporadically throughout the day, the Bookmarkshelf landing such bookmarks
needs to be saved periodically.

When a bookmark is landed, the landing Bookmarkshelf is automatically saved, immediately. In addition, if the
Inspector pops up, and if you make your changes and close the Inspector within 60 seconds, your changes are
automatically saved when you close the Inspector.

If you are using Mac OS X 10.7 or later, these saves are coordinated with the Auto Save and Versions feature of Mac
OS X.



If you are using BookMacster, you can switch off Auto Save by switching ON the checkbox at the bottom of
Preferences > General.  But we don’t recommend this.  With Auto Save and Versions, you’ll never “lose” a bookmark.

4.14.3  Weird File Names    

From time to time you may see copies of your Bookmarkshelf document (.bkmslf) files that have weird file names
alongside the current version.  These are usually nothing to worry about and, if all appears well with the current
version, may be deleted.  This section gives more detail.

Filenames with Tildes (~)
If one day you see a mysterious extra Bookmarkshelf file with one or more tildes (~) between the filename and
“.bkmslf”, and BookMacster is working fine for you, you may trash these tilde files.  They were created by previous
versions of BookMacster and are no longer readable.  For more info, read on…

Filenames with Sharp/Hash/Pound Characters (#)
If one day you see a mysterious extra Bookmarkshelf file with one or more # characters between the filename and
“.bkmslf”, and BookMacster is working fine for you, you may trash such these # files.

When BookMacster opens a bookmarkshelf file, therefore, it examines the file for corruptions which it can fix.  If any
are found, BookMacster moves the corrupt document to a different name, fixes the corruptions, and saves the file.  The
old, corrupt file now has one or more # characters added between the filename and “.bkmslf”.  If it turns out that the
removed items are of value to you, our Support team may be able to recover the removed items from a # file.

Filenames with (deleted xxxxxx)
Bookmarkshelf files which have been in your Dropbox folder may have been deleted by Dropbox.

4.14.4  Details of Bookmarkshelf Versioning

A Bookmarkshelf file, such as myname-01.bkmslf  is actually a little database, with tables defined by the application
version which created it.  As Smarky, Synkmark, Markster and BookMacster are updated to new versions, sometimes
news “rows”, “columns” or “tables” may be added to support new features.  When a newer version of the app with such
table changes opens a Bookmarkshelf which was created by an older version, it immediately renames the
Bookmarkshelf file by apending a tilde (~) to its name, and then converts the file to the new table and saves it with the
old name.  It’s a built-in “feature” of Apple’s Core Data framework which is used by the app.  The reason is that, on the
rare occasion that the new version of the app doesn’t work for you, and you downgrade back to the older version, you
won’t be able to open the new file, but will still be able to open the old tilde file.
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4.15  Bookmarkshelf Structure

4.15.1  What is Structure     

Import and Export Clients, and Bookmarkshelf() Documents, all have what we call a Structure,  by which we mean:

Which, if any, of the *[Hard Folders]()* are present in the root.
What other content item types are allowed in the root

All Structures have an implicit root  which you can also think of as the Client or Browser itself.

Different browsers are designed with different structure.  Here are some examples:

Safari has a Favorites Bar  or Bookmarks Bar,  and its root level accepts soft folders and bookmarks but not
separators.  Only Apple can change this.

Only Firefox has an Unsorted Bookmarks folder.  Like any hard folder,  it cannot be deleted or renamed.

Delicious has no hard folders.   All bookmarks are “loose” in the root.

4.15.2  Why Structure Matters

During an Import or Export, if the structure of the source is different than that of the destination, some items may not be
able to be placed at their expected location and must be mapped.

4.15.3  Setting the Structure

In Smarky and Synkmark, the structure is set automatically for you, based on the structures of the browsers you are
syncing with.  In Smarky, the structure never changes because only Safari is the only browser supported.

In Markster, the structure is fixed to be the Free Structure described below.

In BookMacster, you can set the structure of a Bookmarkshself document in its Settings  > Structure  tab.

Free Structure
Free Structure  means that your document has no hard folders, and any item (bookmark, subfolder or separator) can
be placed in any folder.

Free structure is used in Markster because there is no need to match the structures of web browsers if you are not
syncing to them regularly.

In BookMacster, if you are using Bookmarkshelf Document as a Central Bookmarks Store, and do not ever export to
web browsers or other Clients, you may want to use Free Structure for the same reason.  To do that,

Activate the document window.
Switch to the Content  tab and move all items out of the Hard Folders.
Switch to the Settings  > Structure  tab.
Switch OFF all the checkboxes under Have these Hard Folders.
Switch ON all the checkboxes under Items Allowed in Root.



Default Structure  

When you create a new Bookmarkshelf(), Synkmark or BookMacster look at the Import Browsers (Clients) you added
during the process and set the structure of the Bookmarkshelf so that any item allowed in any of the importing
Browsers or Clients can be placed at the same location in the Bookmarkshelf.  Therefore, no remapping will be
required during an Import.  If you have more than one Client, this will give the Bookmarkshelf a liberal structure,
meaning that in general remapping will be required during Export operations.

These apps will also change the Structure of an existing Bookmarkshelf if you change the Clients, if its file is not in
your Online Synced Folder.  The adjustment when you click out of the Clients  tab or close the document window, and
will be noted in the Status Bar.
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4.16  Organizing In Folders vs. Tags
There are two ways of having relationships bookmarks in use by different browser apps, folders and tags. 
BookMacster supports both, and also provides methods for translating between the two.

       Topics on this Page

Folders vs. Tags
Comparison
Making Tags Work Smarter
Translating between Folder and Tag Relationships

4.16.1  Folders vs. Tags    

Using Folders (with Lineage and Hierarchy)
Most installed web browser applications (Safari, Firefox, etc.) support folders  of bookmarks, allowing you to keep
bookmarks in “parent” folders that can be “grandparent” folders, etc.  In this way, each bookmarks content item has a
lineage.  The arrangement of folders in the entire bookmarks content is called a hierarchy.

Using Tags
Most online bookmarks storage services (Google Bookmarks, Delicious) do not support a folders. Instead, they allow
you to attach tags,  also called labels  to each of your bookmarks.

Using both Folders and Tags
For compatibility, Smarky, Synkmark, Markster and BookMacster supports both Folders and Tags.  Firefox also
supports both Folders and Tags.

4.16.2  Comparison

The advantage of the Folders organization is that you can use simple names which are differentiated by their context. 
For example, if you gave all of your “Apple” bookmarks the tag “Apple”, you might end snacking on an Apple
Computer.  (Actually, it can get alot worse than this.) But with a Folders, it’s no problem:

    Computers 
            Apple 
    Food 
            Fruits 
              &
      Apple

However, there are advantages of the Tag organization too.  First, you can reference the same bookmark from multiple
contexts.  For example, say you’re in the remodeling business and found an article on kitchen sinks.  Do you place it in
the folder “Kitchens” or “Plumbing Fixtures”?  In a Tag organizational system, there’s no problem - you can give it both
tags and you can find it in either case.  Second, using Tags you can share your bookmarks with other people, which is
why the services that use Tag organization are called social bookmarking tools.

It’s a design decision by the engineers of the browser or service and ultimately a personal, organizational preference.

4.16.3  Making Tags Work Smarter



One way to solve the problem of tag organization finding fruit instead of computers is to get in the habit of giving each
bookmark many tags.  For example, you would Apple computer bookmarks with “apple” and “computer” and apple fruit
bookmarks with “apple” and “fruit”.  Then when you wanted a snack you could search for bookmarks tagged with
“apple” and “fruit”.  This would eliminate Apple computer bookmarks.  The web interfaces of web service providers
don’t provide this, but Smarky, Synkmark, Markster and BookMacster do, with its Content Filter.  (Select the desired
tags in the Tag Cloud at the top and click the double-checkmark button.)

4.16.4  Translating between Folder and Tag Relationships

Smarky, Synkmark, Markster and BookMacster help you to translate bookmarks between applications that use Folder
and Tag relationships by fabricating folders from tags and fabricating tags from folders during import and export
operations.
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4.17  Bookdog Grads’ Startup
Smarky, Synkmark, Markster and BookMacster are replacements for our older application, Bookdog.  This page
highlights the changes that will help a Bookdog user to get going with BookMacster.

       Topics on this Page

Which App Do I Want?
New System Requirements
Import,  Export,  Combining Browsers
Auto Import and Auto Export
Agents  — The new breed of Bookwatchdog
Duplicate Bookmarks
Broken Bookmarks
Migration
Sort at Top/Bottom – Invisibly
Glims  Separators in Safari
Getting a Discount when Purchasing a License
Coexistence with Bookdog

4.17.1  Which App Do I Want?

If all you want your Safari bookmarks sorted (alphabetized), the answer is: Smarky.   If you may want to do more,
check out our Bookmarks Manager Selection Guide

4.17.2  New System Requirements

BookMacster requires Mac OS X 10.6 “Leopard” or later.

4.17.3  Import,  Export,  Combining Browsers

The most important little section for a Bookdog user to read.

Bookdog’s old Bookmarks Documents  were somewhat unconventional in that they did not have their own storage. 
Open  and Save  operations were actually performed on a web browsers’ bookmarks.  For example, here’s how
Bookdog worked with Safari:

In contrast, Smarky, Synkmark, Markster and BookMacster Bookmarkshelf Documents  are regular Mac documents. 
Open  and Save  operations are performed on their own storage and do not, by default, affect the bookmarks of any
web browser.  To read or write external browsers’ bookmarks in the new apps, you’ll use the new commands: Import
and Export .

In Bookdog, one document always opened directly the bookmarks of one browser, but the new apps do not have this
limitation and can be used in different styles.  To give you a quick start, we’ve identified three typical starting points. 

http://sheepsystems.com/products/bookdog/
http://sheepsystems.com/products/bkmx


Regardless of your starting point, you can sync your bookmarks among multiple Macs.

4.17.4  Auto Import and Auto Export 

If you’d like BookMacster to behave like Bookdog did, there are openSaveAutoAct which tell BookMacster to 
automatically Import after Open  which we call Auto Import,  and automatically Export before Save  which we call Auto
Export.

The Auto Import,  and Auto Export  settings are activated automatically for you when BookMacster creates a
Bookmarkshelf by importing from only one browser, such as Safari.

Auto Import and Auto Export are analagous to the Auto Save and Versions feature of Mac OS X.

4.17.5  Agents  — The new breed of Bookwatchdog

Bookwatchdog has been retired.  Instead, a Bookmarkshelf can be configured with one or more Agents.   Agents can
sort and find duplicates like Bookwatchdog, but in addition can synchronize (Import, then Export), eliminating the need
for Automator actions.  Agents can be triggered on daily schedules, when browsers quit, when Safari bookmarks
change, or when you log in.  Unlike Bookwatchdog, Agents are launched by the launchd  facility in the Mac OS and
therefore do not require a Login Item.

4.17.6  Duplicate Bookmarks

The Duplicate Bookmark  window which showed duplicates one at a time is gone.  Instead of Analyze for Duplicates,
you now Find Duplicates.   Duplicates are shown in groups so that, for example if you have four bookmarks to the
same web page, you see simply one group of four instead of six pairs which appeared at random.  They are now
shown in a table so that you can select and deal with duplicate groups in arbitrary order, and are stored when you click
Save.

4.17.7  Broken Bookmarks

The Broken Bookmarks  window, which showed a single broken bookmark, is also gone.  After a Verify  operation is

http://developer.apple.com/macosx/launchd.html


complete, you can filter out whatever broken bookmarks you are interested in (example: Any bookmark whose Verify
Status Code is not 200)  in the Find  tab.  The status code, recommendation, and past, present and suggested URL of
bookmarks with issues are now shown in the bottom drawer of the Inspector  panel.  The drawer opens automatically
after a Verify operation completes.  If you want to take a break after fixing broken bookmarks, you can save the
document and re-open it later because all of the Verify  results are saved with the Bookmarkshelf document.

4.17.8  Migration

Last but not least, the Migration  document and its Migration  window are gone.  Instead of migrating between two
browsers, you Import  and Export  between the Bookmarkshelf and an unlimited number of browsers.

To perform a “migration” manually, you configure a Bookmarkshelf with the browser(s) or other clients  from which to
Import,  the clients  to which to Export,  with the various options.  Then instead of clicking Do It,  inspecting the results,
and saving, you click Import,  inspect the results, and then click Export.

To perform a “migration” automatically, instead of using Automator, you configure an Agent  to do the same thing –
Import,  Save  (actually this is optional), and then Export.   Instead of being limited to a single source and single
destination however, you can include as many clients as you want in the Import and Export.

4.17.9  Sort at Top/Bottom – Invisibly

It is no longer necessary to prefix empty spaces or tildes on item names in order to force items to the top or bottom
when sorting.  Items that you want sorted to the top or bottom of their siblings are now marked internally.

4.17.10  Glims  Separators in Safari

The new apps detect if you have Glims  1.0 or later installed, and if so any separators in your content are exported to
Safari using the Glims format.  Separators in the Glims format will be imported whether you have Glims or not.

4.17.11  Getting a Discount when Purchasing a License

If you decide to purchase a license for one of the new apps, the new app will find your Bookdog License Information
and send it to our server which will automatically award you a discount based on your Bookdog purchase date. 
Therefore, if you’ve purchased a Bookdog license, don’t trash your Bookdog preferences and don’t run any of
those app-zapping or app-deleting apps yet.

4.17.12  Coexistence with Bookdog

Generally, if you’re using one of the new apps, you shouldn’t be using Bookdog at the same time.  No harm will be
done, but you’ll get “File Conflict” warnings and other annoyances.

More importantly, if you’ve activated syncing in one of the new apps, you don’t want Bookwatchdog trying to do the
same thing.  For this reason, whenever the new app or one of its Workers launches, or attempts an Import or Export
operation, it checks to see if Bookdog or Bookwatchdog is running and, if so, it quits them or alerts you with an error if
they will not quit.
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4.18  Resolving Errors    
When an error requireing your attention occurs, the app displays an error dialog.  At the bottom left is a button with a
life-preserver icon.  Clicking this button generates an email message including additional technical information,
addressed to our Support team.  If you would like our support regarding an error, don’t take a screenshot.  Click the
life-preserver icon.

Whenever the app or one of its Workers generates an error, it is stored on your Macintosh User Account.  You can re-
view past errors by clicking in the application menu > Logs  and then clicking the Errors  tab.  Errors displayed in this
manner likewise have a button with a life-preserver icon.  Again, don’t take a screenshot.  Click the life-preserver
icon.

Although the apps generally provides quite informative error dialogs, there are a few that could benefit from further
explanation.  The remained of this page does that

       Topics on this Page

Error 144770 : Broken Login Item
Error 144762 : Broken Login Item
Error 3040 : Too Long to Install Browser Extension
Error 3015 : Sync Fight
Errors Exporting to Non-Running Firefox

4.18.1  Error 144770 : Broken Login Item

Why Error 144770 Occurs
Our older app, Bookdog, came with an accessory named Bookwatchdog,  which ran in the background and can
conflict with Smarky, Synkmark, Markster or BookMacster.  Therefore, these apps ask Mac OS X for your Login Items,
so it can see if Bookwatchdog is a Login Item, and if so remove it.  Unfortunately, if the application required for any  of
your Login Items (not just Bookwatchdog) is missing, Mac OS X will give the app an incomplete report.  The app then
asks for your help to fix it.  To get your help, the app presents Broken Login Item  Error 14470.  Yes, it’s annoying, but
it’s something that you should fix sooner or later anyhow.  We’re just being helpful.

Steps to Fix Error 144770
The instructions here look ominous, but following them will probably be the easiest thing you do all day.  Here we go…

At the top left of your screen, click the Apple () menu down to System Preferences.

In the System  row, click Users & Groups  or Accounts  .

There are two tabs near to top.  Click Login Items.   You’ll see something like this…

http://sheepsystems.com/support/


Go back to the dialog in Smarky, Synkmark, Markster or BookMacster and see which item number is broken.

Count down the list to that item number.  In the example shown above, the item number is 2.  Therefore we count
down to the second item number and find that it is  iTunesHelper.   You will likely have different item number and a
different item name.

If you know that you’re no longer using the item indicated, typically because it is associated with an app that you no
longer use, skip the next two steps.

If you don’t recognize the item, put your mouse over the item and sit still for a few seconds.  You may see a tooltip
giving the path  to the application /Applications/iTunes.app/Contents/Resources/iTunesHelper.app.   If you don’t get
any tooltip, and if the item’s ‘Kind’ is ‘Unknown’, it probably means that the item’s file or package has been deleted.

If you realize that you no longer need this item, skip this step.  Otherwise, you should try and find or reinstall the
missing item.  This can be a little tricky if, as in the case of this example, the path is to an app which is inside
another app.  In this example, you would first navigate in Finder to /Applications, then see if you have iTunes
application. If you don’t then indeed this is a Broken Login Item.  If you do, then you must look inside the iTunes
application package to see if you have Contents/Resources/iTunesHelper.app.  To do this, perform a secondary
click (“right-click”) on iTunes and click Show Package Contents.   Open the Contents folder, then inside that open
Resources and look for iTunesHelper.  If it or any of its parent folders are not there, you’ve indeed got a Broken
Login Item.

If the Broken Login Item is something that you no longer have or no longer use, re-activate the System
Preferences > Accounts window, select the item and click the [-] button to delete it.  Of course, this item  will not
work any more, but it wasn’t working anyhow.  If on the other hand you still want this item to work, you’ll need to
reinstall it.  You may need to visit its developer’s website and redownload it, or re-run the installer in the associated
application.

Quit and re-launch Smarky, Synkmark, Markster or BookMacster.  This time you should not get the error message. 
(No news is good news.)  This means that the app has successfully received your Login Items from Mac OS X and
verified that Bookwatchdog is not among them.

4.18.2  Error 144762 : Broken Login Item

Why Error 144762 Occurs
Our older app, Bookdog, came with an accessory named Bookwatchdog,  which ran in the background and can
conflict with Smarky, Synkmark, Markster or BookMacster.  Therefore, these apps ask Mac OS X for your Login Items,
so it can see if Bookwatchdog is a Login Item, and if so remove it.  Error 144762 indicates that Smarky, Synkmark,
Markster or BookMacster requested that Mac OS X remove Bookdog’s old Bookwatchdog from your Login Items, and
Mac OS X said “No” and failed for some reason.



Steps to Fix Error 144762
To solve the problem, since this removal only needs to be done once, do it manually…

Click in your menu:  > System Preferences.

At the top left of your screen, click the Apple () menu down to System Preferences.

In the System  row, click Users & Groups  or Accounts  .

There are two tabs near to top.  Click Login Items.   You’ll see something like this…

Scroll through the list and see if Bookwatchdog  is listed in there.  If it’s not, you’re done.

If it is, delete it by selecting it and clicking the [-] button.

4.18.3  Error 3040 : Too Long to Install Browser Extension

Why Error 3040 Occurs
Synkmark, Markster or BookMacster install add-ons  into some web browsers in order to perform several functions.  In
the case of Firefox, you must approve the installation by clicking a button in Firefox.

Usually it works, but if you don’t notice and/or respond to the dialog in Firefox or Chrome, or if Firefox didn’t display the
dialog because they are occupied with some other task, Error 264948 will appear in Synkmark, Markster or
BookMacster.

Steps to Fix the Problem
Although Synkmark, Markster or BookMacster will retry the installation later when needed, it is often less frustrating,
and thus recommended, if you’ve read this far, to fix the problem immediately, in a manual mode where you have more
control.  To do that,

Click in the application menu > Manage Browser Extensions.  You will see a new window as shown here, except
without the happy green checkmarks.



The buttons are fairly self-explanatory, and if you want to stop reading now and start pushing buttons, go for it.

Focus on the row of buttons for the browser client for which the installation failed.

If indications are that the extension is installed, click the Test  button and see what happens.  You should get a
green “passed the test” checkmark.  Sometimes the test will fail because Firefox or Chrome were not running and
take too long to launch.  If that happens, click “Test” again.  At other times, Firefox hangs and won’t quit.  If that
happens, type ⌘⎇esc  and Force Quit Firefox.

Otherwise, click the Install  button for one of the Chrome or Firefox Clients which you wish Synkmark, Markster or
BookMacster to be able to work with.  The Install  button should be enabled after a failed test.

If installing for Firefox, activate Firefox and watch for instructions to appear.  Sometimes it fails to respond when
you click “Install Now” after the countdown.  If that happens, wait a few seconds for the app to display another
error, then retry.

After installing, return to Manage Browser Add-Ons  and click “Test”.

Repeat for other relevant clients.

In the end you should see happy green checkmark(s) as shown above.

4.18.4  Error 3015 : Sync Fight

Why Error 3015 Occurs
After an Export operation to a Client, Smarky, Synkmark, or BookMacster compares the changes it exported to the
changes exported in prior exports.  If the app finds that it is exporting the the same changes repeatedly, with no other
changes, it is apparent that something must be un-changing what the app changed.  In other words, there’s a fight! 
Since the app in turn detects the un-change and syncs again, exporting again, this could go on forever.

Instead, the app disables syncing by pauses syncing or, equivalently, disables Agents, and displays Error 3015 to you.

Steps to Fix the Problem
The first step is to find the cause of the problem and remove the cause.  There are two general causes.

You have a Sync Loop.  The solution is to break the Sync Loop.

Syncing services are properly configured but one of them is misbehaving.  Our website contains current
information on this topic.  If you cannot resolve the issue, please consider sending us your data so that we can
figure it out.  To do that,

Activate Smarky, Synkmark, or BookMacster.
Click in the menu: Help  > Trouble Zipper.
Trouble Zipper will ask several questions regarding what data to include.  For this particular case, please click
Include Bookmarks,  and then select the browser whose bookmarks are being fought over.

If you would rather try to resolve the problem yourself, you need to find out what change(s) are being fought over.  You
can see this by examining your recent Sync Logs.

http://sheepsystems.com/files/products/bkmx/inex-sync-fight.html


In the following example, by clicking the popup menu you can see that there were three recent Exports interspersed
with two Imports to Safari…

After a fight over Safari bookmarks is reported, if you click any of the recent Export  logs for the errant Client (Safari in
this example) you should see exactly the same changes.  Here is an example…

In this example, the bookmark Ant  is being moved up to position 0, and bookmark Bird  is being moved down to
position 1.  That is, BookMacster, say is putting them into alphabetical order.

Conversely, if you click any of the recent Import  logs for the errant Client (Safari in this example) you should again see
the same changes in each log, but the opposite  of what changed during the exports.  Continuing the same example…

In this example, the bookmark Ant  is being moved down to position 1, and bookmark Bird  is being moved up to
position 0.  That is, some other app or service is moving them back, out  of alphabetical order.

Restore Your Sync Snapshots Preference.  When Smarky, Synkmark or BookMacster first noticed the problem, it
likely increased the setting of your Number of Sync Snapshots to keep  so that enough data could be gathered to
diagnose the problem.  If you’re not 100% sure that the problem won’t come back, we recommed leaving it at the
higher value.  But if you want to set it back,

Activate Smarky, Synkmark, Markster or BookMacster.
Click in the application menu: Preferences.
Click the tab: Syncing.
Change Number of recent Snapshots to keep  to your preferred value.

When Smarky, Synkmark or BookMacster first noticed the problem, it also paused syncing.  After the problem is
resolved, you should resume  syncing.



4.18.5  Errors Exporting to Non-Running Firefox

When Synkmark, Markster or BookMacster needs to export to Firefox while Firefox is not running, or you ask Smarky
to export to Firefox even if it is running, the app accesses Firefox’ bookmarks database file directly.  In preparation for
the actual export, it opens the database, verifies the expected tables, and performs a checkpoint  operation, to flush
through any changes pending by other applications.  These are simple operations, and if they fail, this almost always
means that the database file is corrupt.  Here is what you need to do.

Launch Firefox

Activate Synkark or BookMacster and repeat the Export operation.  If the failure occurred by an Agent operating in
the background, click in the menu Bookmarkshelf  > Export,  to do a normal export.

If it succeeds, activate Firefox and click in the menu: Bookmarks  > Show All Bookmarks.   If you see all of your
bookmarks there, including any newly-exported changes, you are done.  If not, continue.

In the Library  window which appeared in Firefox when you clicked Show All Bookmarks,  click the star tool in the
toolbar and Restore from a recent backup.

If that worked, quit Firefox and repeat the Export from Synkmark or BookMacster.  If that works too, you are done. 
If not, continue.

Now we’re at the point where your Firefox bookmarks are definitely corrupt and you’re going to have to abandon
what remains.

Launch Firefox.

Click in the menu: Help  > Troubleshooting Information.   A window or tab will appear.

In the section Application Basics,  Profile Folder, click the button Show in Finder.   A Finder window will open.

Quit Firefox.

In the Finder window, find the file named places.sqlite.   Trash it (or move to your Desktop, if you think you might
want to try to recover bookmarks later).

See if there are file(s) named places-shm.sqlite  and/or places-wal.sqlite,  and if so trash them.

Assuming you were doing a normal Export from Synkmark or BookMacster which was going to overwrite all of your
Firefox bookmarks anyhow, repeat the export from the app.  Otherwise, you might wawnt to launch Firefox and
restore from one of Firefox’ backups using the Star button as described above.  Note that if you launch Firefox with
no places.sqlite file in your Profile folder, Firefox will create a new one and populate it with a dozen or so
bookmarks regarding the Firefox project and Mozilla, its suthor.
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4.19  Interpreting Icons in Content    
 Folder will be sorted, when sorting is done 

 Folder will not  be sorted when sorting is done 

 Regular bookmark to a web page

 RSS feed (feed://) or Firefox Live Bookmark  

 Smart Folder (in Firefox or iCab) 

 JavaScript bookmarklet (javascript://) 

 Local file (file://) 

 Bookmark is shared when exported to a web-based browser app which supports shared/private 

 Item has an Export Exclusion set for one or more Clients 

 Item is affected by an Export Exclusion set in one of its ancestors 

 Item is set to be sorted at the top, when sorting is done 

 Item would be sorted at the top, when sorting is done, but currently its parent is not set to sort, so this setting has

no effect. 
 Item is set to be sorted at the bottom, when sorting is done 

 Item would be sorted at the bottom, when sorting is done, but currently its parent is not set to sort, so this setting

has no effect 
 This item is in a folder for which a Folder to Tag Mapping has been designated for a Client during Import, and

therefore it is given an additional tag during imports from this Client. 
 This item is in a folder for which a Folder to Tag Mapping has been designated for a Client during Export, and

therefore it will be given an additional tag during exports to this Client. 
 This item has a tag for which a Tag to Folder Mapping has been designated for one or more Clients during Import,

and therefore it came from a different folder in these Client(s). 
 This item has a tag for which a Tag to Folder Mapping has been designated for one or more Clients during Export,

and therefore it will be in a different folder after exporting to these Client(s). 
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4.20  The Inspector Panel    
The Inspector  panel is a comprehensive, editable display of content item attributes.  To show the Inspector panel,
either click the button in the lower-right corner of a Bookmarkshelf window…

or use the menu command Selection > Show Inspector…

The values shown in the Inspector pertains to whatever item is selected in the active Bookmarkshelf() window.



4.20.1  Drawers and Menus

The three buttons in the lower right corner bring up

a contextual menu of actions which may be executed on the subject content item
open/close button for the bottom drawer
open/close button for the side drawer

The bottom drawer contains URLs and Verify results.  The side drawer shows any export exclusions which may have
been set for this item.
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4.21  Open, Save Automatic Actions 
       Topics on this Page

Open after BookMacster launches
Auto Import
Sort
Find Duplicates
Auto Export
Overriding Settings

In BookMacster, you can configure a Bookmarkshelf document to do things automatically when it is opened or saved. 
Because all of these actions can be performed manually with a click or two, in our opinion, having them performed
automatically is annoying and sometimes causes unexpected results.  We therefore recommend that most users leave
all checkboxes discussed below switched OFF.  This feature is retained for some early adopters and former Bookdog
users who seem to like them.

You edit the settings discussed in this section in the Settings  > Open/Save  tab of a .bkmslf document which is open in
BookMacster.

Note that these settings do not persist if you move the document to another Macintosh account.  Instead, they are
Local Settings.

4.21.1  Open after BookMacster launches

This is handy if you intend to keep all of your bookmarks content in a single Bookmarkshelf.  To override it and not
have any document open, hold down the alt  option  key on your keyboard while launching BookMacster.

4.21.2  Auto Import

If this box is checked, the document will Import from its Import Clients immediately upon opening.  This is useful if you
would like to keep the document in sync with its Import Clients, without having to remember to Import whenever you
open it.

4.21.3  Sort

You can set a Bookmarkshelf to perform a Sort operation immediately upon opening.

4.21.4  Find Duplicates

You can set a Bookmarkshelf to perform a Find Duplicates operation immediately upon opening.

4.21.5  Auto Export

If this box is checked, the document will display a sheet prior to saving or closing if there are unexported changes,
giving you a default option to Export to the active Export Clients first.  This is useful if you would like to keep the Export
Clients in sync with the document, without having to remember to Export.  This is useful if you would like to keep the
document in sync with its Export Clients, without having to remember to Export whenever you save it.

Auto Export only occurs Save  operations that are commanded manually.  Save As  operations, Save As Move…



operations, Save To  operations, Auto Saves by Mac OS X 10.7 or later, and Save  commands executed by an Agent
Worker or AppleScript command will not cause an Auto Export.  (Auto Export upon closing prevents unexported
changes from not being exported without your approval in Mac OS X 10.7 or later.)

4.21.6  Overriding Settings

To open a Bookmarkshelf without any of the above prescribed actions being performed, hold down the option  key on
your keyboard as the document is opening.
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4.22  Bookmarks, Folders and Separators    
A Bookmarkshelf(), and all supported browser apps, can contain several types of items: bookmarks,  folders,  and
separators.   We refer to these item types collectively as bookmarks content items,  or just content  …

       Topics on this Page

Bookmarks
Hard Folders
Soft Folders
Separators
Attributes

4.22.1  Bookmarks

A bookmark is a reference to a URL on the internet.  Besides the URL, a bookmark can have several other attributes
such as its name, tags, comments (description), shortcut key, lineage, and various statistics.  Bookmarks are called
links  in Delicious.

4.22.2  Hard Folders

Although they can look similar other folders, most web browsers have two or three of what we call hard folders.   Like
the hardware inside your computer, you cannot change the name or location of a hard folder by typing with your
keyboard or clicking with your mouse.

To replicate what you see in your web browser, a Bookmarkshelf document has hard folders.   You can recognize the
hardness  because their names are displayed in italics,  as shown here:

A Bookmarkshelf document may have zero, one, two, three or four hard folders.  Hard folders are present or absent in
a document, depending on its structure.

In order to map content items during Import and Export operations, Smarky, Synkmark, Markster or BookMacster
needs to identify equivalences between its own hard folders  and those of web browser apps.  The table below shows
the mappings.

The Hard Folders displayed in the app are named to match the name of the Hard Folder in the first of the document’s
Browsers (Clients) which has such a folder.  In case that no browser (client) has a Hard Folder corresponding to a
given Hard Folder existing in the app, the app defaults to the names used by Safari: Favorites Bar,  Bookmarks Menu,
Reading List,  and My Shared Bookmarks.

Possible Name as
displayed in
Smarky, Synkmark,
or BookMacster

Favorites Bar
or
Bookmarks Bar

Bookmarks Menu
or
Other Bookmarks

Reading List
or
Unsorted
Bookmarks

My Shared
Bookmarks

Description

Appears in the
toolbar (near the
top) of windows

Accessible from the
menu

A special place to
quickly drop new
bookmarks which
you will put in a
better place, later.

A special place for
bookmarks that will
be shared with other
people.

Camino Bookmarks Bar Bookmarks Menu - -



Chrome Bookmarks Bar Other Bookmarks - -

Firefox Bookmarks Toolbar Bookmarks Menu Unsorted
Bookmarks

-

iCab Bookmarks Bar Bookmarks Menu - -

OmniWeb Favorites Personal Bookmarks - My Shared
Bookmarks

Opera Bookmarks Bar
[Note 1]

Note 2 - -

Roccat - - - -

Safari (ver 1-6) Bookmarks Bar Bookmarks Menu Reading List -

Safari (later) Favorites Bar Bookmarks Menu Reading List -

Web Services
[Note 3]

- - - -

Note 1.  Opera’s Bookmarks Bar  does not really contain any items.
Note 2.  Although you do not see a Bookmarks Menu  when you click in Opera’s menu Bookmarks  > Manage
Bookmarks,  in fact all items (except the Trash) appear in that menu item.  Therefore, in our view, Opera does have
a Bookmarks Menu.
Note 3.  Web Services are Delicious, Diigo, Pinboard and Google Bookmarks.

4.22.3  Soft Folders

In contrast to the Hard Folders, we speak of Soft Folders  as the regular folders you create in Smarky, Synkmark,
Markster or BookMacster or in a web browser app.  For example, folders named News  or Vacation Ideas  are soft
folders  that you’ve created.  In contrast the hard folders, you may rename, move or delete soft folders  as you wish.

4.22.4  Separators

Separators,  also called separator lines,  are little “fences” that may be placed between groups of items that are still in
the same parent folder.

4.22.5  Attributes

Attributes are the charactertistic of bookmarks and other content items.  For example, some of the attributes of
Bookmarks Content items are: name, url, shortcut, tags, comments, date added, visit count.



Although most attributes are self-explanatory, in this section we explain those that are not…

Three URLs
There are three URLs which Smarky, Synkmark, Markster or BookMacster store for a bookmark:

Current URL  is the URL that would currently be used if you clicked Visit,  and the URL that would be passed to a
Client during an Export.

Suggested URL  is likely a better, newer one which Smarky, Synkmark, Markster or BookMacster has received,
usually as the result of a redirection from the website, during a Verify operation.

Prior URL  is just a holding place for a URL that was replaced, in case you want to revert to it later.

You can see all three URL of a selected bookmark by opening the Inspector panel and opening its bottom drawer.

Clicking one of the buttons on the left will swap the indicated URL values.

Clicking one of the buttons on the right will visit the site addressed by the adjacent URL.

Text Color
In the Inspector Panel, next to the name of the subject item is a rectangle called a color well.   After clicking this color
well, you can set the text color which used is to display the item’s name in the Content View, Status Menulet, and
contextual menus.  This attribute is not supported by any clients and is therefore not exported.  It is for your use within
Smarky, Synkmark, Markster or BookMacster only.

Will be Sorted
This attribute sets explicitly whether or not a particular  folder will be sorted when sorting is done.  In addition to the
checkbox in the Inspector, this is also indicated by the folder’s background color and symbol in the Content Tab.

Verify  Status Codes
The response from a website to a request for a bookmark’s URL normally contains an HTTP Status Code,  which is
usually a positive integer between 100 and 599, although some creative cowboy webmasters sometimes return their
own made-up status codes, usually in the range 600 to 999.

However, “lower level” errors can occur if the site does not send an HTTP response.  These lower level errors are
returned to Smarky, Synkmark, Markster or BookMacster by Mac OS X and contain “error codes” in Apple’s
NSURLErrorDomain.  The codes in NSURLErrorDomain are negative numbers.

Fortunately (maybe because Apple planned it this way), there is no overlap between these positive and negative
values.  Therefore, Smarky, Synkmark, Markster or BookMacster stores in its Verify results for a bookmark what we
call a Verify Status Code.   Quite simply, if this value is positive, it’s an HTTP Status Code, and if negative, it’s an error
code in the NSURLErrorDomain.

Verify Status Codes for Positive Values (HTTP Status Codes)
Most of the HTTP status codes you will see are defined in Section 10 of Internet Society’s specification HTTP/1.1.  But

http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html


although it was published in 1999, this document still has not been ratified into a standard, and in the meantime
additional codes have been proposed.  For a readable and more complete table of the HTTP status codes in use at
this time, we recommend this Wikipedia article.

Verify Status Codes for Negative Values (NSURLErrorDomain)
The following is derived from the file NSURLErrorDomain.h, but we’ve published them here since you will not have that
file unless you have installed Apple’s Developer Tools, and also we added the narrative descriptions.

Code NSURLError: Means that connection failed because:

-999 Cancelled it was cancelled.

-1000 BadURL it has a bad URL.

-1001 TimedOut it took longer than the timeout which was alotted.

-1002 UnsupportedURL it has an unsupported URL.

-1003 CannotFindHost the host could not be found.

-1004 CannotConnectToHost the host would not let us establish a connection.

-1005 NetworkConnectionLost we established a connection but it was lost.

-1006 DNSLookupFailed domain name server (DNS) lookup failed.

-1007 HTTPTooManyRedirects we received too many redirects from the server while
processing the request.

-1008 ResourceUnavailable the requested resource is not available.

-1009 NotConnectedToInternet this computer appears to not have an internet connection.

-1010 RedirectToNonExistentLocation we were redirected to a nonexistent location.

-1011 BadServerResponse we got a bad response from the server.

-1012 UserCancelledAuthentication the user cancelled when asked for authentication.

-1013 UserAuthenticationRequired user authentication is required.

-1014 ZeroByteResource the requested resource contains no data.

-1015 CannotDecodeRawData we could not decode the raw data.

-1016 CannotDecodeContentData we could not decode the content.

-1017 CannotParseResponse we could not parse the response.

-1100 FileDoesNotExist the requested file does not exist.

-1101 FileIsDirectory the requested file is in fact a directory.

-1102 NoPermissionsToReadFile we lack sufficient permissions to read the requested file.

-1103 DataLengthExceedsMaximum the length of the requested data exceeds the limit.

-1200 SecureConnectionFailed we could not establish a secure connection.

-1201 ServerCertificateHasBadDate the server’s SSL certificate appears to have expired.

-1202 ServerCertificateUntrusted the server’s SSL certificate is not trusted.

-1203 ServerCertificateHasUnknownRoot the server’s SSL certificate has an unknown root.

-1204 ServerCertificateNotYetValid the server’s SSL certificate is not yet valid.

http://en.wikipedia.org/wiki/List_of_HTTP_status_codes


-1205 ClientCertificateRejected the server rejected our client certificate.

-2000 CannotLoadFromNetwork we could not load from the network.

-3000 CannotCreateFile we could not create a file.

-3001 CannotOpenFile we could not open a file.

-3002 CannotCloseFile we could not close a file.

-3003 CannotWriteToFile we could not write to a file.

-3004 CannotRemoveFile we could not remove a file.

-3005 CannotMoveFile we could not move a file.

-3006 DownloadDecodingFailedMidStream decoding the downloaded data failed in midstream.

-3007 DownloadDecodingFailedToComplete decoding the downloaded data failed to complete.

HTTP Status Code 302
HTTP Status Code 302 should be returned by a website when there has been a temporary redirect that should not be
used permanently.  For example, you may have a bookmark to the Hooterville News  newspaper with the url

    http://www.hootervillenews.com/todaysHeadlines

This URL takes you to today’s headlines.  However, you won’t get there directly.  In response, today, their server will
send back a response with HTTP Status Code 302, including a redirect  to the url:

    http://www.hootervillenews.com/headlines/2009_07_16

which will give you the headlines for today, July 16.  Your browser then visits this redirect URL and renders its data
instead of the URL you asked for.

Now. if you click on that same bookmark tomorrow, you will again get a 302 response but will be redirected to a
different url:

    http://www.hootervillenews.com/headlines/2009_07_17

which will give you the headlines for tomorrow, July 17.

This example illustrates the correct usage  of the 302 status code by the Hooterville News.

Note that, in this case, you would not  want to update your bookmark to point to the redirected url, because if you did,
you would be reading July 16’s headlines forever.

Last Modified (Date)
Last Modified  is an attribute supported by Firefox, Smarky, Synkmark, Markster or BookMacster.  It is imported or
exported to Firefox or Shiira during an Import or Export operation.

Smarky, Synkmark, Markster or BookMacster update the Last Modified  of an item whenever any of its nontrivial
attributes are changed.  In addition, the app updates the Last Modified  of a folder whenever it gains or loses a child
item.  Therefore, when you move an item from one folder to another, although the Last Modified date of the item itself
(or any of its descendants, if it is a folder) is not changed, the Last Modified  date of the old and new parent folders are
set to the current date and time.

As practiced by Firefox, Last Modifed  is the last time that any of the bookmark’s attributes such as Name or
Comments (Description) were modified.  Moving the bookmark does not count as a change in attributes, and neither
does changing tags (probably because Firefox considers ‘parent’ and ‘tags’ to be ‘relationships’ and not ‘attributes’). 
Note that the Last Modified  attribute has to do with the bookmark itself and not with the bookmarked website.  That is,
Last Modified  does not  change when the site’s webmaster changes the content of the site.

Finally, note that, as of Firefox 3.5, the Last Modified  attribute, although updated as noted above, is not visible in



Firefox itself.

Export Exclusions
Bookmarks and folders have an attribute which allows you to exclude the from being exported to selected Clients.  To
access these switches, activate the Inspector and click the Export Exclusions  drawer button near the bottom. 
Checkboxes for all Clients are on by default.

To use this feature,

Open the Bookmarkshelf document which is doing the syncing in Smarky, Synkmark, Markster or BookMacster.
In the Content View, select any bookmarks, or folders of bookmarks, that you don’t want exported to all browsers. 
We’ll call these the excluded items.
If the Inspector is not showing, click in the menu: Selection > Show Inspector.  The Inspector panel will appear.
Click the Export Exclusions button at the bottom of the Inspector panel.
In the drawer which appears, switch off the checkbox(es) for whatever browser(s) you don’t want the excluded
items exported to.
Back in the document window, verify that one of the little Export Exclusions icons has appeared next to the
targetted bookmarks and folder(s).

   or   

Now, the next time you do a normal export, the excluded items will be removed from the browsers whose checkboxes
you switched off, and will not re-exported until you switch them back on.

Note that Export Exclusions  are attributes of the bookmark or folder and are not Local Settings.   That is, if your
Bookmarkshelf document is synced to or copied to other Macs, the same exclusions will apply to the same Clients
(and all of their profiles).

Item Quality
When deleting all duplicates or consolidating folders, Smarky, Synkmark, Markster or BookMacster must decide for
you which item to keep and which item to delete.  As explained, in those sections, it retains the item with higher
quality.  Generally, items are compared two at a time to determine which has higher quality.

If the items are folders and one has more children than the other, the one with more children has higher quality.
Otherwise, if the items are bookmarks and one has more tags, the one with more tags has higher quality.
Otherwise, if one has schemes http  and one has scheme https,  the one with scheme https  has higher quality.
Otherwise, if one is buried deeper in the hierarchy than the other (that is, has a longer lineage), it has higher
quality.  Why?  As one user pointed out, “If I buried it deeper, I must have thought longer about it.”
Otherwise, if both of the items have a Last Modified Date, and if one is newer by more than 5 minutes, it has higher
quality.
Otherwise, if at least one of them has Comments, and one has longer Comments, it has higher quality.
Otherwise, if the names of the two items have different lengths, the one with the longer name has higher quality.
Otherwise, if one of them has been marked with the Don’t Verify  attribute and the other has not, the one marked
Don’t Verify  has higher quality.
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5.0  Support and Admin    
       Topic Pages in Chapter 5

5.1  Installing and Licensing
5.2  Acknowledgements
5.3  Version History
5.4  Legal Notices

5.0.1  Support Issues

Support issues are our problems,  not yours.  We are grateful for all of the user feedback which has helped the
continuous quality improvement of our apps.

Our support web page will lead you to articles, our forum, a few troubleshooting tools and, of course, forms to contact
us.

5.0.2  Updating Smarky, Synkmark, Markster or BookMacster

Besides internal bug fixes, BookMacster is often updated to maintain compatibility with web browsers as they change.

We strongly recommend having updates downloaded and installed automatically.  To opt in to that, click in the
application menu > Preferences  > Updating  and check the box.  Even better, check the box to Download and update
automatically.   Note that you can elect to receive earlier versions, called Alpha  and Beta.
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5.2  Acknowledgements
       Topics on this Page

Beta Testers
Open-Source Code
Teachers
Tools

5.2.1  Beta Testers

Our sincere thanks to the following people who contributed feedback, many of whom persisted with great patience,
during the Beta Test of BookMacster, between November 2009 through May 2010.

Alexander Hoffmann in Trier

Andreas Zeitler of Mac OS X Screencasts in London

Andrew Lyles of New York, New York (“Say it twice, we’re kinda slow”)

Bradley MacDonald of Chevy Chase

Charles WJ in France

Mr. D. Wright of Wasilla, Alaska

Eric O’Brien of Possibility Engine in Seattle, USA

Faisal N. Jawdat

Mr. Frank H. Wu of San Francisco

Guy Kawasaki of Alltop, Palo Alto

John M. Knapp, LMSW, of Knapp Family Counseling in  Malone, NY

Leo Marihart of Lemoore, California, USA

macmystic in Venezuela

Mads Vestergaard in Copenhagen

Mark Dymek of Mark’s Computer Repair in Boston, MA

Mike Harris in Chicago

Nic Giannandrea of Visalia, CA

Nikolaos Anastopoulos in Greece

Rick Mathes of Egoscue - Austin in Austin, TX

Roland Schama of Seven Hills, OH

Steve Mayer in Aloha, OR

Steven Wickliffe of Evanston

Tedkl

Yoni Blumberg of Northfield, MN

and a couple dozen others who contributed anonymously
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5.2.2  Open-Source Code

Graham Cox wrote and published the GCUndoManager which provides Undo and Redo support.  Yes,
GCUndoManager plays with Apple’s Core Data!

The Check For Updates  feature is implemented by the Sparkle  framework, written and maintained by Andy
Matuschak, and provided under license.

We read/write JavaScript Object Notation using the Cocoa categories from the BSJSONAdditions which is among
the source code published by Blake Seely, and used under license.  The latest  code is available on the project’s
github.

The Firefox reader/writer (when Firefox is not running) uses the latest version of SQLite, written and placed into the
public domain by D. Richard Hipp of Hipp, Wyrick & Company, Inc..

The text fields used to record keyboard shortcuts in the Shortcuts  tab of the Preferences in Markster and
BookMacster are the  shortcutrecorder.  We use the code from this project under the contributor’s New BSD
License.

BookMacster’s Google Bookmarks parser uses essentially the RSS  Class written by Brent Simmons, provided
under license by Ranchero Software, the maker of NetNewsWire for Mac.

Michael Ash wrote and published the MAKVONotificationCenter, which allows our apps to have “Key-Value
Observing Done Right” .

The code implementing our Preferences window is based substantially on the UKPrefsPanel, from the collection of
source code written by Uli Kusterer.

The Tags View  in the document window is based on the Tag Cloud NSView.

Code for using Core Animation to animate this “Hint” arrow was copied and modified from Core Animation Tutorial:
Window Shake Effect, by Marcus Zarra

Parsing and unparsing of dates formatted per ISO 8601 in XBEL files is done using the ISO8601DateFormatter
class written by Peter Hosey.

The star rater thingey was adapted from EDStarRating, by Ernesto Garcia, of cocoaWithChurros.

Changes in bookmarks trees are detected using the mix() function, published by Robert Jenkins, for nonlinearly
combining hash values.

The popup menu in the Content View is based in part on the KBPopUpTableHeaderCell published by Keith Blount
of Literature & Latte.

The idea to use an attached window to make the blue “Hint” (Help) arrow, and most of the heavy lifting code, was
copied and modified from MAAttachedWindow by Matt Gemmell.

The tooltip window which drags with the mouse is based on the ToolTip class published by Eric Forget of
Cafederic.

The small blue “bookmark” and some of the other stock icons are from the kit created by Jasper Hauser of
JasperHauser.nl Icon Design.

The orange “RSS” icon used for Firefox Live Bookmarks is from the Developer Icons set published by Matt Ball.

Additional code used under license from Whistle Communications.

Cool sound effects were provided by SoundJay.com.  They have many high-quality sound effects available.

5.2.3  Teachers

Quitting Chrome and Firefox was only about 98% reliable until we learned a trick from AppleScript guru Shane
Stanley.

Use of the EVP functions to generate SHA1 and MD5 hash algorithms was learned from the NSData_AMDigest
category written by Andreas Mayer.

http://apptree.net/about.htm
http://apptree.net/gcundomanager.htm
http://sparkle.andymatuschak.org/
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/LicenseSparkle.html
http://json.org/
http://blakeseely.com/downloads.html
http://blakeseely.com/
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/LicenseBlakeSeely.html
http://github.com/blakeseely/bsjsonadditions
http://sqlite.org/
http://www.sqlite.org/copyright.html
http://www.hwaci.com/
http://code.google.com/p/shortcutrecorder/
http://www.opensource.org/licenses/bsd-license.php
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/LicenseRanchero.html
http://ranchero.com/
http://www.newsgator.com/NGOLProduct.aspx?ProdID=NetNewsWire
http://www.mikeash.com/
http://www.mikeash.com/pyblog/key-value-observing-done-right.html
http://www.zathras.de/angelweb/sourcecode.htm
http://www.fernlightning.com/doku.php?id=randd:tcloud:start
http://www.cimgf.com/2008/02/27/core-animation-tutorial-window-shake-effect/
http://www.zarrastudios.com/ZDS/Home/Home.html
http://boredzo.org/iso8601parser/
http://cocoacontrols.com/platforms/mac-os-x/controls/edstarrating
http://www.cocoawithchurros.com/
http://www.burtleburtle.net/bob/hash/doobs.html
http://lists.apple.com/archives/cocoa-dev/2005/Apr/msg01223.html
http://www.literatureandlatte.com/index.html
http://mattgemmell.com/2007/10/03/maattachedwindow-nswindow-subclass
http://mattgemmell.com/
http://www.cocoadev.com/index.pl?ToolTip
http://www.cafederic.com/
http://www.jasperhauser.nl/icon/
http://www.mattballdesign.com/blog/2009/11/developer-icons-are-back-online/
http://www.mattballdesign.com/
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/LicenseWhistle.html
http://soundjay.com/
http://www.macosxautomation.com/applescript/apps/index.html
http://harmless.de/


5.2.4  Tools

The Help Book is produced with our own Perl script which invokes Fletcher Penney’s MultiMarkdown,  which is in
turn built on John Gruber’s Markdown,  and also invokes John Gruber’s SmartyPants.

Home | Parent ← Go → Prior | Next

http://fletcherpenney.net/multimarkdown/
http://daringfireball.net/projects/markdown/index
http://daringfireball.net/projects/smartypants/
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/SSYMH.05.01.html
file:///Users/jk/Documents/Programming/Builds/Release/BookMacster.app/Contents/Resources/English.lproj/HelpBook/SSYMH.05.03.html


Home | Parent ← Go → Prior

5.4  Legal Notices
“Firefox” and “Camino” are registered trademarks of Mozilla Foundation Corp. California.

“Google” and “Chrome” are registered trademark of Google Inc.

“iCab” is a trademark of Alexander Clauss of Darmstadt, Germany.

“Mac”, “Macintosh”, “Mac OS X”, “AppleScript” and “Automator” are trademarks of Apple Inc., registered in the U.S.
and other countries.

“OmniWeb” is a registered trademark of Omni Development Inc.

“Opera” is a registered trademark of Opera Software AS Corp. Norway.

“Pinboard” is a trademark of Nine Fives Software, California, USA.

“Shiira” is a trademark of The Shiira Project.

“URL Manager Pro” is a trademark of Alco Blom or Alco Blom Software.

“Webnote” and “Webnote Happy” are a trademark of Happy Apps, Falls Church, VA, USA.

Home | Parent ← Go → Prior
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